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Preface

This guide provides instructions about how to use ApplicationXtender Image Capture to scan and
manage batches of ApplicationXtender documents. For more information about hardware and
software requirements, see the OpenText ApplicationXtender Release Notes.
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October 2020 Initial publication.
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Chapter 1

Getting Started

This section contains instructions and information essential to getting started with ApplicationXtender
Image Capture. It includes the following topics:

¢ Introduction to ApplicationXtender Image Capture, page 15

¢ Topic Summary, page 16

¢ Introduction to AppXtender and AppXtender Image Capture Concepts, page 16
¢ How Does AppXtender Image Capture Work with AppXtender?, page 21

* How Batches are Stored and Displayed in AppXtender Image Capture, page 23
* Selecting Data Sources, page 28

¢ Starting ApplicationXtender Image Capture, page 30

¢ AppXtender Image Capture Views, page 35

¢ AppXtender Image Capture Toolbars, page 36

Introduction to ApplicationXtender Image
Capture

ApplicationXtender Image Capture (AppXtender Image Capture) is a batch scanning module
integrated with ApplicationXtender® (AppXtender). AppXtender Image Capture allows you to store,
retrieve, view, and process batches. Batches can be added one page at a time or many pages at a time.
A Batch List for each application is shared between AppXtender Image Capture and AppXtender
Document Manager so that AppXtender Image Capture users can add pages to batches in the list
while AppXtender Document Manager users are creating indexed documents from other batches

in the list.

While you are creating a batch or after a batch has been retrieved from the Batch List in
ApplicationXtender Image Capture, you can adjust the display of the batch. Using the Print
command, you can print or fax pages from AppXtender Image Capture. The Configuration dialog
box in AppXtender Image Capture provides a way to configure several features that affect the way
AppXtender Image Capture looks or performs.
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Topic Summary

This section contains instructions and information essential to getting started with ApplicationXtender
Image Capture. It includes the following topics:

¢ Introduction to AppXtender and AppXtender Image Capture Concepts, page 16 defines key terms
that are used throughout the AppXtender system and this manual. Reviewing these concepts
before working with AppXtender Image Capture will help you understand the terminology
used in the AppXtender Image Capture and AppXtender Document Manager interfaces and
Web Access.

¢ How Does AppXtender Image Capture Work with AppXtender?, page 21 describes the
AppXtender modules that are essential for AppXtender Image Capture users or for the
AppXtender administrator who configures AppXtender Image Capture workstations. Each
module serves a specific purpose.

e How Batches are Stored and Displayed in AppXtender Image Capture, page 23 lists and describes
the types of files that can be stored and displayed in AppXtender Image Capture.

* Selecting Data Sources, page 28 describes how to specify multiple data sources for display in
AppXtender Image Capture or AppXtender Document Manager and Web Access.

* Starting ApplicationXtender Image Capture, page 30 describes how to start AppXtender Image
Capture. It includes special instructions for the first time you start AppXtender Image Capture
and the first time you start AppXtender Image Capture with a different scanner.

* AppXtender Image Capture Views, page 35 describes each of the AppXtender Image Capture
views, which display batches, list applications, and allow you to add and retrieve batches.

¢ AppXtender Image Capture Toolbars, page 36 briefly describes each of the AppXtender Image
Capture toolbar buttons.

Introduction to AppXtender and AppXtender
Image Capture Concepts

The functionality of the ApplicationXtender® (AppXtender) system centers on a few key concepts.
An understanding of these concepts helps you use AppXtender and ApplicationXtender Image
Capture (AppXtender Image Capture) effectively.

For more information, see:

* Glossary of AppXtender and AppXtender Image Capture Terms, page 16

Glossary of AppXtender and AppXtender Image
Capture Terms

The AppXtender and AppXtender Image Capture terms listed in the following topics explain the
AppXtender system and its functional components, such as the applications, documents, indexes,
batches, and pages, and how they relate with each other.

16



Getting Started

For more information, see:

® Introduction to ApplicationXtender Image Capture, page 15
* Annotations, page 17

* Applications, page 17

* Batches, page 18

® Batch Storage Locations, page 18
¢ Database, page 19

e Data Source, page 19

* Documents, page 19

* Indexes, page 20

* Foreign File Viewer, page 20

® DPages, page 20

® Redactions, page 21

Annotations

ApplicationXtender Image Capture allows you to add annotationsto the following page types:

¢ Images
o Text
e Portable Document Format (PDF) files

An annotation is a note or a shape added to a page, typically to focus attention on a particular part
of the page. You can use annotations to comment on the contents of a page, block areas of the page
from view, or highlight important information. When you create an annotation, it is associated
with the batch page on which you created it. Annotations are edited and stored separately from
the image, but they are displayed with the image. The types of annotations available include text,
highlighting, lines, arrows, and shapes.

For more information, see:

® Glossary of AppXtender and AppXtender Image Capture Terms, page 16

Applications

An application is the highest level of organization in AppXtender and AppXtender Image Capture.

You store documents or batches in an application and retrieve documents or batches from an
application.

The AppXtender system administrator creates applications through an AppXtender module called
ApplicationXtender Administrator. During application creation, the administrator names the
application and sets up one or more index fields for the application.
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Every time an AppXtender user stores a document in an application in AppXtender, the user must
enter index information for that particular document into the index fields. AppXtender stores the
index information in a database so users can search it later to retrieve documents.

However, when you store a batch in an application in AppXtender Image Capture, you do not enter
index information. Instead, you simply give that batch a name. A batch is intended as a temporary
container for scanned pages, from which an AppXtender user can later create indexed documents.

For more information about creating and managing applications in AppXtender Administrator, refer
to the ApplicationXtender Administration Guide.

For more information, see:

* Glossary of AppXtender and AppXtender Image Capture Terms, page 16

Batches

A batch is a file or group of files stored in an application and identified by a batch name. Each page of
a batch is a single object, such as a scanned image file or a word processing document. You create a
batch by adding an object to an application and entering a batch name. You can then add additional
objects as additional pages of the same batch.

A batch can be as small as one page, or can contain thousands of pages. You can store different types
of data as pages within one batch. For instance, a hospital patient’s batch could primarily contain

a patient’s scanned admission forms. After those forms have been scanned into the batch, you can
import a doctor’s report in Microsoft Word format and an x-ray into the batch as new pages. A
batch can contain any combination of objects. For more information on the types of files that can be
stored in AppXtender Image Capture, see How Batches are Stored and Displayed in AppXtender
Image Capture, page 23.

When you store a batch in an application, you must enter a batch name. To retrieve the batch later,
you display a Batch List and select the batch name from the list. You can process (print or fax) pages
within a batch individually in AppXtender Image Capture. If you have the proper security privileges,
you can modify batches in AppXtender Image Capture at any time.

For more information, see:

* Glossary of AppXtender and AppXtender Image Capture Terms, page 16

Batch Storage Locations

The batch files (for example, scanned images, text files, other objects, and so on) are stored in a
directory designated by the administrator as an application’s document write path. AppXtender
applications can be configured to store batches to any storage device that can be mapped by the
AppXtender workstation (such as network file server, local hard disk, erasable and WORM optical
media, and so on).

18
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For more information, see:

* Glossary of AppXtender and AppXtender Image Capture Terms, page 16

Database

A database is a collection of data tables of a particular database format (such as Oracle or Microsoft
SQL Server). AppXtender uses databases to store application information. When an application is
created, details such as the field definitions and security information are stored in database tables.
When you create a batch in AppXtender Image Capture, the batch name is stored in the batch table,
with a pointer to the location of the batch.

For more information, see:

* Glossary of AppXtender and AppXtender Image Capture Terms, page 16

Data Source

A data source is the means by which AppXtender Image Capture accesses data from a database.
When a data source is defined, an OLE DB data provider is configured to access the database. All of
the following characteristics in combination — where the data is stored, the format of the data stored,
and the data provider used to access the data — make up the data source. To access AppXtender
applications in AppXtender Image Capture, you connect to the data sources for the databases where
the AppXtender applications are stored.

For more information, see:

* Glossary of AppXtender and AppXtender Image Capture Terms, page 16

Documents

A document is a file or group of files stored in an application and identified by index information

in AppXtender. Each page of a document is a single object, such as a scanned image file or a

word processing document. An AppXtender user creates a document by adding an object to an
application and entering index information in AppXtender. The user can then add additional objects
as additional pages of the same document. Within AppXtender, users can open batches that were
created in AppXtender Image Capture and can use the contents of the batch to create documents.
When an AppXtender user creates a document from an AppXtender Image Capture batch, the user
indexes the document.

A document can be as small as one page, or can contain thousands of pages. AppXtender users
can store different types of data as pages within one document. For instance, a hospital patient’s
document could include a patient’s scanned admission forms, a doctor’s report in Microsoft Word
format, and an x-ray. A document can contain any combination of objects.

When an AppXtender user stores a document in an application in AppXtender, the user must enter
information for each of the document’s index fields. The information acts as a label for the document,
and because the information is stored in a database, the user can search for that "label" to retrieve the
document.

19



Getting Started

To retrieve the document later, the user searches for the record of index information entered to
identify the document. When the user makes a search request in ApplicationXtender, all records of
index information containing a match with the information requested appears in the result set.

For more information about creating, viewing, and managing documents in AppXtender, refer to the
ApplicationXtender Document Manager User’s Guide and ApplicationXtender Web Access User Guide.
For more information, see:

* Glossary of AppXtender and AppXtender Image Capture Terms, page 16

Indexes

An AppXtender index is a group of fields where information that describes a document is stored.
When an AppXtender user stores a document in an application, the index values that the user enters
identify the document.

The index allows AppXtender users to organize stored documents efficiently. Documents can be
stored in AppXtender in random order, and yet can still be easily retrieved, because every document
stored has an index record attached to it. AppXtender users can search all stored index values for an
application and retrieve relevant documents.

For more information about indexing and retrieving documents in AppXtender, refer to the
ApplicationXtender Document Manager User’s Guide and ApplicationXtender Web Access User Guide.
For more information, see:

* Glossary of AppXtender and AppXtender Image Capture Terms, page 16

Foreign File Viewer

The Foreign File Viewer allows you to view the content of some foreign files in AppXtender Image
Capture. The major benefit of the Foreign File Viewer is that a third-party viewer, such as Microsoft
Word, is no longer needed to display the content of the files. As soon as the content of the file is
displayed, you can launch its native software program from the Page menu so that you can edit
the file.

For more information, see:

* Glossary of AppXtender and AppXtender Image Capture Terms, page 16

Pages

The word "page" typically implies a single entity. However, because AppXtender and AppXtender
Image Capture support multiple object types, a page is defined as a single object. A very long word
processing file is a page to AppXtender or AppXtender Image Capture. A page could also be, for
example, a single scanned image, a 30-minute video clip, or an audio recording.

When you create a batch in AppXtender Image Capture, the object added as the new batch is the first
page of that batch. Other pages can be added to the batch at any time in AppXtender Image Capture.
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You can also print, fax, or delete pages at any time. Up to 250,000 pages can be attached to a batch,
and a page may come from one of many different types of sources.

For more information, see:

* Glossary of AppXtender and AppXtender Image Capture Terms, page 16

Redactions

You can use redactions to secure or hide portions of image and text pages. Redactions are annotation
shapes that are filled and opaque. You can apply redaction to all available shapes: freehand lines,
straight lines, arrows, rectangles, rounded rectangles, and ovals. When applied, the area of the page
behind the redaction is not visible.

For more information, see:

* Glossary of AppXtender and AppXtender Image Capture Terms, page 16

How Does AppXtender Image Capture Work
with AppXtender?

ApplicationXtender Image Capture (AppXtender Image Capture) is a scanning module integrated
with ApplicationXtender (AppXtender). Batches are scanned in AppXtender Image Capture and then
released to AppXtender for indexing. Each page in a batch can be used to create a document or can be
added to an existing document in AppXtender.

The AppXtender Image Capture interface is based on the AppXtender interface, so that you can start
working immediately if you are familiar with AppXtender. AppXtender Image Capture contains
only the features of AppXtender that are needed for scanning batches of images into the AppXtender
system.

AppXtender Image Capture allows you to store, retrieve, view, and process batches. Batches and
pages can be added one at a time, or can be imported many at a time. A Batch List for each application
is shared between AppXtender Image Capture and AppXtender. This means AppXtender Image
Capture users can add pages to batches in the list while AppXtender users are creating indexed
documents from other batches in the list.

Once a batch has been retrieved from the Batch List in AppXtender Image Capture, you can adjust the
display of the batch. You can print or fax (using the Print command) pages from AppXtender Image
Capture. The Configuration dialog box in AppXtender Image Capture provides a way to configure
several features that affect the way AppXtender Image Capture looks or performs.

AppXtender has several components, or modules, each of which performs a specific function within
the AppXtender system. Some AppXtender modules are essential for ApplicationXtender Image
Capture users or for the AppXtender administrator who configures AppXtender Image Capture
workstations. For more information, see the following topics:

¢ ApplicationXtender Image Capture on the Network, page 22
* License Server, page 22

¢ Data Source Selector, page 22

21



Getting Started

¢ ApplicationXtender Administrator, page 23
¢ Chapter 1, Getting Started

ApplicationXtender Image Capture on the Network

The modules that make up AppXtender, the files that you store and manage through AppXtender
and AppXtender Image Capture, and the database used by AppXtender and AppXtender Image
Capture can all be located on separate computers across a network to increase performance. When
you store a batch to AppXtender Image Capture, you are probably storing it to a location on the
network rather than onto a local computer. When an AppXtender user later uses that batch to create
indexed documents, the database that is used to store index information is also probably on a server
somewhere on the network.

However, from your perspective as a user of AppXtender Image Capture, database location and batch
storage location are relatively unimportant. The benefit of AppXtender Image Capture to you as a
user is that you do not have to decide where to store batches or remember where to go to locate them.
You simply open the Batch List and select an AppXtender application to find the batches you want,
and AppXtender Image Capture knows where to go to retrieve them.

To understand how your particular AppXtender system works, you may want to consult your
AppXtender system administrator to find out what functionality is configured for your workstation,
what AppXtender data sources are configured for you, and what functions you have rights to perform
in AppXtender Image Capture. Having an understanding of what functions are available to you will
help you to better understand how you can use AppXtender Image Capture.

For more information, see:

¢ Introduction to AppXtender and AppXtender Image Capture Concepts, page 16

License Server

AppXtender uses one central License Server to monitor licensing for AppXtender and AppXtender
Image Capture workstations. The License Server is a central computer that manages licensing for all
ApplicationXtender products. For information on using the License Server, refer to the License servers
chapter of the ApplicationXtender Administration Guide.

For more information, see:

¢ Introduction to AppXtender and AppXtender Image Capture Concepts, page 16

Data Source Selector

The Data Source Selector allows you to select or add new data sources, modify the configuration of
data sources, as well as switch between existing data sources. If there are multiple data sources
configured in the Data Source Selector, you can designate multiple data sources to be viewed within
AppXtender Image Capture. This allows you to view applications from all applicable data sources
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during a single AppXtender Image Capture session. For information on using the Data Source
Selector, see Selecting Data Sources, page 28.

For more information, see:

* Introduction to AppXtender and AppXtender Image Capture Concepts, page 16

ApplicationXtender Administrator

ApplicationXtender Administrator provides access to many administrative functions. In AppXtender
Administrator, applications can be created, modified, purged of index information, or deleted.
Security settings for AppXtender and AppXtender Image Capture functions and AppXtender
documents are configured and managed in AppXtender Administrator. In addition, administrators
can use the Audit function in AppXtender Administrator to track activity within the AppXtender
system. For example, the creation and deletion of batches can be tracked if you enable audit trails
for those items.

For more information on AppXtender Administrator, consult your AppXtender system administrator
or refer to the ApplicationXtender Administration Guide.

For more information, see:

¢ Introduction to AppXtender and AppXtender Image Capture Concepts, page 16

How Batches are Stored and Displayed in
AppXtender Image Capture

You can store any type of file in ApplicationXtender Image Capture (AppXtender Image Capture).
Depending on the file type, AppXtender Image Capture stores the file as a supported file type such
as image or text, or as an unsupported file type such as foreign or OLE. When files are created in
AppXtender Image Capture, AppXtender Image Capture verifies the file type and then stores the file
as the identified type (such as image, text, or foreign file format).

Many of the functions available in AppXtender Image Capture are file-type dependent. Because
AppXtender Image Capture is geared toward providing access to as many useful functions as
possible, features are provided that can be used to work with particular file types. However, these
functions are frequently not available when you are working with other file types.

A good example of this is the Enhance Image function. If you are scanning an image of an invoice, for
example, it might be very helpful to use image enhancement to clean up the image during scanning
and make it easier to read. However, when you are working with a Microsoft Word document stored
as a foreign file, image enhancement is not available (because it would not be of any use with the
Microsoft Word document).

AppXtender Image Capture has the capability to display file types in a variety of ways. The content
of supported file types can be displayed in the Batch Display view. Depending on your AppXtender
Image Capture configuration, an unsupported file type can be displayed as an icon representing a
foreign file, through Foreign File Viewer support, or in its native application in the Batch Display view.

Note: Access to AppXtender Image Capture functionality is dependent on the rights granted in
your AppXtender user profile. For more information on your user privileges in AppXtender Image
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Capture, consult your AppXtender system administrator or refer to the Managing Security chapter
of the ApplicationXtender Administration Guide.

The following topics discuss how AppXtender Image Capture stores different types of files and give a
brief overview of the functions available for files stored in each format:

* Supported Files, page 24
¢ Unsupported Files, page 27

For more information, see:
¢ Chapter 1, Getting Started

Supported Files

Supported files are files that are natively supported in AppXtender Image Capture. Supported
file types include: image files (TIFF, GIF, Bitmap, PCX, DCX, JPEG, and TGA files, for example),
Hypertext Markup Language (HTML) files, and Rich Text Format (RTF) files. The following topics
describe the AppXtender Image Capture-supported files:

* Image Files, page 24

* Text Files, page 25

* Rich Text Format (RTF) Files, page 26

¢ Hypertext Markup Language (HTML) Files, page 26
¢ Portable Document Format (PDF) Files, page 26

For more information, see:

¢ How Batches are Stored and Displayed in AppXtender Image Capture, page 23

Image Files

AppXtender Image Capture has the ability to store image files in their native format or in a different
format supported by AppXtender Image Capture. Image files contain graphic data. AppXtender
Image Capture displays image files in their stored format. Depending on the image storage format,
black and white files and 4/8-bit color files can be displayed in their native format as well as TIFF

or Windows bitmap files. True color files can be displayed in their native format as well as TIFF,
Windows bitmap, or JPEG files. If you store images using the JPEG format, you can configure the
level of compression of the images through AppXtender Image Capture.

By default, AppXtender Image Capture stores images in their native format (for example, a TIFF file
is stored as TIFF). When you choose to store an image type (black and white, 4/8-bit color, or true
color) in a specific image format, AppXtender Image Capture ignores the original format and stores
all images of that type in that format.

You add images to AppXtender Image Capture by scanning in paper documents or by importing
them. You can add annotations, enhance the image quality (while scanning), and adjust the display of
the image in many ways to allow optimal viewing of the image. You can also print or fax an image
page. You can view page information for image pages in AppXtender Image Capture. Batch view

24



Getting Started

properties are also available for image pages, allowing you to change display settings from the
Batch Display view.
For more information, see:

* Supported Files, page 24

Text Files

AppXtender Image Capture can store text files in ASCIIL, EBCDIC, and EBCDIK formats. Text files
can be added to AppXtender Image Capture by importing them.

Note: By default, text files are added to AppXtender Image Capture as foreign files. By associating
the .TXT extension with the text file type on the File Types tab in the AppXtender Image Capture
Configuration dialog box, you can cause text files to be supported in their native text format. For more
information on configuring the File Types tab, consult your AppXtender system administrator or refer
to the Configuring AppXtender Workstations chapter of the ApplicationXtender Administration Guide.

You can add annotations and adjust the display of the image in many ways to allow optimal viewing
of the image. You can also print or fax a text page. You can view page information for text pages in
AppXtender Image Capture. Batch view properties are also available for text pages, allowing you to
change display settings from the Batch Display view.

The following table provides an explanation of each supported text format.

Table 1. Batch Storage Format for Text Files

Code Description

ASCII ASCII stands for the American Standard Code
for Information Interchange. This character set
is used on most PCs, Macintoshes, and other
desktop computers. A report generated on a
desktop computer is likely to be in an ASCII
format.

EBCDIC EBCDIC stands for Extended Binary Coded
Decimal Interchange Code. This character set is
used on IBM mainframes. A report generated
on an IBM mainframe will be in EBCDIC format.

EBCDIK EBCDIK is the Japanese variation on EBCDIC.
This character set is used on IBM mainframes
manufactured in Japan. A report generated on

a Japanese IBM mainframe will probably be in
EBCDIK format.
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For more information, see:

* Supported Files, page 24

Rich Text Format (RTF) Files

AppXtender Image Capture stores RTF files in their native format. You can print or fax an RTF page.
Page information and batch view properties are not available for RTF files.

RTF files are displayed in their native format. The contents of the RTF file appears in the Batch Display
view, even if you do not have the Foreign File Viewer enabled for foreign files. Because RTF is natively
supported in AppXtender Image Capture, the Foreign File Viewer is not required to view file contents.

For more information, see:

* Supported Files, page 24

Hypertext Markup Language (HTML) Files

HTML files are files written in the language used for display on the World Wide Web. A Web page
is typically in HTML format. AppXtender Image Capture stores HTML files in their native format.
The content of the HTML file appears in the Batch Display view. You can print or fax an HTML
page. Page information and batch view properties are not available for HTML files. You can launch
the file to view it in a standard Web browser.

For more information, see:

* Supported Files, page 24

Portable Document Format (PDF) Files

PDF files are files in a proprietary Adobe format. AppXtender Image Capture stores PDF files
in their native format.

PDF files are displayed in their native format. The contents of the PDF file appears in the Document
Display window, even if you do not have the Foreign File Viewer enabled for foreign files. Because
PDF is natively supported in AppXtender Image Capture, the Foreign File Viewer is not required
to view file contents.

You can add annotations and adjust the display of the PDF file in many ways to allow optimal
viewing. Batch view properties are available for PDF files. You can also perform some of the export
functions (such as printing and faxing). While using these export functions, you may be able to hide
annotations on a PDF file, depending on the privileges assigned to your user account.
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For more information, see:

¢ Supported Files, page 24

Unsupported Files

Unsupported files are stored in AppXtender Image Capture in their native format. Unsupported
files include foreign files and OLE files. When you add a file of an unsupported type to AppXtender
Image Capture, it is added as a foreign file, unless you have configured the file’s extension on the File
Types tab on the AppXtender Image Capture Configuration dialog box. For example, if you have
mapped the DOC extension to the Embedded Object file type on the File Types tab, when you import
a file with the DOC extension into AppXtender Image Capture, it is added as an OLE object. For more
information on configuring the File Types tab, consult your AppXtender system administrator or refer
to the Configuring AppXtender Workstations chapter of the ApplicationXtender Administration Guide.

For more information, see the following topics:

* How Batches are Stored and Displayed in AppXtender Image Capture, page 23
¢ Foreign Files, page 27
* OLE Objects, page 28

Foreign Files

When you import a file that is not natively supported in AppXtender Image Capture, AppXtender
Image Capture stores that file as a foreign file. All files other than TIFF, Windows bitmaps, JPEG,
TGA, GIF, PCX, DCX, RTF, and HTML are stored in AppXtender Image Capture as foreign files.
AppXtender Image Capture stores foreign file types in their native file format.

You can print or fax a foreign file page. You can view page information for foreign files in AppXtender
Image Capture. Batch view properties are also available for foreign files. If you would like to view a
foreign file, you can launch the foreign file in its associated source application to do so.

You can choose how to display foreign files in the AppXtender Image Capture Batch Display view.

If you enable the Foreign File Viewer in AppXtender Image Capture Configuration, the content of
foreign files that are supported under the Foreign File Viewer appear in the view. If you do not enable
the Foreign File Viewer, foreign files appear as icons in the Batch Display view.

Note: If the Foreign File Viewer setting is enabled and Microsoft Office is installed on the computer,
AppXtender Image Capture automatically displays supported Microsoft Office documents in a native
Office embedded window inside the Batch Display view. Refer to Embedded Office Viewer File
Support, page 97 for more information.

For a list of the foreign files that can be viewed using the Foreign File Viewer feature, see .
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For more information, see:

¢ Unsupported Files, page 27

OLE Objects

If you have mapped an extension to the Embedded Object file type on the File Types tab, when you
import a file with that extension into AppXtender Image Capture, AppXtender Image Capture

uses Object Linking and Embedding (OLE) to embed the file in AppXtender Image Capture. The
content of the object appears in the AppXtender Image Capture Batch Display view. AppXtender
Image Capture stores OLE objects in their native file format. For more information on configuring the
File Types tab, consult your AppXtender system administrator or refer to the Configuring AppXtender
Workstations chapter of the ApplicationXtender Administration Guide.

You can print or fax an OLE object page. You can view page information for OLE objects in
AppXtender Image Capture. Batch view properties are also available for OLE objects.
For more information, see:

¢ Unsupported Files, page 27

Selecting Data Sources

A data source is the means by which ApplicationXtender Image Capture stores data to a database.
Multiple data sources can be viewed simultaneously within AppXtender Image Capture. In this way,
you can access applications located on many different data sources during a single AppXtender
Image Capture session, provided you have security rights to access those data sources.

This topic describes how to specify multiple data sources for display in AppXtender Image Capture or
AppXtender, and how to specify a default data source for the Move Online module. For information

on data source creation and configuration, consult your AppXtender system administrator or refer to
the AppXtender Data Sources chapter of the ApplicationXtender Administration Guide.

Note: You can save data source settings (which data sources are default and which are selected) to a
file, along with other AppXtender workstation settings. Also, if you have such a saved settings file,
you can load the data source settings from that file. For instructions, refer to the ApplicationXtender
Administration Guide.

For more information, see:

* Specifying a Default Data Source, page 29
* Specifying Multiple Data Sources, page 28

Specifying Multiple Data Sources

If you have multiple data sources configured in the Data Source Selector, you can designate multiple
data sources to be viewed within AppXtender Image Capture. This allows you to view applications
from all applicable data sources during a single AppXtender Image Capture session.
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Note: Even if multiple data sources are designated for viewing within AppXtender Image Capture,
only the data source designated as the default data source can be edited using AppXtender
Administrator, or the import wizards.

To configure multiple data sources to be viewed in AppXtender Image Capture:

1. From the Windows Start menu, select Programs> OpenText >Data Source Selector. The
AppXtender Data Source Selector dialog box appears.

o App¥tender Data Source Selector x|

Diata Source Mame | Description | Locate,
ApptenderDEMO Mo Description:
@ RMAPFXE30 10-15-05 Refresh

k. I Cancel | Set an Defaultl S how/Hide Smply

2. Select the data source that you want to use as the default and click Set as Default. A white check
mark within a black background (lml ) appears next to it.

3. Select the data source that you want to be viewable within AppXtender Image Capture
(in addition to the default data source) and click Show/Hide. A black check mark with no
background ( ¥ ) appears next to it.

4. Repeat the previous step for each additional data source you want to be accessible within

AppXtender Image Capture.

5. Click OK or Apply. (OK saves your changes and closes the dialog box. Apply saves your changes
without closing the dialog box.) The next time you launch AppXtender Image Capture, all data
sources that you marked with check marks are accessible.

For more information, see:
e Chapter 1, Getting Started

Specifying a Default Data Source

The Data Source Selector allows you to set a data source as default.

To set a data source as default:

1. From the Windows Start menu, select Programs> OpenText > Data Source Selector. The
AppXtender Data Source Selector dialog box appears.
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2. Double-click the data source that you want to set as default. A white check mark within a black

background (lml ) appears next to the data source.

3. Click OK or Apply. (OK saves your changes and closes the dialog box. Apply saves your changes
without closing the dialog box.)

Note: You must specify a data source as default before you can close the AppXtender Image Capture
Data Source Selector dialog box.

For more information, see:
¢ Chapter 1, Getting Started

Starting ApplicationXtender Image Capture

ApplicationXtender Image Capture (AppXtender Image Capture) is a scanning module integrated
with ApplicationXtender (AppXtender). Batches are scanned in AppXtender Image Capture and then
released to AppXtender for indexing.

Like AppXtender, AppXtender Image Capture is password protected, which means that it monitors
each user’s activity and allows or denies access to certain information and functions based on

that user’s assigned privileges. Only four AppXtender privileges are necessary for functions in
AppXtender Image Capture:

* The Batch Scan privilege is the most essential privilege for an AppXtender Image Capture user.
This privilege is required for a user to create or display batches.

* The Print privilege allows users to print or fax pages in AppXtender Image Capture.

* The Configure WS privilege allows users to view all the tabs on the AppXtender Image Capture
Configuration dialog box, rather than just the View, Display, and Scan tabs.

¢ The AppXtender Administrator privilege allows users to reset a batch. (Only administrative
users should have this privilege.)

The system administrator assigns privileges to a user’s account. AppXtender and AppXtender Image
Capture have varying levels of security, from initial login to document level.

The administrator can assign full system rights for all applications or different rights from one
application to another. For example, a user may have full privileges for the "Purchase Orders"
application, but only the Batch Scan privilege for the "Human Resources" application. Each user
account is driven by the user name and password, making this information required when logging
into the system.

If you do not have an assigned user name and password, consult your AppXtender system
administrator to obtain an AppXtender user account. If you cannot perform a particular AppXtender
Image Capture function, consult the system administrator to verify your security privileges, or refer
to the Managing Security chapter of the ApplicationXtender Administration Guide.

Note: Your login procedure can vary depending on whether you have logged in before and
depending on the security provider in use for the current data source. For information, see Variations
on Login Procedures, page 31.
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To start AppXtender Image Capture:

1.

From the Windows Start menu, select Programs> OpenText > AppXtender Image Capture. The
Login dialog box appears.

In the User Name text box, enter a user name that is valid for the active data source.
In the Password text box, enter your password.

If you are the only person using AppXtender Image Capture on this workstation, you can select
the Remember password option to enable it.

Note: The Remember password option is only available if it has been enabled for AppXtender
Image Capture for your AppXtender workstation. If the Remember password option is selected,
AppXtender Image Capture remembers the user name and password. All subsequent logins
bypass the Login dialog box. For information on disabling this feature, see New Login, page 33.

Click Login. If the correct information has been entered, AppXtender Image Capture
starts. For more information about built-in security in AppXtender Image Capture, consult
your AppXtender system administrator or refer to the Managing Security chapter of the
ApplicationXtender Administration Guide.

The status bar indicates whether a scanner is detected.

For more information, see:

Chapter 1, Getting Started

New Login, page 33

Logging into Multiple Data Sources, page 34
Viewing Application Properties, page 34

Variations on Login Procedures

The variations in login procedures depend on whether you have logged in before and depend on the
security provider in use for the data source. The following table describes each variation:
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Table 2. Variations in Login Procedures

Variation

Description

If this is the first time you are starting
AppXtender Image Capture (or if you have
connected a different scanner to the computer)

Before you start AppXtender Image Capture,
install and load the appropriate scanner
driver on the Scanning workstation. For
information, consult your AppXtender system
administrator or refer to the "Planning Your
ApplicationXtender Installation" chapter of the
ApplicationXtender Installation Guide.

After you click Login, you must select the correct
scanner type for the workstation. This step is
necessary to allow you to begin scanning. For
instructions, see Selecting a Scanner, page 46.

If the current data source is using the CM
security provider

Passwords are not case-sensitive.

If the current data source is using the Windows
security provider

When you attempt to start XtenderSolutions
software, your current Windows user account is
checked for authentication and authorization.
Depending on your profile, you might be
automatically logged into the software without
a Login dialog box.

If you want the Login dialog box to appear, press
[Shift] while you attempt to start the software
and until the Login dialog box appears.

You must precede the user name with a
domain and a backslash. For example, typing
CM\ axadmin indicates the "axadmin" user on
the "CM" domain.

Passwords are case-sensitive.
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Variation Description
If the current data source is using a directory Depending on configuration in the LDAP
service security provider directory service and in ApplicationXtender

Administrator, you may need to specify

user account information in multiple

parts, separated by backslashes (\). The
administrator who configures directory services
in ApplicationXtender Administrator should
distribute appropriate login instructions. For
instructions on configuring directory services
in ApplicationXtender Administrator, refer

to the ApplicationXtender Core Components
Administrator’s Guide.

Passwords are case-sensitive.

If the Remember Password option has been You are automatically logged in using your
enabled in AppXtender or AppXtender Image | current user name and the same logon type that
Capture had been selected the last time.

For more information, see:

¢ Starting ApplicationXtender Image Capture, page 30

New Login

AppXtender Image Capture allows you to log into AppXtender Image Capture as another user
during your active session. For example, when a system administrator wants to make a change to a
setting on the AppXtender Image Capture Configuration dialog box and uses the workstation that
Bob is logged into, he can select New Login from the File menu and log in as SYSOP. After he makes
a change, he can select New Login from the File menu again and log back in as Bob.

Note: If your workstation has been configured to remember a user’s password for faster startup, keep
in mind that logging in as a new user disables the remember password feature.

Note: Your login procedure may vary depending on the security provider in use for the current data
source. For information, see Variations on Login Procedures, page 31.

To log in as a new user:

1. From the File menu, select New Login. The Login dialog box appears.

2. In the User Name text box, enter a user name that is valid for the active data source.

3. In the Password text box, enter your password.

4. Click Login. If the correct information has been entered, AppXtender Image Capture restarts
using the new user name and password. For more information about the built-in security in
AppXtender Image Capture, consult your AppXtender system administrator or refer to the
Managing Security chapter of the ApplicationXtender Administration Guide.

33



Getting Started

For more information, see:

e Starting ApplicationXtender Image Capture, page 30

Logging into Multiple Data Sources

If multiple data sources have been configured using the AppXtender Data Source Selector, you can
now access them all from the AppXtender Image Capture interface. In this way, you can access
applications located on many different data sources during a single AppXtender Image Capture
session. By default, you are logged into only one data source. To log into other data sources available
in the Applications view, use the following procedure.

Note: Your login procedure may vary depending on the security provider in use for the current data
source. For information, see Variations on Login Procedures, page 31.
To log into another data source:

1. Loginto AppXtender Image Capture. The AppXtender Image Capture interface appears, with a
list of available data sources located within the Applications view.

2. You are automatically logged into the active data source (the active data source appears in bold
type, with applications expanded, in the data source list).

3. Right-click the data source you want to log into. From the shortcut menu that appears select
Login. The Login dialog box appears for the selected data source.

Note: As an alternative to right-clicking the data source and selecting Login, you can click the
plus (+) sign located to the left of the data source.

4. In the User Name text box, enter a user name that is valid for the selected data source.
5. In the Password text box, enter your password.

6. If you are the only person that uses AppXtender on this workstation, you can select the Remember
password option to remember your password when you log in.

Note: The Remember password option is only available if it has been enabled for your
AppXtender workstation. If the Remember password option is selected, AppXtender remembers
the user name and password. All subsequent logins bypass the Login dialog box. For information
on disabling this feature, see New Login, page 33.

7. Click Login to log into the data source.

For more information, see:

¢ Starting ApplicationXtender Image Capture, page 30

Viewing Application Properties

The General tab of the Application Properties dialog box contains basic information about the selected
application, including a description of the application, the date and time the application was created,
and the write paths for documents, annotations, OCR output text, and full-text versions of documents.
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To view general application properties:

1. Right-click the application name in the Applications view. From the shortcut menu that appears,
select Properties. The Application Properties dialog box appears.

2. Click the General tab.

3. When you are finished viewing general application properties, click OK to close the Application
Properties dialog box.

For more information, see:

* Starting ApplicationXtender Image Capture, page 30
¢ Configuring the Title Bar, page 55

AppXtender Image Capture Views

The AppXtender Image Capture desktop consists of many views or windows that you can customize
to fit your preferences. The views can be set to hidden or active and are dockable.

For more information, see:
e Chapter 1, Getting Started

* Applications View, page 35
¢ Batch Display View, page 36

Applications View

The Applications view contains a tree structure, listing data sources, and applications.

To show or hide the Applications view:

¢ From the View menu, select Applications.

To show or hide the list of applications:
1. In the Applications view, right-click the name of the data source. A shortcut menu appears.

2. You have the following choices:

¢ If you want to show the list of applications, click Expand.
e If you want to hide the list of applications, click Collapse.

To activate an application and its data source:

* Double-click the application name in the Applications view.

The active application and its data source are in bold in the Applications view.

35



Getting Started

For more information, see:

¢ AppXtender Image Capture Views, page 35

Batch Display View

The Batch Display view allows you to view a stored batch after you have retrieved it or a new batch
while you are scanning into it.

To display an existing batch in Batch Display view:
1. From the Batch menu, select List. The Batch Scan dialog box appears.

2. In the Batches for application drop-down list, select the application that contains the batch that
you want to display. A list of batches in the selected application appears in a table.

Note: This procedure is just an overview of the interface. If you are reading this procedure to
become more familiar with AppXtender Image Capture, you might not have batches to work
with yet. For information on adding new batches, see Chapter 3, Creating Batches.

3. Double-click the row for the batch that you want to display. The Batch Scan dialog box closes
and the selected batch appears in Batch Display view. For more information on displaying
stored batches, see Displaying a Batch, page 95.

You can use the pointer to manipulate the displayed batch in several ways, depending on the current
pointer mode. In pan mode, you can drag the image in the view to see more of it. In selection mode,
you can select a region of the image and implement several commands on that region.

To switch between pan mode and selection mode:
¢ C(lick the Pan Mode button on the Image toolbar.

0

For more information, see:

* AppXtender Image Capture Views, page 35

AppXtender Image Capture Toolbars

ApplicationXtender Image Capture (AppXtender Image Capture) has three different toolbars.
These toolbars provide shortcut buttons for the most frequently used AppXtender Image Capture
commands. When the mouse pointer is held over a toolbar button, a description of the button’s
function is displayed as a tool tip and in the status bar.

Each toolbar can be displayed, customized, or hidden, depending on your preference. For
information on displaying, customizing, or hiding a toolbar, see Configuring Toolbars, Title Bar,
and Status Bar, page 53.

Each toolbar is described in one of the following topics:

* Main Toolbar, page 37

* Annotation Toolbar, page 38
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¢ Image Toolbar, page 40
* Scan Toolbar, page 41

For more information, see:
¢ Chapter 1, Getting Started

Main Toolbar

The Main toolbar contains buttons that allow the user to access the essential functions of AppXtender
Image Capture.

| &glsmr » OB SS

The following table describes each button on the ApplicationXtender Image Capture Main toolbar:

Table 3. ApplicationXtender Image Capture Main Toolbar Buttons

Button Function For More Information, See
L The Applications View button | Applications View, page 35
shows or hides the Applications
view.
= The Print button prints the Printing or Faxing Pages and
currently displayed page. Regions, page 135
4 The Cut button cuts the Cutting Pages, page 138
displayed page to the Windows
Clipboard.
The Copy button copies the Copying Pages, page 137
displayed page to the Windows
Clipboard.
) The Paste button adds a new Adding a Page from the

page to the displayed batch Windows Clipboard, page 101
from the contents of the
Windows Clipboard.

P The Configuration button Opening the AppXtender
opens the AppXtender Image | Image Capture Configuration
Capture Configuration dialog Dialog Box, page 62

box.

0 The Tile Vertically button Tile, page 110
tiles windows (such as Batch
Display view and Applications
view windows) vertically.

=] The Tile Horizontally button Tile, page 110
tiles windows (such as Batch
Display view and Applications
view windows) horizontally.
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Button Function For More Information, See

B The Cascade Windows button | Cascade, page 110
cascades windows (such

as Batch Display view and
Applications view windows).

The Select Scanner button Selecting a Scanner, page 46
A g pag

opens the Select Scanner dialog

box.

The Scan Batch toolbar button | Creating a Batch By Scanning,
Py g y g

opens the ApplicationXtender | page 84
Image Capture dialog box,
which allows you to begin
scanning a batch into the active
application.

For more information, see:

* AppXtender Image Capture Toolbars, page 36

Annotation Toolbar

The Annotation toolbar allows you to add annotations to your batch pages. All of the functions on the
Annotation toolbar can also be accessed from the Annotate menu.

[k @ssr 2N/ OQ0OCID |2 (@R
RE-~&d9-=-2-XHaD-

This topic briefly explains each Annotation toolbar button. For more information on annotating
a page, see Chapter 5, Annotations.

Note: Only users with appropriate privileges can access features in the Annotations menu and
toolbar. If you have questions about the privileges assigned to your AppXtender user profile,
consult your AppXtender system administrator or refer to the Managing Security chapter of the
ApplicationXtender Administration Guide.

Table 4. ApplicationXtender Image Capture Annotation Toolbar Buttons

Button Function
k Allows selection of annotations (toggle). For
information, see Modifying Annotation Settings,
page 165.
Creates a text annotation. For information, see

Creating a Text Annotation, page 150.

S Creates a highlight annotation. For information,
see Creating a Highlight Annotation, page 157.
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Button

Function

&

Creates a freehand line annotation. For
information, see Creating a Basic Line
Annotation, page 153.

~

Creates a straight line annotation. For
information, see Creating a Basic Line
Annotation, page 153.

Creates an arrow annotation. For information,
see Creating a Basic Line Annotation, page 153.

O

Creates a rectangular annotation. For
information, see Creating a Basic Shape
Annotation, page 155.

Creates a rounded rectangular annotation.
For information, see Creating a Basic Shape
Annotation, page 155.

Creates an oval annotation. For information, see
Creating a Basic Shape Annotation, page 155.

Creates a polyline annotation. For information,
see Creating a Polyline Annotation, page 154.

Creates a polygon annotation. For information,
see Creating a Polyline Annotation, page 154.

Erases the annotation. For information, see
Erasing Annotations, page 172.

| S| o Al O

Creates a filled or hollow annotation (toggle).
For information, see Default Filled or Hollow
Setting, page 147.

Creates an annotation with redaction (toggle).
For information, see Default Redaction Setting,
page 147.

Selects the default annotation group. For
information, see Default Annotation Group,
page 148.

Selects all annotations. For information, see
Modifying Annotation Settings, page 165.

Brings selected annotation to front. For
information, see Overlapping Annotations, page
160.

Sends selected annotation to behind. For
information, see Overlapping Annotations, page
160.
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Button Function

q - Shows or hides annotations (toggle) and
allows you to hide annotations by annotation
group. For information, see Showing or Hiding
Annotations, page 162.

Selects line width. For information, see Default
Line Width, page 143.

]
4

. Selects annotation colors. For information, see
Default Color for Line and Shape Annotations,
page 146.

® Deletes the selected annotation(s). For
information, see Deleting Annotations, page 172.

] Saves all annotations.

) Cancels annotation changes.

B - Allows you to add rubber stamp annotations to

a page.

For more information, see:

* AppXtender Image Capture Toolbars, page 36

Image Toolbar

The Image toolbar contains buttons that allow the user to change the Batch Display view.

|+ -BOHSeLe odnlo

The following table describes each button on the ApplicationXtender Image Capture Image toolbar:

Table 5. ApplicationXtender Image Capture Image Toolbar Buttons

Button Function For More Information, See

P The Next Sticky View button Using Sticky View, page 58
applies the next available
Sticky View to images of the
same type as the current page.
You can create Sticky Views to
apply specific zoom, rotation,
and scale-to-gray settings to
the currently displayed type of
image.

] The Fit to Window button fits | Fit to Window, page 115
displayed page in the Batch
Display view.
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Button

Function

For More Information, See

1]

The Fit Height button fits
displayed page in the Batch
Display view top to bottom.

Fit to Window Height, page 116

The Fit Width button fits
displayed page in the Batch
Display view left to right.

Fit to Window Width, page 116

displayed page 90° to the right.

L3 The Rotate Left button rotates | Rotate Left, page 117
displayed page 90° to the left.
g The Rotate Right button rotates | Rotate Right, page 117

The Zoom In button zooms in
on displayed page. (The image
appears larger.)

Zoom In, page 114

The Zoom Out button zooms
out on displayed page. (The
image appears smaller.)

Zoom Out, page 114

The Magnifier button opens the
Magnifier window.

Using the Magnifier, page 117

The Previous Page button
displays previous page.

Previous Page, page 108

The Next Page button displays
next page.

Next Page, page 108

G| 2| =D

The Pan Mode button switches
between pan mode and
selection mode.

Batch Display View, page 36

For more information, see:

* AppXtender Image Capture Toolbars, page 36

Scan Toolbar

The Scan toolbar allows you to perform and configure scanning operations. All of the functions on
the Scan toolbar can also be accessed from the Scan menu.

|5 8|4 32|00 =]|[stone =] |[Letersie 855110

|| |40F Simplex =] | - | & -

This topic briefly explains each Scan toolbar button and drop-down list. For more information on
scanning, see Creating a Batch By Scanning, page 84.

Note: Only users with all of the following can access features in the Scan menu or toolbar:

* Scanning hardware installed on the user's workstation

¢ The scanner drivers appropriate for the scanner installed on the user's workstation
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* AppXtender scanner support files installed on the user's workstation
¢ The Batch Scan privilege assigned to the user

Note: For information on hardware and drivers, refer to the scanner's documentation. For information
on which scanners are supported with AppXtender Image Capture, see Selecting a Scanner, page 46.
For information on support files and privileges, consult your AppXtender system administrator or
refer to the ApplicationXtender Installation Guide and the ApplicationXtender Administration Guide.

Table 6. ApplicationXtender Image Capture Scan Toolbar Buttons

Button Function

EY The Scan button begins a scanning session.

e If a batch is currently displayed, the Scan
button creates a new page.

¢ If no batch is currently displayed, the Scan
button opens the ApplicationXtender Image
Capture dialog box, which allows you to
begin scanning a new batch into the active
application.

B The Rescan button repeats the previous scan.
This button is available only while the most
recently scanned image is still displayed.

o The Auto Feed button enables automatic feed
mode. In automatic feed mode, AppXtender
Image Capture scans all of the pages in the
feeder. When the feeder is empty, the scan
session ends.

The Manual Feed button enables manual feed
£
mode. In manual feed mode, AppXtender Image
Capture scans all of the pages in the feeder, and
then waits for you to add more pages before the
scan session times out.

lg The Single Feed button enables single feed
mode. In single feed mode, AppXtender Image
Capture scans only one page at a time. After
each page is scanned, you must click the Scan
button again to scan the next page.

. The Front Rotation button configures the
automatic rotation of images as they are
scanned.

. The Back Rotation button configures the

automatic rotation of images as they are
scanned. This button is available only when the
scanner is set to scan both sides of each page,
and applies to the image that originates from the
back side of the page.
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Button

Function

B -

The Scanner Setup button displays a shortcut
menu so that you can configure scanning.

The Auto Enhance button enables or disables
automatic enhancement of images as they are
being scanned.

In addition to these buttons, the Scan toolbar also has four drop-down lists. These lists, which are
different for each scanner and may not be available depending on the scanner type, allow you to
change the following settings for the images that you scan.

Table 7. Scan Toolbar Drop-down Lists

List

Function

DPI Resolution

Sets the resolution for the scanned images in
dots per inch

Number of Colors

Sets the number of colors for the scanned images
(for example bi-tonal, 16-Level Gray, 256-Level
Gray, and 24-Bit Color)

Page Size

Sets the page dimensions for the scanned images
(for example, letter, legal, or A4)

Scanner Source

Sets the number of images per page for the
scanner (for example, simplex or duplex)

For more information, see:

AppXtender Image Capture Toolbars, page 36
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Chapter 2
Configuring AppXtender Image Capture

This section explains all the end-user configuration options in ApplicationXtender Image Capture.
For information on specific aspects of customizing workstation settings, see the following topics:

¢ Introduction to Configuration, page 45

* Selecting a Scanner, page 46

¢ Optional Scanning Configurations, page 47

¢ Configuring Toolbars, Title Bar, and Status Bar, page 53

¢ Print Setup, page 57

* Using Sticky View, page 58

¢ Customizing AppXtender Image Capture Views, page 60
* Opening the AppXtender Image Capture Configuration Dialog Box, page 62
¢ View Tab, page 63

* Display Tab, page 66

* Scan Tab, page 68

¢ Print Tab, page 72

¢ File Types Tab, page 75

* Data Tab, page 77

* Paths Tab, page 80

Introduction to Configuration

Many configuration options are available to accommodate individual preferences. Some configuration
options are integral to the functionality in ApplicationXtender Image Capture (AppXtender Image
Capture), such as scanner selection and scanning options; and the file types and the storage formats
that AppXtender Image Capture uses.

Others are cosmetic and do not alter the way the system performs, such as options controlling the
look and feel of the main screen. You can adjust the layout of the AppXtender Image Capture
desktop and the behavior of the AppXtender Image Capture views. You can also customize toolbar
display and settings.
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Selecting a Scanner

AppXtender installs scanner support files when the scanning option is selected during installation.
Refer to the ApplicationXtender Release Notes for more information on supported scanner drivers.

The manufacturer’s recommended scanner driver must also be installed on your workstation to
scan. For more information, consult your system administrator or refer to the "Planning Your
ApplicationXtender Installation" chapter of the ApplicationXtender Installation Guide.

Before you begin scanning, the scan workstation must have the correct scanner type selected.

To select a scanner for your workstation:

1. Install and load the appropriate scanner driver on the scan workstation. For information, consult
your AppXtender system administrator or refer to the "Planning Your ApplicationXtender
Installation" chapter of the ApplicationXtender Installation Guide.

2. From the Scan menu, select Configuration> Scanner. The Select Scanner dialog box appears.

Select Scanner x|

Available Scanners:

< MOME >
ThaétslN: CFM-Twain DR-3020

Cancel Help

Note: If your scanner does not appear in the Select Scanner list, ensure the scanning option

was selected during the ApplicationXtender Document Manager installation, and the
appropriate scanner driver has been installed. For information, consult your AppXtender system
administrator or refer to the "Planning Your ApplicationXtender Installation" chapter of the
ApplicationXtender Installation Guide.

3. Select your scanner from the list and click OK. Depending on the scanner, another dialog box
could appear, allowing you to configure the scanner driver. For instructions, refer to the
documentation for your scanner.
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For more information, see:

® Chapter 2, Configuring AppXtender Image Capture

Optional Scanning Configurations

You can configure several scanner properties to produce the scanning results that you want. The
following topics describe how to configure each aspect of scanning.

* Scan Feeder Options, page 47

* Automatic Enhancement, page 48

® Resolution Settings, page 49

* Mode Settings, page 49

* Page Size Settings, page 50

® Source Setting, page 50

* Automatic Rotation, page 51

® Scanner Driver Configuration, page 52

You can use either the Scan menu or the Scan toolbar to perform each of these configurations. For
information on the Scan toolbar buttons, see AppXtender Image Capture Toolbars, page 36. For
information on hiding or customizing the Scan toolbar, see Configuring Toolbars, Title Bar, and
Status Bar, page 53.

Because AppXtender Image Capture supports many different scanners, and each scanner may have
a different set of configuration options, all scanner settings you see may not be described in detail
here. If you are not sure which setting to choose for a particular option, refer to the documentation
included with your scanner for more information on scanner settings for your scanner.

For more information, see:

o Chapter 2, Configuring AppXtender Image Capture

Scan Feeder Options

AppXtender Image Capture provides three different options for operating the scanner feeder. They
include single feed, manual feed, and automatic feed. These options are mutually exclusive; only
one of the options can be activated.

For more information, see:

¢ Optional Scanning Configurations, page 47
® Automatic Feed, page 48

* Manual Feed, page 48

* Single Feed, page 48

47



Configuring AppXtender Image Capture

Automatic Feed

In automatic feed mode, AppXtender Image Capture scans all of the pages in the feeder. When the
feeder is empty, the scan session ends. After all of the pages in the feeder have been scanned, if you
put more pages in the feeder, you must click the Scan button again to scan the new pages.

To enable automatic feed:

e From the Scan menu, select Feed and then Auto.

For more information, see:

¢ Scan Feeder Options, page 47

Manual Feed

In manual feed mode, AppXtender Image Capture scans all of the pages in the feeder, and then waits
for you to add more pages before the scan session times out. After the time runs out, if you put more
pages in the feeder, you must click the Scan button again to scan the new pages.

The timeout is configurable, and is set in the AppXtender Image Capture Configuration dialog box.
The default is 20 seconds. For information on configuring the Scanner Manual Feed Timeout, see
Scanner Manual Feed Timeout, page 72.

To enable manual feed:

e From the Scan menu, select Feed and then Manual.

For more information, see:

* Scan Feeder Options, page 47

Single Feed

In single feed mode, AppXtender Image Capture scans only one page at a time. After each page is
scanned, you must click the Scan button again to scan the next page.
To enable single feed mode:

* From the Scan menu, select Feed and then Single.

For more information, see:

® Scan Feeder Options, page 47

Automatic Enhancement

AppXtender Image Capture allows you to automatically enhance pages as they are being scanned. If
the pages that you are scanning will be processed using optical character recognition (OCR) in
AppXtender, this feature can make the OCR more accurate. Automatic enhancement applies all
settings configured in the ScanFix Configuration dialog box and the ScanFix Advanced settings dialog
box. Automatic enhancement applies to bi-tonal (black and white) images only.
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To enable or disable automatic enhancement:
¢ From the Scan menu, select Configuration and then Auto Enhancement. The automatic
enhancement feature toggles on or off.

Note: This automatic enhancement requires the purchase of the Scanfix enhancement license.

For more information, see:

¢ Optional Scanning Configurations, page 47

* Enhancement Settings, page 49

Enhancement Settings

When automatic enhancement is enabled, all bi-tonal images scanned into AppXtender Image
Capture are enhanced using the configured enhancement settings. The effectiveness of this feature
for improving OCR processing of scanned images in AppXtender depends entirely on how you
configure image enhancement settings.

To configure image enhancement settings:

* From the Scan menu, select Configuration and then Enhancement Configuration.

The ScanFix Configuration dialog box appears. You may configure the settings to produce the desired
results. For details on image enhancement settings, see Chapter 6, Image Enhancement.

For more information, see:

* Automatic Enhancement, page 48

Resolution Settings

The Resolution drop-down list is located on the Scan toolbar and can be used to change the dots per
inch (DPI) resolution setting. The DPI options available to you depend on your scanner. Higher DPI
settings produce larger file sizes. However, higher settings also produce greater image clarity, which
might improve OCR processing of the scanned images in AppXtender. The recommended setting is
200 DPL. If you require higher quality, you can select another option.

To configure resolution settings:

¢ From the Scan menu, select Resolution and then the DPI setting that you want to use.

For more information, see:

* Optional Scanning Configurations, page 47

Mode Settings

The Mode drop-down list is located on the Scan toolbar and can be used to change the scanning
mode. Some scanning mode examples are bi-tonal, 16-Level Gray, 256-Level Gray, and 24-Bit Color,
and vary depending on your scanner. When selecting a scanner mode, remember that there is a
trade-off between the size of the resulting file and the clarity of the scanned page. For example, the
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256-Level Gray option provides more clarity than the Bi-tonal option, but also produces a much larger
file, as shown in the following table. The recommended setting for efficient scanning is bi-tonal.

Table 8. Example File Sizes When Using Different Modes for Same Image

Mode File Size
Bi-tonal 12 KB
256-Level Gray 3,367 KB
24-Bit Color 10,040 KB

To configure mode settings:

* From the Scan menu, select Mode and then the mode setting you want to use.

For more information, see:

¢ Optional Scanning Configurations, page 47

Page Size Settings

The Page Size drop-down list is located on the Scan toolbar and can be used to change the page size
and orientation. The Page Size option sets the size of the page that you are scanning. The options
listed for you vary depending on your scanner. Some page size examples are A4, Legal, Letter, and B5.
To configure page size settings:
* From the Scan menu, select Page Size and then the size and, if available, orientation you want

to use.

If you scan a page that is larger than the current page size setting, part of the image is not scanned. If
you scan a page that is smaller than the current page size setting, black areas are added to the edges
of the scanned image, which means the file size is larger than it needs to be.

For more information, see:

¢ Optional Scanning Configurations, page 47

Source Setting

The Source drop-down list allows you to choose a scanner source. Options available for you may
include Flatbed, ADF Simplex, and ADF Duplex, although the options vary depending on your
scanner. The following table describes the typical source settings and what they mean:
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Table 9. Typical Source Settings

Source Setting Description

Flatbed Flatbed refers to using the scanner’s top paper
bed, similar to a copy machine.

ADF Simplex Automatic Document Feeder (ADF) Simplex
refers to using the automatic document feeder
to scan only the front side of the document.

ADF Duplex ADF Duplex refers to using the automatic
document feeder to scan both sides of the
document.

To configure source settings:

* From the Scan menu, select Source and then the source you want to use.

For more information, see:

¢ Optional Scanning Configurations, page 47

Automatic Rotation

AppXtender Image Capture allows you to automatically rotate pages as they are being scanned. If
you have configured your source as duplex, separate options are provided to set the rotation of front
and back pages being scanned. If you have configured your source as something other than duplex,
you need only to configure the front-page rotation.

Rotation can be set to 90, 180 and 270 degrees. When you click the Front Rotation and Back Rotation
buttons on the Scan toolbar, the setting toggles from None to 90°, to 180°, to 270°. T :

For more information, see:

* Optional Scanning Configurations, page 47
¢ Front Page Rotation, page 52
¢ Back Page Rotation, page 52
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Front Page Rotation

To configure automatic rotation for all front pages:

* From the Scan menu, select Rotation (Front) and then the desired rotation setting (None, 90
Degrees, 180 Degrees, or 270 Degrees).

For more information, see:

* Automatic Rotation, page 51

Back Page Rotation

To configure automatic rotation for all back pages:

* From the Scan menu, select Rotation (Back) and then the desired rotation setting (None, 90
Degrees, 180 Degrees, or 270 Degrees).

For more information, see:

* Automatic Rotation, page 51

Scanner Driver Configuration

The Scanner Settings dialog box provides advanced features that relate to your scanner. The options
vary depending on the scanner you are using. Some examples of settings that may be included
are brightness, dither, and contrast.

To access your scanner’s advanced settings:
* From the Scan menu, select Configuration and then Driver Configuration.
The Scanner Settings dialog box for your scanner appears. The options and buttons that appear on

the Scanner Settings dialog box vary according to the scanner. For more information on configuring
this dialog box, refer to the documentation provided with your scanner.
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Any changes made in this dialog box are reflected in the Scan toolbar. Additionally, any settings you
change remain as the scanner settings until you change them.
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For more information, see:

* Optional Scanning Configurations, page 47

Configuring Toolbars, Title Bar, and Status Bar

You can customize the ApplicationXtender Image Capture (AppXtender Image Capture) toolbars, the
Batch Display view title bar, and the AppXtender Image Capture status bar to meet your needs. For

instructions, see the following topics:

* Displaying or Hiding a Toolbar, page 54 describes how to hide AppXtender Image Capture
toolbars from view or show AppXtender Image Capture toolbars.

¢ Changing the Size of Toolbar Buttons, page 54 describes how to increase or decrease the size of

AppXtender Image Capture toolbar buttons.

¢ Customizing Toolbars, page 55 describes how to remove buttons from the toolbar, add buttons to
the toolbar, or re-order the buttons on the toolbar.

* Configuring the Title Bar, page 55 describes how to specify whether the AppXtender data source
name or application name appears with the batch name in the title bar of the Batch Display view.

* Displaying or Hiding the Status Bar, page 57 describes how to hide or show the AppXtender

Image Capture status bar.

The following table briefly describes the functions available on each toolbar:

Table 10. AppXtender Image Capture Toolbars

Toolbar

Description

Main

The Main toolbar provides shortcuts to common
AppXtender Image Capture commands (such as
print, scan, and configure). These commands
can be executed by clicking the buttons on the
toolbar, eliminating the series of steps necessary
when using the pull down menus. For a detailed
description of each button on the Main toolbar,
see Main Toolbar, page 37.

Annotation

The Annotation toolbar contains shortcuts to
the annotation features, such as select, save,
delete, and create. For a detailed description
of each button on the Annotation toolbar, see
Annotation Toolbar, page 38. AppXtender
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Toolbar Description

Image The Image toolbar provides shortcuts for
manipulating images. Some of the buttons
available are pan mode, rotating, and zooming.
For a detailed description of each button on the
Image toolbar, see Image Toolbar, page 40.

Scan The Scan toolbar contains shortcuts for scanning
options and configuration settings such as
manual feed, automatic feed, single feed, rescan,
and different automatic-rotation options. For a
detailed description of each button on the Scan
toolbar, see Scan Toolbar, page 41.

For more information, see:

¢ Chapter 2, Configuring AppXtender Image Capture

Displaying or Hiding a Toolbar

AppXtender Image Capture toolbars can be shown or hidden from view. All AppXtender Image
Capture features are always available from menus, even if the toolbar is hidden. Toolbars can be
removed to create more space for displaying batches.

To display or hide a toolbar:

1. From the View menu, select Toolbars. In the Toolbars submenu, the name of each displayed
toolbar has a check mark next to it.

2. In the Toolbars submenu, click the name of the toolbar you want to display or hide. If the
toolbar you selected was previously displayed, it is now hidden. If the toolbar you selected
was previously hidden, it is now displayed.

For more information, see:

¢ Configuring Toolbars, Title Bar, and Status Bar, page 53

Changing the Size of Toolbar Buttons

The default size of AppXtender Image Capture toolbar buttons may be too small for some users. You
can change the size of AppXtender Image Capture toolbar buttons, if necessary.
To change the size of the toolbar buttons:

1. From the View menu, select Toolbars. In the Toolbars submenu, a check mark indicates the
current button size setting.

2. From the Toolbars submenu, depending on which size is currently selected, you have the
following options:

¢ Click Large Icons. The buttons increase in size.

e (Click Small Icons. The buttons decrease in size.
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For more information, see:

* Configuring Toolbars, Title Bar, and Status Bar, page 53

Customizing Toolbars

Any AppXtender Image Capture toolbar can be customized to meet your needs. Buttons can be
deleted from the toolbar, added to the toolbar, or re-ordered on the toolbar.

To customize a toolbar:

1. Right-click the toolbar you want to customize. A shortcut menu appears. From the shortcut
menu, select Customize. The Customize Toolbar dialog box appears.

Customize Toolbar d |

Ayailable toolbar buttarns: Current toolbar buttons:
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2. You have the following choices:

e Remove buttons from the toolbar by double-clicking on the button name in the Current
toolbar buttons list or by selecting the button name and clicking Remove.

* Add buttons to the toolbar by double-clicking on the button name in the Available buttons list
or by selecting the button name and clicking Add.

® Re-order buttons by selecting a button name in the Current toolbar buttons list and clicking
Move Up or Move Down or by dragging the button name to the new location.

¢ Reset to a pre-defined list of toolbar buttons by clicking Reset.

3. After you have completed customizing the toolbar, click Close.
For more information, see:

e Configuring Toolbars, Title Bar, and Status Bar, page 53

Configuring the Title Bar

When a batch is displayed in the Batch Display view, information about that batch appears in the
Batch Display view title bar, including the name specified for the batch when it was created.

For each application, you can configure the title bar to display the name of the AppXtender data
source that contains the batch, the name of the application that contains the batch, or both.
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To configure the Batch Display view title bar:

1. Inthe Applications view, right-click the application for which you want to configure the Batch
Display view title bar. A shortcut menu appears.

2. From the shortcut menu, select Properties. The Properties dialog box for the selected application
appears.

3. Select the Title tab.
x
General  Title |
The batch title will congist of the following:
¥ Data Source Name

v Application Name

Cancel Smply Help

4. Specify whether you want the name of the AppXtender data source to appear in the Batch Display
view title bar. You have the following choices:

* Toinclude the name of the AppXtender data source, enable the Data Source Name option.
¢ To leave out the name of the AppXtender data source, disable the Data Source Name option.

5. Specify whether you want the name of the application to appear in the Batch Display view title
bar. You have the following choices:

¢ To include the name of the application, enable the Application Name option.
¢ To leave out the name of the application, disable the Application Name option.

6. Save changes. You have the following choices:

¢ To save changes and keep the Properties dialog box open, click Apply.
¢ To save changes and close the Properties dialog box, click OK.
The next time you display a batch, the Batch Display view title bar reflects the changes.

For more information, see:

¢ Configuring Toolbars, Title Bar, and Status Bar, page 53
¢ Viewing Application Properties, page 34
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Displaying or Hiding the Status Bar

The status bar appears at the bottom of the AppXtender Image Capture screen and contains each of
the following from left to right:

* Help messages for ApplicationXtender Image Capture functions, describing toolbar button
functions and menu item functions

* The name of the active application
* The page number of the currently displayed page
* The total number of pages in the currently displayed batch

The AppXtender Image Capture status bar can be removed from the AppXtender Image Capture
window to save space for the Batch Display view. When the status bar is hidden, it reappears during
scanning to display the Cancel button and a progress bar.

To display or hide the status bar:

¢ From the View menu, select Status Bar. If the status bar was previously displayed, it is now
hidden. If the status bar was previously hidden, it is now displayed.

For more information, see:

¢ Configuring Toolbars, Title Bar, and Status Bar, page 53

Print Setup

The Print Setup dialog box allows you to set up the default print settings. From this dialog box,
you can select the printer, the orientation, the paper size, the paper source, and other properties of
future print jobs.

To configure printing:

1. From the File menu, select Print Setup. The standard Windows Print Setup dialog box appears.
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print setup 2|
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2. If you want to connect to a printer on the network, click Network. For further instructions,
refer to the Windows documentation.

Cancel

:

3. In the Print Setup dialog box, select a default printer from the Name list, and select the default
paper size, source, and orientation.

4. If you want to configure advanced properties of the selected printer, click Properties. For further
instructions, refer to the Windows documentation.

5. Click OK. The dialog box closes and the changes you have made are saved.

For more information, see:

¢ Chapter 2, Configuring AppXtender Image Capture

Using Sticky View

Sticky View means that ApplicationXtender Image Capture (AppXtender Image Capture) can
"remember"” display settings (zoom, rotation, and scale-to-gray) for similar page types. For example,
bi-tonal (black and white) pages can be "stuck" to open with certain zoom and rotation settings. A
different Sticky View could be set for bitmaps.

Sticky View can be helpful when scanning similar paper documents, by automatically displaying the
page at its actual size to facilitate monitoring the quality of the scan. AppXtender Image Capture
automatically discerns which page type is displayed and responds with the appropriate settings.

You can use Sticky View with the following page types. (The Information dialog box displays a page's
type. For more information, see Page Information, page 133.)

¢ Images
* Text (as defined in the File Types tab of the Configuration dialog box)
* OLE Objects (as defined in the File Types tab of the Configuration dialog box)
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Note: For more information on the File Types tab of the Configuration dialog box, consult your
system administrator or refer to the Configuring AppXtender Workstations chapter of the
ApplicationXtender Administration Guide.

Sticky View is different from the default display configuration in that the pages are not stored with
the sticky settings; the pages appear in Sticky View simply for batch creation and retrieval. The sticky
settings are in effect until Sticky View is turned off.

Sticky View applies the following settings:

® Zoom, as described in Using Zoom, page 113
* Rotation, as described in Using Rotate, page 117
* Scale-to-gray, as described in Using Scale-to-Gray, page 118

You can also save multiple sticky view settings for a displayed page and switch between each of
the saved sticky view settings. For more information, see Saving Sticky View Settings, page 59
and Switching Sticky View Settings, page 112.

For more information, see:

¢ Chapter 2, Configuring AppXtender Image Capture

Saving Sticky View Settings

The Save Setting feature allows you to store multiple sticky view settings for each page type. You can
save up to five different sticky view settings for each page type.

To save a sticky view setting:

1. Display a page with the desired settings.

2. Select a Save Settings view. From the View menu, select Sticky View and then Save Settings. The
Save Settings menu appears. Highlight the appropriate view (for example, View 1).

Wigw 1 Ale+-5hFt+1
Wigw £ Ale+-shft+2
Wigw 3 Alt+5hft+3
Wigw 4 Alt+5ht-+4
Wigw 5 Ale+ShFE+5

A check mark appears next to the saved view setting.

v e 1 Ale+5hFe+1
Wigw 2 Ale+-shft+2
Wigw 3 Ale+-5hft+3
Wigw 4 Alt+5hft+4
Wigw 5 Alt+Sht+S

3. Repeat steps 1 and 2 to save more views.
For more information, see:

e Using Sticky View, page 58

¢ Switching Sticky View Settings, page 112
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Customizing AppXtender Image Capture Views

The Applications view can be modified to meet your preferences. By changing the way your
ApplicationXtender Image Capture views display, you can customize your AppXtender Image
Capture desktop. The Applications view can be configured to appear as a docked view, as a dialog
box, or as a subwindow. The Applications view can also be configured to hide on use.

For more information, see the following topics:

* Docking a View, page 60

* Displaying a View as a Dialog Box, page 60
¢ Displaying a View as Subwindow, page 61
¢ Hiding a View on Use, page 61

For more information, see:

¢ Chapter 2, Configuring AppXtender Image Capture

Docking a View

An AppXtender Image Capture docked view has a grab bar. A grab bar is similar to a title bar
except it does not contain a title.

:ﬂ|

You can drag the view to the left, right, top, or bottom of the AppXtender Image Capture window by
dragging this bar. A docked view automatically aligns with the AppXtender Image Capture window
borders and cannot be moved beyond the AppXtender Image Capture window borders. By default,
the Applications view appears as a docked view.

Note: The following procedure applies to only the Applications view. It does not apply to the
Batch Display view.
To dock a view that is now a dialog box:

1. Double-click the title bar of the dialog box. The dialog box becomes a docked view, in the location
where the view was last docked.

2. Click the grab bar, and drag the view to the desired position on the AppXtender Image Capture
desktop. For the view to dock, drag it to the left, right, top, or bottom edge of the AppXtender
Image Capture desktop. When you release the mouse button, the view moves to that location.

For more information, see:

¢ Customizing AppXtender Image Capture Views, page 60

Displaying a View as a Dialog Box

An AppXtender Image Capture dialog box has a title bar with a Close button. Drag the view to a
different location on your desktop by dragging the title bar. A dialog box is independent of the
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AppXtender Image Capture window borders. It can be moved away from the AppXtender Image
Capture window borders, in any direction. This behavior is described as floating as a dialog box.

Applications |

Note: The following procedure applies only to the Applications view. It does not apply to the
Batch Display view.

To display a view as a dialog box:

1. If the view is docked, double-click the grab bar. The docked view becomes a dialog box.

2. Click the title bar and drag the dialog box to the desired location on the AppXtender Image
Capture desktop.

For more information, see:

* Customizing AppXtender Image Capture Views, page 60

Displaying a View as Subwindow

An AppXtender Image Capture subwindow has a title bar with Minimize, Maximize, and Close
buttons. Drag the view to a different location in the AppXtender Image Capture window by dragging
the title bar. A subwindow is independent of the AppXtender Image Capture window borders but
cannot be moved beyond them. This behavior is often described as floating as an MDI window.

=

Note: The following procedure applies only to the Applications view. It does not apply to the
Batch Display view.

To display a view as a subwindow:

1. Right-click in the docked view or view dialog box. A shortcut menu appears. From the shortcut
menu, select Float as MDI Window.

2. Click the Title bar and drag the subwindow to the desired location on the AppXtender Image
Capture desktop.
For more information, see:

¢ Customizing AppXtender Image Capture Views, page 60

Hiding a View on Use

By default, the views remain in the AppXtender Image Capture window until you close or hide them,
which means, when you display the Batch List, the Applications View remains. You can configure
the Applications view to hide when you display the Batch List.

This is described as hiding on use because you use the Applications view to display the Batch List.
When a view is configured to hide on use, this configuration is often described as hide on use mode.
In this mode, AppXtender Image Capture automatically hides the view after you select items from: it.
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You can always display the hidden view using the Applications View button on the Main toolbar.
The hide on use mode can be used on a view whether it displays as a docked view, as a dialog
box, or as a subwindow.

Note: The following procedures apply only to the Applications view. They do not apply to the
Batch Display view.

To configure a docked view to hide on use:

* Right-click the view’s grab bar. A shortcut menu appears. From the shortcut menu, select Hide
on Use.

To configure a dialog box or subwindow to hide on use:

* Right-click inside the dialog box or subwindow. A shortcut menu appears. From the shortcut
menu, select Hide on Use.

For more information, see:

¢ Customizing AppXtender Image Capture Views, page 60

Opening the AppXtender Image Capture
Configuration Dialog Box

You can customize the behavior of many aspects of ApplicationXtender Image Capture (AppXtender
Image Capture) functionality through the AppXtender Image Capture Configuration dialog box. You
can use the AppXtender Image Capture Configuration dialog box to change workstation defaults for
most features, such as zoom and tile.

If you have the Configure WS privilege, you can see all the configuration tabs, and you are able
to make a wide variety of configuration changes. If you do not have the Configure WS privilege,
three tabs appear: View tab, Display tab, and Scan tab. This topic discusses these three tabs. For
information on the other tabs available to users with the Configure WS privilege, refer to the
Configuring AppXtender Workstations chapter of the ApplicationXtender Administration Guide.

To access ApplicationXtender Image Capture configuration:

1. From the File menu, select Configuration. The Configuration dialog box appears.

2. Set the desired options according to the instructions in the following topics:

* View Tab, page 63

e Display Tab, page 66

® Scan Tab, page 68

* Print Tab, page 72

¢ File Types Tab, page 75
* Data Tab, page 77

* Paths Tab, page 80

3. Click OK. The Configuration dialog box closes and any changes you have made are saved.
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For more information, see:

® Chapter 2, Configuring AppXtender Image Capture

View Tab

The View tab of the ApplicationXtender Image Capture (AppXtender Image Capture) Configuration
dialog box allows you to configure several aspects of viewing batches.

For more information, see:

e Chapter 2, Configuring AppXtender Image Capture

¢ Opening the AppXtender Image Capture Configuration Dialog Box, page 62
* Image Size Options, page 63

® Zoom Settings are Pixels, page 64

e Using Scale-to-Gray, page 118

e Display Foreign Files, page 65

* Use Acrobat Reader to Display PDF Files, page 65

* Restore Last Layout at Startup, page 66

Image Size Options

Image size options control the default display size of images displayed in AppXtender Image
Capture. Use this option with the following page types:

¢ Images

* Text (as defined in the File Types tab of the Configuration dialog box)

Note: For more information on the File Types tab of the Configuration dialog box, consult your system
administrator or refer to the Configuring AppXtender Workstations chapter of the ApplicationXtender
Administration Guide.

To change the default image size setting:

1. In the Configuration dialog box, select the View tab.

2. Under Image Size, select one of the five zoom settings. These settings are explained in the
following table:
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Table 11. Image Size Options

Option

Description

Fit to Window

If this option is chosen as the default,
AppXtender Image Capture displays images
to fit the display window either top to bottom
or left to right, while maintaining the original
aspect ratio of the image and displaying the
entire image.

Fit to Window Height

If this option is chosen as the default,
AppXtender Image Capture displays images
to fit the window from top to bottom. You
might need to scroll left or right to see the
sides of the image.

Fit to Window Width

If this option is chosen as the default,
AppXtender Image Capture displays images
to fit the window from left to right. You might
need to scroll up or down to see the top or
bottom of the image.

Actual Size

If this option is chosen as the default,
AppXtender Image Capture displays images
to appear as actual size (one pixel stored is
equal to one pixel on the monitor).

Use Zoom Setting

If this option is chosen as the default,
AppXtender Image Capture displays images
using the default zoom percent. The Zoom
Percent list allows you to set the default ratio.

3. If you have selected the Use Zoom Setting option, select the desired ratio. You have the following

choices:

® C(lick the drop-down list. The Zoom Percent drop-down list appears. Select the desired ratio.

Standard options range from 25% to 400%.

* In the text box, enter the preferred percentage.

4. Click OK.
For more information, see:

¢ View Tab, page 63

Zoom Settings are Pixels

By default, AppXtender Image Capture considers both the image resolution and monitor resolution
when rendering images for display. By enabling the Zoom settings are pixels option, AppXtender
Image Capture displays images in raw pixel size, disregarding image and monitor resolution.
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For more information, see:

* View Tab, page 63

Scale-to-Gray

When this option is enabled, bi-tonal (black and white) images are displayed as grayscale, which is
frequently a more legible format. Various shades are used to convert black and white images for the
highest readability. This option applies to bi-tonal images only.

For more information, see:

¢ View Tab, page 63

Display Foreign Files

When this option is enabled, AppXtender Image Capture uses the Foreign File Viewer component to
display the contents of foreign files supported by the Foreign File Viewer. For a list of supported
file types in the Foreign File Viewer, see . When this option is disabled, AppXtender Image Capture
displays a foreign file page as an icon.

For more information, see:
* View Tab, page 63

Note: If the Foreign File Viewer setting is enabled and Microsoft Office is installed on the computer,
AppXtender Image Capture automatically displays supported Microsoft Office 2003 and 2007
documents in a native Office embedded window inside the Batch Display view. Refer to Embedded
Office Viewer File Support, page 97 for more information.

Use Acrobat Reader to Display PDF Files

When this option is enabled, AppXtender or AppXtender Image Capture uses the Acrobat Reader
technology to display the contents of PDF files. When this option is disabled, AppXtender or
AppXtender Image Capture uses PDF Library to display each PDF page. If you enable the option for
AppXtender or AppXtender Image Capture, it is enabled for both.

Note: The PDF Library performs document printing of a PDF page regardless of the view setting.
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For more information, see:

* View Tab, page 63

Restore Last Layout at Startup

If this option is enabled on the View tab of the Configuration dialog box, the AppXtender Image
Capture desktop layout is automatically saved when you exit AppXtender Image Capture. This
includes the following settings:

¢ AppXtender Image Capture window size and location

¢ Toolbar locations and toolbar button size

* View type (docked view, dialog box, or subwindow) for the Applications view
* Location and size of the Applications view

If this option is disabled, the AppXtender Image Capture desktop layout is not saved on exit. When
you open AppXtender Image Capture, the AppXtender Image Capture desktop layout reverts to the
settings of the last time it was saved.

For more information, see:

* View Tab, page 63

Display Tab

The Display tab of the AppXtender Image Capture Configuration dialog box allows you to configure
various ApplicationXtender Image Capture display features.
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Configuration x|

View  Display I Scan I

—Screen D
Wertical: 36

Harizontal: IHE
Reset |

— Palp/Pglin in Dual-Page Wiew——

= Mest/previous 2 pages

" Mest/previous page

Cancel Help

For more information, see:

e Chapter 2, Configuring AppXtender Image Capture

* Opening the AppXtender Image Capture Configuration Dialog Box, page 62
e Screen DPI, page 67

e PgUp/PgDn in Dual-Page View, page 67

Screen DPI

The Screen DPI settings refer to the dots per inch of the system monitor. AppXtender Image Capture
takes this information from the video interface card installed with the system. You can overwrite the
defaults by entering new Horizontal or Vertical settings. If you want to change the Horizontal or
Vertical settings back to the defaults from the video interface card, click Reset.

For more information, see:

e Display Tab, page 66

PgUp/PgDn in Dual-Page View

This option dictates how the [PAGE UP] and [PAGE DOWN] keys operate when a batch is in
dual-page display mode. This mode is also known as Split View. The Split View feature splits the
Batch Display view so that multiple pages of the same batch are displayed.
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In Split View, the actions performed by the [PAGE UP] and [PAGE DOWN] keys depend on the

PgUp/PgDn setting in the Display tab:

For information on the Next Page and Previous Page commands, see Selecting Pages to View within a
Batch, page 108. For information on using dual-page mode, see Split View, page 110.

When you select Next/previous 2 pages, the keys page through two batch pages at a time. For
example, if you display a batch with four pages in split view, pages 1 and 2 appear first, then

pages 3 and 4.

When you select Next/previous page, the keys page through one batch page at a time. For example,
if you display a batch with four pages in split view, pages 1 and 2 appear first, then pages 2 and 3.

For more information, see:

Display Tab, page 66

Scan Tab

The Scan tab of the AppXtender Image Capture Configuration dialog box allows you to customize

the scanning process.

Configuration

Wi IDispIa_l,l Scan |

[ Allow Image Proceszsing

™ Remaove blank pages [Black & white image: only}

Threshold:
[ mizier [ armal [Eleater

[T Create new batehes when blank pages are detected

[ Synchronized scan

Scanner manual feed timeout; |2E| geconds

k. I Cancel Help

For more information, see:
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¢ Creating New Batches Using Blank Page Separators, page 70
¢ Synchronized Scan, page 71

¢ Scanner Manual Feed Timeout, page 72

Enabling Image Processing Options

Image processing is a licensed feature that allows you to enhance scanned images.

To configure AppXtender Image Capture for image processing:
1. On the Scan tab of the Configuration dialog box, enable Allow Image Processing.
2. Click OK.

Note: To access image enhancement options, log out of ApplicationXtender and then log back in to
ApplicationXtender after you enable Allow Image Processing for the first time.

Refer to Chapter 6, Image Enhancement for more information.

Removing Blank Pages

You can configure AppXtender Image Capture to remove blank pages automatically (in black and
white images only) while you are scanning.
To configure the automatic removal of blank pages:

1. On the Scan tab of the Configuration dialog box, enable the Remove blank pages option. The
Threshold slider and the Create new batches when blank pages are detected option become
available.
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Configuration

Wigw IDiSD|a_'.-' Scan I

[ Allow Image Processing

¥ Remove blank pages [Black % white image only

Threshold:
M aizier MHarmal Cleaner
[ Create new batches when blank pages are detected
™ Synchronized scan
Scanner manual feed timeout; |2|:| zeconds
2k, I Cancel Help |

2. Use the Threshold slider to adjust the setting for what the scanner recognizes as a blank page.

¢ If you want to allow a noisier image to be recognized as a blank page (and therefore removed),

adjust the slider towards Noisier.

¢ If you want to allow a cleaner image to be recognized as a blank page (and therefore removed),

adjust the slider towards Cleaner.

! \ Caution: Examine the pages that are scanned and take note of which pages are automatically
removed from the batch as you scan them. If you find that pages are being removed that
should not be removed, adjust the slider towards Cleaner. Make sure the Threshold setting is

appropriate for the pages you are scanning.

1. Enable the Create new batches when blank pages are detected option if you want to use blank
page separators in the batch. For more information, see Creating New Batches Using Blank

Page Separators, page 70.
2. Click OK.

For more information, see:

* Scan Tab, page 68

Creating New Batches Using Blank Page Separators

You can configure AppXtender Image Capture to start a new batch each time it detects a blank
page within a batch. For example, if you have a batch of 50 pages to be scanned and you want

it to be indexed as two separate batches, you can put a blank page in the middle and AppXtender
Image Capture automatically starts a new batch at that page. This makes it easier for the person
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doing the indexing in AppXtender because they do not have to go through and break the separate
batches out manually.

To configure automatic creation of batches using blank page separators:

1. Enable the Remove blank pages option. The Create new batches when blank pages are detected
option is not available unless the Remove blank pages option is enabled. For more information,
see Removing Blank Pages, page 69.

2. Enable the Create new batches when blank pages are detected option.
3. Adjust the Threshold slider to determine what the scanner recognizes as a blank page.

Note: The Threshold slider settings are the same for this option as they are for the Remove blank
pages option. For more information, see Removing Blank Pages, page 69.
4. Click OK.

Each new batch keeps the original name assigned to the batch and adds a hyphen (-) and sequential
number to the additional batches created. For example, if the original batch is name Personnel, each
new batch that is created is renamed Personnel-1, Personnel-2, and so on.

Note: The batch name is limited to 32 characters in length. Therefore, if a batch name starts out at 32
characters then the system crops the name and replace the letters with a tilde (~) symbol to add the
hyphen and number to the end of the new batch.

You also have the option of adding new pages to an existing batch.

A Caution: If you add pages to an existing batch and there is blank page separator, then
AppXtender Image Capture uses the same naming convention as described in the preceding
procedure. AppXtender Image Capture automatically assigns the next sequential number to
the new batch. If there is a batch with that name, you are prompted to rename that file with a
different name or the same batch name and the next number not being used.

For more information, see:

* Scan Tab, page 68

Synchronized Scan

With some types of scanning, the images are scanned faster than AppXtender Image Capture can
display them. The Synchronized scan option slows down the scanner so that AppXtender Image
Capture can display each scanned image. You have the following choices:

e If you want to review each page as it is scanned, enable the Synchronized scan option.

e If you want to allow the scanner to scan images at its highest speed, disable the Synchronized
scan option.
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For more information, see:

* Scan Tab, page 68

Scanner Manual Feed Timeout

This option sets the scanner timeout for scanning that is performed while in the manual feed mode.
The default is 20 seconds. The timeout option determines how much time that you have to put
more pages in the scanner without having to continue the scan process manually. This option can
be set higher or lower to meet your preference.

For more information, see:

* Scan Tab, page 68

Print Tab

The Print tab of the AppXtender Image Capture Configuration dialog box allows you to configure
how pages are printed. You can configure the following options:

* Print Original Size, page 72

¢ Fit to Page, page 73

¢ Dithering, page 73

* Acceleration, page 73

¢ Endorse Printed Pages, page 74

For more information, see:

¢ Chapter 2, Configuring AppXtender Image Capture
* Opening the AppXtender Image Capture Configuration Dialog Box, page 62

Print Original Size

When a page is printed, the printer automatically fits the contents of the page to a standard printable
area. If some characters in the page are outside the printable area of the page, the printer slightly
reduces the overall size of the page so that all characters can fit. However, there are occasions when
a perfect one-to-one (original to printed) match is required. ApplicationXtender Image Capture
(AppXtender Image Capture) meets this requirement through the Print Original Size feature on the
Print tab of the Configuration dialog box. This function allows AppXtender Image Capture to override
the printer's fixed printable area. All characters in a page are scaled to print exact original size.

When the Print Original Size option is enabled, AppXtender Image Capture overrides the printer's
printable area and prints the selected page in exact original size. When disabled, the printer shrinks
or enlarges the selected page to fit the printable area.
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This option applies to the following page types:

¢ Images
* Text, as defined on the File Types tab

For more information, see:

* Image Files, page 24
* Print Tab, page 72
* File Types Tab, page 75

Fit to Page

Enabling this option allows AppXtender Image Capture to fit an image to the entire printable area of
a single page. The print endorsement settings determine whether the Fit to page option is available.
For more information, refer to Endorse Printed Pages, page 74

Dithering

Dithering is a technique used in computer graphics to create the illusion of varying shades of gray on
a monochrome display or printer. Dithering relies on treating areas of an image as groups of dots that
are colored in different patterns. Dithering takes advantage of the eye's tendency to blur spots of
different colors by averaging their effects and merging them into a single perceived shade or color.
Depending on the ratio of black dots to white dots within a given area, the overall effect is of a
particular shade of gray. Dithering is used to add realism to computer graphics and to soften jagged
edges in curves and diagonal lines at low resolutions.

If you are printing a color image to a monochrome (black and white) printer, you can improve
the quality of the printout by enabling the Dithering option on the Print tab of the Configuration
dialog box. When this option is enabled and you send a color image to a monochrome printer,
ApplicationXtender Image Capture (AppXtender Image Capture) dithers the image. For example,
if you print a color, 400 K, 200 DPI image to a monochrome printer, the result is a black and white,
3600 K, 600 DPI image of the same size. Each pixel in the color image becomes nine pixels in the
black and white image.

Note: When the Dithering option is enabled and you send an image to a color printer, AppXtender
Image Capture does not dither the image.

For more information, see:

¢ Print Tab, page 72

Acceleration

The Acceleration options on the Print tab of the Configuration dialog box expedite the printing
of ApplicationXtender Image Capture (AppXtender Image Capture) batches. AppXtender Image
Capture supports XipPrint accelerator cards, Talaris printers, and Quick PCL printing.
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Note: Pages with print endorsements are not printed in accelerated mode. Whenever a page of this
type is printed, the acceleration mode automatically toggles off while that page prints.

For more information, see:

* Print Tab, page 72

* XipPrint, page 74

¢ Talaris, page 74

* Quick PCL, page 74

XipPrint

If you have a XipPrint II card, you can use the XipPrint printer acceleration feature. The XipPrint II is
a card that can be installed in the SIMM socket of a printer. It takes over file decompression, allowing
AppXtender Image Capture to process print jobs more quickly.

Talaris

If you have a Talaris 1794FT or 3290FT printer, you can use the Talaris printer acceleration feature.
The Talaris 1794FT and 3290FT printers take over file decompression, allowing AppXtender Image
Capture to process print jobs more quickly.

Quick PCL

If you have a PCL5 compatible printer, such as HP III, HP IV or Compagq, you can use the Quick PCL
printer acceleration feature. This feature significantly improves printing performance for black

and white images to any PCL5 compatible printers. Quick Print bypasses the Windows GDI layer
so that AppXtender Image Capture talks directly to the Windows printer driver. This substantially
reduces cycle time.

Note: Quick Print is valid for bi-tonal images only. Grayscale and color images are processed
at the standard rate.

Endorse Printed Pages

You can use the Endorse Printed Pages option on the Print tab of the Configuration dialog box to
print pages with an identifying text message in one corner of each page. Endorsements print on all
pages as long as the option is enabled.

Note: Endorsements are valid for all file types except HTML.

To configure print endorsement:

1. Click the Endorse Printed Pages check box. (To disable the endorsement, clear the check box.)
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2. From the Position drop-down list, select an option. Available options include Lower right, Lower
left, Upper right and Upper left.

3. Type the endorsement message in the Text text box. Endorsement text strings can be up to 10
lines, and each line can have up to 80 characters, including spaces.

The endorsement feature supports predefined macros. The following table describes the macros.

Table 12. Endorsement Macros

Macro Output

%DS Displays the short form of the date, such as
3/2/2007, on which the page is printed.

%DL Displays the long form of the date, such as
Friday, March 02, 2007, on which the page is
printed.

%T Displays the time at which the page is printed.

%U Displays the user who printed the page.

%P Displays the current page number.

4. Enable or disable the Overlap on image option. (This option is not available when using XipPrint
or Talaris acceleration.)

¢ If this option is enabled, the endorsement overlaps any images. This option allows the image
to be printed on a larger area of the page. Select either Print original size or Fit to page.

¢ If this option is disabled, the images and the endorsement take up separate areas of the
printed page. Also, if this option is disabled, the Print original size and Fit to page options
become unavailable.

Consider disabling this option if the endorsement overlaps with an important part of the image,
or if the endorsement is difficult to read with the image printed behind it.

ApplicationXtender prints the endorsement on every page in the location selected from the Position
drop-down list. The location of the macro output in the endorsement depends on the location of
the macro in the text string.

For more information, see:

¢ Print Tab, page 72

File Types Tab

The File Types tab of the Configuration dialog box provides options for importing files into
ApplicationXtender Image Capture (AppXtender Image Capture), including options for file types
or extensions. By default, files not natively supported by AppXtender Image Capture (for example,
files other than TIFF, Windows bitmaps, TGA, RTF, JPEG, GIF, PCX, and DCX) are imported as
foreign files. Pages imported as foreign files are represented in AppXtender Image Capture in one
of the following ways:

* Represented by an icon and require a third-party viewer to display the contents of the page. For
example, if a Microsoft Word document is imported (using the Import File function) as a new
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page, a Word icon displays as the AppXtender Image Capture page. You then double-click the
icon to start Word and view the document.

* Displayed in the Foreign File Viewer (For more information, see Display Foreign Files, page 65.)

* Displayed in the embedded Office Viewer, if applicable. (For information, see Embedded Office
Viewer File Support, page 97.)

Note: AppXtender Image Capture does not support progressive JPEGs. Importing a progressive
JPEG into AppXtender Image Capture results in the file being imported as a foreign file. By default,
text pages are imported into AppXtender Image Capture as foreign files. If you want to import all
files with a TXT extension as plain text, add this file type in the File Types tab.

You can add and delete file types from the File Types tab. For more information, see:

e Chapter 2, Configuring AppXtender Image Capture

* Opening the AppXtender Image Capture Configuration Dialog Box, page 62
¢ Adding File Types, page 76

¢ Deleting File Types, page 76

* Viewing Foreign Files, page 125

Adding File Types

You can add a file type on the File Types tab of the Configuration dialog box.

To add a file type:

1. In the File Extension text box, type the extension that you want ApplicationXtender Image
Capture (AppXtender Image Capture) to recognize.

2. Select a file type from the File Type drop-down list. The File Type options available are Image
Format, Text, Rich Text Format, Embedded Object, Foreign File, Web Component, and Adobe
PDF.

3. Click Add. The extension and file type are added to the Formats list.
4. Click OK.

For more information, see:

* TFile Types Tab, page 75

Deleting File Types

You can delete a file type from the File Types tab of the Configuration dialog box.

To delete a file type:

1. In the Formats list, select the file type you want to delete.

2. Click Delete, and the file type is removed from the Formats list.
3. Click OK.
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For more information, see:

¢ File Types Tab, page 75

Data Tab

The Data tab of the Configuration dialog box allows you to set default image formats and other
data-related settings.
For more information, see:

e Chapter 2, Configuring AppXtender Image Capture

¢ Opening the AppXtender Image Capture Configuration Dialog Box, page 62
* Database Connect & Drop, page 77

¢ Allow Remember Password, page 77

¢ Image Storage Format, page 78

Database Connect & Drop

This option on the Data tab of the Configuration dialog box controls the duration of the database
connection held by ApplicationXtender Image Capture (AppXtender Image Capture). By default, the
Database connect & drop option is disabled.

 If this option is disabled, the AppXtender Image Capture data layer holds the connection to the
underlying database for the entire AppXtender Image Capture session.

e If this option is enabled, the AppXtender Image Capture data layer connects to the database when
needed and then drops the connection when it is not needed.

Because the user is connecting to the database and then dropping the connection when it is not
needed, if the database goes down and back up or if the database fails over in a clustered server
environment, AppXtender Image Capture connects to the restarted database or the new database.
However, because users are connecting and dropping, there is performance degradation when
this option is enabled (because database connect and drop depends on the data source's ability to
perform connection pooling).

If you are planning to run AppXtender Image Capture in a clustered environment, enable the
Database connect & drop option.

For more information, see:
e Data Tab, page 77

Allow Remember Password

This option on the Data tab of the ApplicationXtender Image Capture (AppXtender Image Capture)
Configuration dialog box controls the display of the Remember password option on the Login dialog
box for AppXtender Image Capture. By default, the Allow remember password option is enabled.
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If this option is enabled, the next time you start AppXtender Image Capture, the Login dialog box
appears with the Remember password option.

If this option is disabled, the next time you start AppXtender Image Capture, the Login dialog box
appears without the Remember password option.

For more information, see:

* Data Tab, page 77

Image Storage Format

You can configure the default storage format for ApplicationXtender Image Capture (AppXtender
Image Capture) image files on the Data tab of the Configuration dialog box. These settings determine
the storage format for batches and pages created from scanning.

These settings also determine to what storage format imported batches and pages are converted. This
applies to all page imports, such as creating a batch or page using the Import File command.

For more information, see:

* Data Tab, page 77

¢ Black & White, page 78

* 4/8-bit Color, page 79

* True Color, page 79

* JPEG Quality Factor (1-100), page 79
® Separate Multi-Page TIFFs, page 80

Black & White

This option determines the file format that AppXtender Image Capture uses to store bi-tonal images.
Select an appropriate file format from the Black & white drop-down list. Your choices are Default
TIFF and Windows BMP.

e If you select Default on the Configuration dialog box, imported bi-tonal images are stored in their
native format (for example, a GIF file would be stored as GIF) and scanned bi-tonal images are
stored as TIFF.

* If you select one of the specific image formats on the Configuration dialog box, all bi-tonal images
are stored in that format, regardless of their original format.
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4/8-bit Color

This option determines the file format that AppXtender Image Capture uses for 4/8-bit color images.
Select an appropriate file format from the 4/8-Bit Color drop-down list. Your choices are Default,
TIFF, and Windows BMP:

e If you select Default, imported 4/8-bit color images are stored in their native format (for example,
a GIF file is stored as GIF) and scanned 4/8-bit color images are stored as TIFF.

* If you select one of the specific image formats, all 4/8-bit color images are stored in that format,
regardless of their original format.

True Color

This option determines the file format that AppXtender Image Capture uses to store true color
images. Select an appropriate file format from the True Color drop-down list. Your choices are
Default, TIFF, Windows BMP, and JPEG.

¢ If you select Default, imported true color images are stored in their native format (for example, a
GIF file is stored as GIF) and scanned true color images are stored as TIFF.

* If you select one of the specific image formats, all true color images are stored in that format,
regardless of their original format.

Note: You can compress true color images using Joint Photographic Experts Group (JPEG) image
compression. If you select JPEG, JPEG compression is enabled. You can set the JPEG Quality Factor
(1-100) slider to control the level of compression and the quality of the compressed images. For more
information on compressing images using this slider, see JPEG Quality Factor (1-100), page 79.

JPEG Quality Factor (1-100)

JPEG provides compression of true color images, such as photographs, artwork, and similar still
images. There is always some loss of information when you use JPEG compression to compress an
image. For example, when compressing a scanned photograph, the output image is not exactly
identical to the input image.

JPEG compression allows you to trade off between file size and output image quality. In most
cases, you want to obtain a minimum file size by choosing the maximum amount of compression
without affecting the output image quality. However, if image quality is not important, you can
use a higher compression level to make an extremely small file. Conversely, if the image quality is
important, you can use a lesser compression level to increase the quality until there is no visible
change to the output image.

The JPEG quality factor (1-100) setting allows you to choose the compression setting for true color
images. AppXtender Image Capture uses the JPEG quality factor scale, which ranges from 1 to 100,
where 1 indicates the smallest file size with the lowest quality and 100 indicates the largest file size
with the best quality.

To set the level of JPEG compression for stored images:

1. In the AppXtender Image Capture Configuration dialog box, click the Data tab.
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2. From the True Color drop-down list, select JPEG.

3. Use the slide ruler on the scale to adjust (reduce or increase) the level of compression and the
quality factor that AppXtender Image Capture applies to True Color images when they are stored.

4. Click OK.

Separate Multi-Page TIFFs

This option controls how AppXtender Image Capture imports a multi-page TIFF or multi-page
DCX file.

* If this option is enabled, AppXtender Image Capture imports a multi-page TIFF or multi-page
DCX file by separating each page of the imported file into a page within the new AppXtender
Image Capture batch. Each page is stored as a separate BIN file.

¢ If you enable this option, file storage format for multi-page image files depends on the image
storage format settings. (For information, see Black & White, page 78, 4/8-bit Color, page 79, and
True Color, page 79.) If this option is enabled, AppXtender Image Capture applies the selected
image storage format (for example, BMP) to each stored page separated from the multi-page file.
If this option is enabled and the image storage format is set to Default, all multi-page image files
are saved in the file's native format.

e If this option is disabled, AppXtender Image Capture imports a multi-page TIFF or multi-page
DCX file in its native format. All the pages in the multi-page file are stored together as one BIN
file. Disabling this option greatly increases the speed at which system conversion is completed.

Paths Tab

The Paths tab of the Configuration dialog box allows you to configure local and personal write paths
for the ApplicationXtender (AppXtender) workstation. These are separate from the write paths
established in ApplicationXtender Administrator for the application. You can also enter volume
label search drives for the AppXtender workstation. This setting tells AppXtender Image Capture
to look at the specified drives for the images.

Path settings are saved in the Windows registry for each AppXtender workstation. The settings apply
only to the workstation where the configuration takes place.

For more information, see:

e Chapter 2, Configuring AppXtender Image Capture

* Opening the AppXtender Image Capture Configuration Dialog Box, page 62
* Local Write Path, page 81

* Personal Search Path, page 81

* Volume Label Search Drives, page 81
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Local Write Path

Using this option on the Paths tab of the Configuration dialog box, you can activate a temporary
storage area for scanning in ApplicationXtender Image Capture (AppXtender Image Capture), such
as a local hard drive. You can even configure a different local write path for each data source. The
Local Write Path option enables you to use the local write path when needed and the document
write path at other times. When this option is enabled, batches are stored in the path entered in
the Local Write Path text box.

A Caution: Do not enable a local write path on the ApplicationXtender (AppXtender) workstation
where the Index Server is installed. If a local write path has been configured and enabled
when you attempt to start the Index Server, an error message appears and the Index Server
automatically shuts down.

Note: The Local Write Path option should be enabled when scanning locally. The option remains
enabled until you clear the check box in the Paths tab of the Configuration dialog box.

Note: You cannot use volume labels for the local write path.

For more information, see:
* Paths Tab, page 80

Personal Search Path

Using this option on the Paths tab of the Configuration dialog box, you can configure additional paths
to search for ApplicationXtender Image Capture (AppXtender Image Capture) batches. If batches
for an application are stored in a location that is not referenced in any of the other path settings, a
personal search path should be set to allow for retrieval of those batches.

When retrieving batches, AppXtender Image Capture searches first in the personal search path,
then the application's write path, and then the paths listed in the Personal Search Path text box.
AppXtender Image Capture then searches all the remaining configured write paths.

For more information, see:
e Paths Tab, page 80

Volume Label Search Drives

Using this option on the Paths tab of the Configuration dialog box, you can specify the drives
that AppXtender Image Capture searches to find batches that were stored on removable media
using volume labels.

If removable media with volume labels are used as document write paths to store batches, this option
is used to configure retrieval of those batches. The drive letter (or drive letters) where the media will
be mounted must be specified as Volume Label Search Drives. AppXtender Image Capture checks
each of the drives specified to determine if the media labeled with the volume label is mounted in one
of those drives. If not, AppXtender Image Capture prompts the user to insert the appropriate media.
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To specify a drive:

1. You have the following choices:

¢ In the Volume Label Search Drive(s) text box, enter the drive letter. (To specify multiple
drives, enter each drive letter separated by a semicolon.)

® C(Click Select. Select a drive. (To specify multiple drives, hold down the [CTRL] key or [SHIFT]
key while selecting the drives.) Click OK.

2. Click OK.
For more information, see:
* Paths Tab, page 80
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Creating Batches

This section provides an overview and procedures for creating batches in ApplicationXtender
Image Capture.

Introduction to Batches, page 83
Creating New Batches, page 84
Displaying a Batch, page 95
Adding Pages to Batches, page 98

Introduction to Batches

ApplicationXtender (AppXtender) provides two options for scanning paper documents into the
AppXtender system:

ApplicationXtender itself is an integrated scan-and-index online module, which allows you to scan
and index documents in an interactive mode. Documents are scanned and indexed at the same
time. For more information on scanning in ApplicationXtender, refer to the ApplicationXtender
Document Manager User’s Guide.

ApplicationXtender Image Capture (AppXtender Image Capture), a separate module, provides
batch-scanning functionality, allowing you to scan batches and then index them in AppXtender
later. For information on this module, continue reading this section.

Various input methods are available for you to create batches. AppXtender Image Capture batches
are organized in applications for easy retrieval. AppXtender Image Capture allows you to add
pages to batches after they have been created.

The following procedure provides an overview of the batch creation methods discussed in this topic:

To create a batch:

1.

Bring into AppXtender Image Capture the information that you want to store. You have several
methods of input from which to choose. For more information, see Creating New Batches, page
84.

If you created the batch by scanning, the new batch appears in the Batch Display view. For
instructions on displaying a closed batch, see Displaying a Batch, page 95.

If necessary, add pages to the new batch. For more information, see Adding Pages to Batches,
page 98.
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Creating New Batches

There are several methods for creating batches in ApplicationXtender Image Capture (AppXtender
Image Capture). For more information, see the following topics:

* Chapter 3, Creating Batches

¢ Deciding Which Batch Creation Method to Use, page 84
* Creating a Batch By Scanning, page 84

* Creating a Batch by File Selection, page 86

¢ Creating Batches From a Batch Import File, page 88

Deciding Which Batch Creation Method to Use

AppXtender Image Capture allows you to create batches in many ways. The following table is
intended to help you decide the best way to bring a batch into AppXtender Image Capture:

Table 13. Deciding What Input Method to Use for Creating Batches

If You Want to Create Use this Method For More Information, See

A batch from paper documents | Scanning Creating a Batch By Scanning,
not yet in electronic format page 84

A batch from electronic File selection Creating a Batch by File
documents in one location Selection, page 86

Multiple batches from Batch import file Creating Batches From a Batch
electronic documents in Import File, page 88

various locations, including

optical disks (or if you want to

be able to accurately repeat the

same import later)

If you create a batch by file selection or from a batch import file, your ability to view the resulting
pages of those batches depends on the type of files you have imported. For information, see Support
for Viewing of Imported Files in AppXtender Image Capture, page 96.

For more information, see:

* Creating New Batches, page 84

Creating a Batch By Scanning

This topic describes how to scan a batch into AppXtender Image Capture.

Note: Before you can create a batch by scanning, install the correct scanner driver and select
the scanner from within AppXtender Image Capture. For more information on installing the
scanner driver, consult your AppXtender system administrator or refer to the "Planning Your
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ApplicationXtender Installation" chapter of the ApplicationXtender Installation Guide. For more
information on selecting the scanner, see Selecting a Scanner, page 46.

To scan a batch into AppXtender Image Capture:

1.

Select the appropriate settings on the Scan toolbar, the Scan menu, or the Scan tab of the
Configuration dialog box.

You can customize several scanner properties to produce the desired scanning results. DPI
settings, scanner feeder settings, automatic rotation, automatic image enhancement, brightness,
dither, and other settings can be configured. Advanced settings available for each scanner are
driver-specific and change from scanner to scanner. The Scanner Settings dialog box allows you
to set additional parameters. For instructions, see Optional Scanning Configurations, page 47.

The following configurable options may also affect the scanning process:
* The Remove Blank Pages option discards pages from the scanning process that do not meet
the threshold you choose on the sliding Threshold bar.

® The Create New Batches When Blank Pages Are Detected option starts a new batch every time
a blank page is detected, and deletes that page.

® The Synchronized Scan option allows you to slow down manual and automatic feed and
view each page as it is scanned.

These options can be set on the Scan tab in the Configuration dialog box. For more information,
see Scan Tab, page 68.

Close any currently displayed batches.

Prepare the paper documents for scanning. Document preparation requirements depend on the
standards set for your company. Consult your AppXtender system administrator for guidelines.
Some document preparation suggestions include:

* Remove sticky notes, paper clips, and staples (if appropriate).
* Ensure the documents are stacked with the correct orientation.

¢ If you are using an automatic document feeder, ensure the pages to be scanned are in good
enough condition to run through the feeder.

Feed the paper that you want to scan into the scanner.

In the Applications view, right-click the name of the application into which you want to scan a
batch. A shortcut menu appears.

From the shortcut menu, select New Batch. The ApplicationXtender Image Capture dialog
box appears.

ApplicationXtender Image Capk El

Batch Mame:

[
(] 4 I Cancel Help
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In the Batch Name text box, enter a name for the batch.

Note: You can enter the name of an existing batch to add pages to that batch. However, you
cannot add pages to a batch that is being indexed in AppXtender. If you attempt to scan new
pages into a batch that is being indexed, the batch creation fails.

Click OK. (If the Batch Name text box contains the name of an existing batch, AppXtender Image
Capture opens that batch and appends the scanned images to that batch.) AppXtender Image
Capture scans the batch and displays it in the Batch Display view.

Note: While pages are being scanned, a Cancel button appears on the AppXtender Image Capture
status bar. You can click Cancel at any time to stop scanning. Also, 30 seconds after each image
has been fully scanned, it is automatically saved to the batch. This feature allows users on other
workstations to begin indexing images soon after you scan them.

If necessary, you can rescan the page just scanned. Ensure the page is still displayed in the Batch
Display view, and then from the Scan menu, select Rescan. The newly scanned page replaces
the page scanned before it.

Note: The Rescan feature does not replace the most recently scanned page if it is not displayed in
the Batch Display view or if 30 seconds have passed since the image was scanned. To replace
the page, delete it and then scan it again. For more information on deleting a page, see Deleting
Pages, page 138. For more information on scanning a page, see Adding Pages to Batches, page 98.

For more information, see:

Creating New Batches, page 84

Creating a Batch by File Selection

You can create a batch in ApplicationXtender Image Capture (AppXtender Image Capture) by
selecting a group of files.

Note: When importing files into a batch, text files that are flagged as hidden or system are not
imported.

To create a batch by file selection:

1.

2.
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Select Files for Bakch Import ed

Look in: Iﬁ FilesF orl rmpart j = = ER-
[ 00000003 B Irvoices. ki
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3. In the Batch Name text box, enter a batch name. You must enter a batch name to create a batch.

Note: You can enter the name of an existing batch to add pages to that batch. However, you
cannot add pages to a batch that is being indexed in AppXtender. If you attempt to use file
selection to add pages to a batch that is being indexed, the batch creation fails.

4. Navigate to and select the files you want to import. (If you want to add a file of a foreign type,
select All Files [*.*] from the Files of type list.) The selected file names are displayed in the File
name text box.

Note: To select two or more files in sequence, select the first file, then press and hold the [SHIFT]
key while selecting the last file. To select two or more out of sequence, press and hold the [CTRL]
key while selecting each file. Also, in the File name text box, you can enter the file name of each
file you want to import. However, each file name must be enclosed in double quotes.

5. Click Open to import all selected or specified files. A message appears, indicating the progress
of the batch import. This message is displayed until all files of the batch have been imported.
Click Cancel at any time to cancel the batch import. When the import is complete, a Batch Import
Status dialog box appears.

Batch Import Status |

Proceszing Completed At IM-:un kap 06 14:21:26 2002

. _ 5
Filez Processed: I Esit |

Fages Imported: I.'-"

Rejections: |1 View Reject Log |

6. If you want to see a log of the import, click View Log. The batch creation log appears in Notepad.
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] Untitled - Notepad =10l x|

File Edit Format Help
scanxtender w4, a0, 018 ;|

Processing file: C:\TemphBI_Al.tmp

Log file: C:hTemp:BI_Al. LOG

rejection file: Ci\Temp:BI_ALl.REJ
pestination application: RECORDS
Processing intiated at: 2002-06-06 14:21
Processing hatch: PDFs and BMPs
Processing completed at: 2002-06-06 14:21
Total files processed @ 8

Total pages imported @ 7

Total rejections @ 1

[

Note: When importing a batch by file selection, AppXtender Image Capture places the resultant
log and rejection file in the TEMP directory on the local drive (for example, C:\TEMP).

7. If any of the records were rejected and you want to see the reasons for the rejections, click View
Reject Log. The batch rejection log appears in Notepad.

ol

File Edit Format Help

Impart Error on Line 8: Error Ox&0070002, -21470248% The :J
system cannot find the file specified.
File: E:"FilesForImportibike. bmp

[

For information on displaying stored batches after they have been imported, see Displaying a
Batch, page 95.

For more information, see:

¢ Creating New Batches, page 84

Creating Batches From a Batch Import File

You can create batches in ApplicationXtender Image Capture (AppXtender Image Capture) by
creating and importing a batch import file (a list of files to be included in the batches).

Note: When importing files into a batch, text files that are flagged as hidden or system are not
imported.
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To create batches from a batch import file:

1. Create a text file referencing the files to be imported. You can import several batches at a time
by grouping the imported files for a particular batch together in a file. For instructions, see
Creating a Batch Import File, page 89.

2. Import the file you have created. For instructions, see Performing the Batch Import, page 93.
For more information, see:

* Creating New Batches, page 84

Creating a Batch Import File

A batch import file is a text file referencing the location of files for import. This file can be created in
the Windows Notepad or in DOS. You can import multiple batches by including a description for
each batch in the file. Each batch description should have two components: a unique name for the
batch and a reference to each of the files to be imported.

¢ The name can be up to 32 alphanumeric characters long and needs to precede the file references to
be included in that batch. Use a name that is unique for the application into which you intend
to import the batch. If a batch is imported into an application that already has a batch by that
name, then the new batch is appended to the existing batch.

Note: If you are using the Create new batches when blank pages are detected option on the Scan
tab of the Configuration dialog box, then each new batchis renamed with a hyphen and sequential
number added to the end of the original batch name. If the original batch name already takes the
full 32-characters, then the name is cropped to fit the necessary addition and the characters that
were removed are replaced by a single tilde (~) symbol. For more information, see Creating New
Batches Using Blank Page Separators, page 70.

¢ Each reference to a file location should include either one (in the case of single-page image, PDF,
RTE, and HTML files) or two (in the case of all other files) "at" (@) symbols, followed by the path
where the file can be found. When importing multi-page images, use one "at" symbol to import
only the first page of the image, or two "at" symbols to import every page in the image. Volume
labels can be referenced in place of directory paths to import files and images stored on removable
media such as optical disks. Additionally, the asterisk (*) wildcard character can be used to import
multiple files from a single location with one command line.

For details on formatting a batch import file, see the following topics:

* General Batch Import File Format, page 90
* Format for Referencing a Volume Label, page 92
* Format for Importing Multiple Files with a Single Command, page 92

Batch Import uses the image format settings from the Data tab of the Configuration dialog box. For
information on configuring the image format settings, consult your AppXtender system administrator
or refer to the "Configuring AppXtender Workstations" chapter of the ApplicationXtender
Administration Guide.
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For more information, see:

* Creating Batches From a Batch Import File, page 88

General Batch Import File Format

To successfully accomplish the import, the batch import file must be formatted correctly. One or two
"at" (@) symbols should immediately precede a file name and path. The following table lists the

file types that can be preceded by one "at" symbol (@) and the file types that must be preceded by
two "at" symbols (@@):

Table 14. Using @ vs. Using @@

May Use One "at" Symbol (@) Must Use Two "at” Symbols (@@)

¢ Single-page image types ¢ Foreign files, including text files (even if they
have been configured on the File Types tab of

* PDF the Configuration dialog box)

* Basic Windows RTF * Multi-page image files (if you want to import

. HTM every page)

* Multi-page image files (if you want to import

only the first page)

Note: To separate multi-page TIFF and DCX pages, the Separate multi-page TIFFs option in the Data
tab of the Configuration dialog box must be enabled. Each page of the imported file becomes a page
within the new AppXtender Image Capture batch. For information on configuring the separation

of multi-page TIFF and DCX files, consult your AppXtender system administrator or refer to the
"Configuring AppXtender Workstations" chapter of the ApplicationXtender Administration Guide.

Note: To import all pages of a multi-page TIFF or DCX file, you must use two "at" symbols (@@)
before the file location, even if you have enabled the Separate Multi-page TIFFs option. If you use
only one "at" symbol (@) before the file location, the first page of the file becomes a page of the new
AppXtender Image Capture batch, but the remaining pages of the file are discarded.

Note: Multiple pages of GIF animation files cannot be imported into AppXtender Image Capture.
The first page of the file becomes a page of the new AppXtender Image Capture batch, but the
remaining pages of the file are discarded. AppXtender Image Capture does not support progressive
JPEGs. Importing a progressive JPEG into AppXtender Image Capture results in the file being
imported as a foreign file.

When AppXtender Image Capture processes a batch import file with file names preceded by two
"at" symbols (@@), AppXtender Image Capture honors the file type mappings and image storage
format settings for those file names. The following table explains the trade-off between using one "at"
symbol or two:
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Table 15. Trade-Off Between Using @ vs. Using @@

For This Scenario

Do This

Result

All the files listed in the batch
import file are a format that
is natively supported by
AppXtender Image Capture.

Precede each file name and
path with only one "at" symbol

(@).

AppXtender Image Capture
imports the file without
checking the file type. Each file
must be a natively supported
file format.

Some of the files listed in the
batch import file are a format
that is natively supported by
AppXtender Image Capture
and some are not, and you do
not have time to edit the batch
import file.

Precede each file name and
path with two "at" symbols
(@@).

AppXtender Image Capture
checks the file type and treats
the file as the detected type
(such as image, text, or foreign
file format). The number of
files that AppXtender Image
Capture must check increases
the import time.

Some of the files listed in the
batch import file are a format
that is natively supported by
AppXtender Image Capture
and some are not, and you
do have time to edit the batch
import file.

For each supported file, precede
the file name and path with
only one "at" symbol (@).

For each unsupported file,
precede the file name and path
with two "at" symbols (@@).

If one @ precedes the file
name and path, AppXtender
Image Capture imports the file
without checking the file type.

If two @@ signs precede the file
name and path, AppXtender
Image Capture checks the file
type and treats the file as the
detected type.

None of the files listed in the
batch import file are a format
that is natively supported by
AppXtender Image Capture.

Precede each file name and
path with two "at" symbols
(@@).

AppXtender Image Capture
checks the file type and treats
the file as the detected type (in
this case, foreign file format).

If the following example batch import file is imported, two batches are created (Images and Fiscal

Year 1996):

Images

@c:\bitmaps\sailboat.bmp

@c:\tifs\desert.tif
Fiscal Year 1996
@Qc:\1996\report. txt
@@c:\1996\report.doc
@c:\1996\chart.bmp

A batch named Images would contain two image files, SAILBOAT.BMP and DESERT.TIF. A batch
named Fiscal Year 1996 would contain a text file (REPORT.TXT), a Microsoft Word document
(REPORT.DOC), and an image (CHART.BMP).
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Format for Referencing a Volume Label

A volume label can be used as the root of the file path in place of a drive letter, to allow for batch
import from multiple pieces of media. If, for example, the images to be stored in AppXtender are
located on several different optical disks, each of those disks can be referenced in the batch import
file by the volume label on the disk. As references to different volume labels are found during the
import, you are instructed to insert the correct media. Volume labels can be referenced by placing
the name of the volume with a dollar sign in front, such as $ VOLUME NAME, where the drive letter
would normally be.

The following example of a batch description includes the volume label VOLUME_01:
Images

@$VOLUME 0l\images\castle.bmp

@c:\images\sky.bmp

@c:\images\leaves.bmp

During import of this example batch import file, you would be prompted to mount the optical disk
that has the volume label VOLUME_01, unless it was already mounted.

The removable media drive where the volume would be mounted must be added as a Volume
Label Search Drive on the Paths tab of the Configuration dialog box for the AppXtender Image
Capture workstation in order for AppXtender Image Capture to find the mounted volume. For
instructions, refer to the "Configuring AppXtender Workstations" chapter of the ApplicationXtender
Administration Guide.

Format for Importing Multiple Files with a Single Command

The asterisk (*) wildcard character can be used to import several files from a single location. Rather
than entering a line in the batch import file for each file in the directory, files with similar names
can be referenced with one command.

When you use the asterisk to replace some or all the letters, AppXtender Image Capture imports
all the files in the referenced directory whose names contain the remaining pattern of letters. For
example, if the filenames for all the financial reports in the directory C:\FINANCE\ begin with the
word REPORT, placing the line "c: \finance\report*. *" in the batch import file would retrieve
all those files. All files in a particular directory can be imported with one command by entering

"* _*" in place of the filename.

The rules for using one or two "at" symbols (@) still apply when you are using wildcards. If you
create a wildcard statement to import both supported and unsupported files, ensure it is preceded
with two "at" symbols.

The following example batch import file uses the wildcard character:
Images

@SVOLUME 0Ol\images\castle*.bmp

@c:\images\*.bmp

@c:\images\new\*.*
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The first line after the batch name imports all bitmap files with the prefix CASTLE in the IMAGES
directory on the disk labeled VOLUME_01. The second line imports all bitmap files in the
C:\IMAGES directory. The third line imports all files in the C:\IMAGES\NEW directory.

Performing the Batch Import

As soon as a batch import file has been created, you can perform the import. AppXtender Image
Capture reads the text file, creating a batch whenever it encounters a line in the file that does not
begin with an @ symbol, and storing each of the successive files referenced in that batch.

Note: You cannot add pages to a batch that is being indexed in AppXtender . If you attempt to use a
batch import file to add pages to a batch that is being indexed, the batch creation fails.

To create a batch of imported pages:

1. Ensure the appropriate application is active. The active application is in bold in the Applications
view.

2. From the Batch menu, select Import. The Select Batch Import File dialog box appears.

3. Navigate to the location of the batch import file and select the batch import file name. Click Open.
A message appears, indicating the progress of the batch import. This message is displayed until
all files of the batch have been imported. Click Cancel at any time to cancel the batch import.

If any of the files listed in the batch import file are referenced by a volume label, and if you have
not specified a volume label search drive for the AppXtender Image Capture workstation, the
Volume Label Search Drives dialog box appears.

¥Yolume Label Search Drives

Ma Walume label zearch dives have been zpecified.
Pleasze zelect a drive or drivers that you wigh to uze for
the walume label zearch.

(%] Contral Panel -
=5 3% Floppy (4]

=D5SYSTEM [C:)

=APPS (D)

=IDATAIE)

=RESTORE [F:) -
=install on 'otgfs' [1:]

=?images on 'otgls' [J:]

=2 office on 'otgfs' [K:] -
4| | v
Cancel |

4. If the Volume Label Search Drives dialog box appears, select the drive letter of the drive on
which you plan to mount the media to import and click OK. The ApplicationXtender Utility
dialog box appears.
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ApplicationXtender Utility x|

WOLUME_01: Please mount the wolume and select QK ko continue,

Zancel |

5. If the ApplicationXtender Utility dialog box appears, mount the specified volume and then click
OK. When the import is complete, a Batch Import Status dialog box appears.

Batch Import Status

Procezszing Completed At IM-:un kay 06 14:37:05 2002

' ; 7
Filez Processed: I Exit |

FPages Imported: IE

Wiew Heject Log |

Rejections: |'|

x|

6. If you want to see a log of the import, click View Log. The batch import log appears in Notepad.

] untitled - Notepad

File Edit Format Help

=10 %]

Scanxtender w4, 60, 018

Processing file: E:NFilesForImporti\Import.txt
Log Tile: E:“FilesForImpart\Import.LoG
rejection file: E:WFilesForImport™Import.REG
Destination application: RECORDS

Processing initiated at: 2002-06-06 14:35
Processing hatch: Batch2O020605

Processing completed at: 2002-06-06 14:35
Total files processed: 7

Total pages imported @ &

Total rejections @ 1

=4

[

Note: When the batch import file you are importing is on a read-only media or drive, AppXtender
Image Capture places the resultant log and rejection file in the TEMP directory on the local drive

(for example, C:\TEMP).

7. If you want to see a list of rejected records and the reasons for the rejections, click View Reject

Log. The batch import rejection log appears in Notepad.
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=

File Edit Format Help

Import Error on Line 8: Error Ox&0070003, -21470248%3 The ;|
system cannot find the path specified.
File: $woLUME_COL:“FilesFarImporthFox.Txt

For information on displaying stored batches, see Displaying a Batch, page 95.

For more information, see:

® Creating Batches From a Batch Import File, page 88

Displaying a Batch

As soon as a batch has been created, you can display it in Batch Display view.

Note: AppXtender Image Capture 5.10 can be used to view batches created by releases of AppXtender
Image Capture older than 5.10 as long as the batches have been released into AppXtender.

To display a batch:

1. In Applications view, right-click an application. A shortcut menu appears. From the shortcut
menu, select Batch List. The Batch Scan dialog box appears.

Batch Scan

Batches for application: IHEEDHDS
M amne | FPages | Tirme Stamp | Created By | Statuz | Cancel |
Irveoices 10 2002-05-03 16:B6:5F  S¥SOP Idl= Delete |
Leave Request form 1 2002-05-06 13:05:34  SYSOP [ndexing —
B atch20020405 G 2002-05-06 14:35:55  SY'SOP Scanning Merma... |
Help |

2. In the Batches for application drop-down list, select the application that contains the batch you
want to display. A list of batches in the selected application appears in a table. The following
table describes the information that is provided about each batch:
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Table 16. Batch Scan Dialog Box Columns

Column Description

Name The name that was given to the batch upon
creation.

Pages The number of pages that the batch currently
contains.

Time Stamp The date and time at which the batch was
created.

Created By The user name of the user who created the
batch, whether the batch was scanned or
imported.

Status The status of the batch:

* Indexing: The batch is open in AppXtender.

* Scanning: The batch is open in AppXtender
Image Capture.

¢ Idle: The batch is not open in either
AppXtender or AppXtender Image
Capture.

3. Double-click the row for the batch you want to display. The Batch Scan dialog box closes and the

selected batch appears in Batch Display view.

For more information, see:

¢ Chapter 3, Creating Batches

Support for Viewing of Imported Files in AppXtender

Image Capture

Files imported into AppXtender Image Capture are supported for viewing in the following ways:

* Using the native AppXtender Image Capture Viewer (For information, see Native AppXtender

Image Capture File Support, page 97.)

¢ Using the Foreign File Viewer (For information, see .)

¢ Using the embedded Office Viewer (For information, see Embedded Office Viewer File Support,

page 97
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For more information, see:

* Displaying a Batch, page 95

Native AppXtender Image Capture File Support

AppXtender Image Capture supports several file formats natively. File formats that are supported
natively display in the Batch Display view without need for an additional third-party viewer or any
additional AppXtender Image Capture configuration. AppXtender Image Capture-supported file
types include Bitmap files, TGA files, DCX files, GIF files, JPEG files, PCX files, various TIFF files,
Rich Text Format (RTF) files, HTML files, and Adobe Portable Document Format (PDF) files.

All files that are not natively supported in AppXtender are referred to as "foreign files," both in this
guide and in the AppXtender Image Capture interface.

Note: Multi-page TIFF and DCX files can be imported into AppXtender Image Capture. Each
page of the imported file becomes a page within the new AppXtender Image Capture batch. Your
workstation may be configured to store each multi-page TIFF file as one BIN file or many BIN
files. For information, consult your AppXtender system administrator or refer to the "Configuring
AppXtender Workstations" chapter of the ApplicationXtender Administration Guide.

Note: AppXtender Image Capture does not support progressive JPEGs or GIF animation files.
Importing a progressive JPEG or a GIF animation file into AppXtender Image Capture results in the
file being imported as a foreign file.

For more information, see:

* Support for Viewing of Imported Files in AppXtender Image Capture, page 96

Embedded Office Viewer File Support

If the Foreign File Viewer setting is enabled and Microsoft Office is installed on the computer,
AppXtender Image Capture automatically displays supported Microsoft Office 2003 and 2007
documents in a native Office embedded window inside the Batch Display view. This capability,
which is available for Word, Excel, PowerPoint, and Visio Office document formats, uses Microsoft
Object Linking and Embedding (OLE) technology. Documents are displayed in read-only mode.

Viewing Batches from a Volume

If you attempt to open a batch which has been stored to a volume label search drive, the Volume
Label Search Drives dialog box appears.
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¥Yolume Label Search Drives: 5[

Mo Yolume label zzarch drives have been specified.
Fleaze select a drive ar dnvers that pou wish bo use for
the wolume label search.

(%] Cantral Panel =2 office on 'otgfs' [K:]
ﬁ 3% Floppy [&:] =2 manualz on 'otgfs...

=1 5STEM [C:] =2 release on 'ohgrel...
=3 APPS D] @ Compact Dizc [£1]
= DATA [E:]

= RESTORE [F:)

=2 archive on 'tk-cm...
=2 install on 'otgfs' (1]
=2 images on 'otgfs' ...

Cancel |

To display the batch:
1. Select the drive in which the batch is stored.
2. Click OK. The batch is displayed.

For more information, see:

¢ Displaying a Batch, page 95

Adding Pages to Batches

As soon as a batch has been created, additional pages can be attached as you require. Subsequent
pages can be the same object type as the first page or any other object type. Pages can be inserted
before or after the displayed page, or appended to the end of the active batch.

ApplicationXtender Image Capture (AppXtender Image Capture) has safeguards in place to prevent
mismanagement of batch pages. Additional pages cannot be added to the wrong batch, because the
desired batch must be displayed to add pages. The batch’s title bar always shows the active page
and total number of pages.

AppXtender Image Capture allows for various methods of input, such as a scanner, Clipboard,
or import file, so there is no restriction on a batch’s structure or content. The input methods are
discussed further in the following topics:

* Deciding What Page Addition Method to Use, page 99
* Adding a Page by Scanning, page 100

* Adding a Page from the Windows Clipboard, page 101
* Adding a Page by Importing a File, page 103

* Adding a Page by Dragging a File, page 104
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For more information, see:

¢ Chapter 3, Creating Batches

Deciding What Page Addition Method to Use

AppXtender Image Capture allows you to add pages to batches in many ways. The following table is

intended to help you decide the best way to add a page to a batch:

Table 17. Deciding What Input Method to Use

If the Page You Want to Create
is Use this Method

For More Information, See

A paper document that is not | Scanning
yet in electronic format.

Adding a Page by Scanning,
page 100

The current contents of the Pasting from the Clipboard
Clipboard

Adding a Page from the
Windows Clipboard, page 101

An electronic document that is | Importing a file
one of the following:

® In an image format
supported in AppXtender
Image Capture

e A text file (*.TXT)

* A Rich Text Format file
(*RTF)

* A Hypertext Markup
Language file (*.HTM or
*HTML)

e An Adobe Portable
Document Format (PDF)
file (*.PDF)

¢ In a format that is not
natively supported by
AppXtender Image Capture

Adding a Page by Importing
a File, page 103, Or Adding a
Page by Dragging a File, page
104

An electronic document that Dragging a file
is an e-mail attachment in
Microsoft Outlook or Microsoft
Exchange.

Adding a Page by Dragging a
File, page 104

If you add a page to a batch by pasting from the Clipboard, by importing a file, or by dragging a
file, your ability to view the resulting page depends on the type of file you have imported. For
information, see Support for Viewing of Imported Files in AppXtender Image Capture, page 96.
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For more information, see:

¢ Adding Pages to Batches, page 98

Adding a Page by Scanning

Additional pages can be added from any scanner supported for use with ApplicationXtender Image
Capture (AppXtender Image Capture). This topic describes the addition of a single page by scanner.
Scanned pages can be inserted before or after a displayed page, or appended to the end of a batch.
For more information, see the following topics:

¢ Adding Pages to Batches, page 98
* Inserting a Scanned Page before the Current Page, page 100
* Inserting a Scanned Page after the Current Page, page 100

* Appending a Scanned Page to a Batch, page 101

Inserting a Scanned Page before the Current Page

You can scan a new page into a batch and add it as the previous page in the batch (before the
currently displayed page).

To add a page before the current page by scanning:

1. Ensure the appropriate batch is currently displayed. For instructions, see Displaying a Batch,
page 95.

2. From the Page menu, select New and then Scan. A shortcut menu appears. From the shortcut
menu, select Insert Before. AppXtender Image Capture automatically scans the page and it
appears as a new page in the Batch Display view.

For more information, see:

¢ Adding a Page by Scanning, page 100

Inserting a Scanned Page after the Current Page

You can scan a new page into a batch and add it as the next page in the batch (after the currently
displayed page).
To add a page after the current page by scanning:

1. Ensure the appropriate batch is currently displayed. For instructions, see Displaying a Batch,
page 95.

2. From the Page menu, select New and then Scan. A shortcut menu appears. From the shortcut
menu, select Insert After. AppXtender Image Capture automatically scans the page and it
appears as a new page in the Batch Display view.
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For more information, see:

* Adding a Page by Scanning, page 100

Appending a Scanned Page to a Batch

You can scan a new page into a batch and add it as the last page in the currently displayed batch.

If you would like to scan in several pages at once and append all the pages to an existing batch,
follow the procedure for creating a batch by scanning and enter the name of the existing batch when
prompted for a batch name. For instructions, see Creating a Batch By Scanning, page 84.

To add a page to the end of the current batch by scanning:

1. Ensure the appropriate batch is currently displayed. For instructions, see Displaying a Batch,
page 95.

2. From the Scan menu, select Scan Page. AppXtender Image Capture automatically scans the page
and it appears as a new page in the Batch Display view.
For more information, see:

* Adding a Page by Scanning, page 100

Adding a Page from the Windows Clipboard

ApplicationXtender Image Capture (AppXtender Image Capture) allows for the sharing of data
between programs using the Windows Clipboard. The contents of the Clipboard can be pasted into
AppXtender Image Capture as a new page. Because the Clipboard holds any type of data, the new
page can be an image; data from another application, such as Microsoft Word or PowerPoint; or even
a page from a different AppXtender application.

Your ability to view the resulting page depends on the type of file you have copied and pasted. If
AppXtender Image Capture supports the file type you copy and paste, the content of the file appears
in the Batch Display view. Unsupported file types, or foreign file types, are represented in the Batch
Display view by an icon (unless the Foreign File Viewer is enabled). AppXtender Image Capture
stores foreign file types in their native file format. For more information, see Support for Viewing of
Imported Files in AppXtender Image Capture, page 96.

Pages can be pasted before or after a displayed page, or appended to the end of a batch. For more
information, see the following topics:

¢ Adding Pages to Batches, page 98

* Pasting a Page before the Current Page, page 102
* Pasting a Page after the Current Page, page 102
* Appending a Pasted Page to a Batch, page 102
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Pasting a Page before the Current Page

You can add the new page as the previous page in the batch (before the currently displayed page).

To paste a page before the current page:

1. Move the desired data to the Windows Clipboard. Typically, this is performed through a
program’s Edit menu, and some programs have shortcuts to accomplish this function.

2. Ensure the appropriate batch is currently displayed. For instructions, see Displaying a Batch,
page 95.

3. From the Page menu, select New and then Clipboard Paste. A shortcut menu appears. From the
shortcut menu, select Insert Before.

Note: If there is not a valid page in the Windows Clipboard, AppXtender Image Capture dims the
Insert Before menu command, meaning it is not available for selection. If this is the case, verify
that the data has been moved to the Clipboard successfully. The Clipboard viewer (supplied with
Windows) can be used to view the contents of the Clipboard at any time.

The content of the Clipboard appears in the Batch Display view as a new page.

For more information, see:

¢ Adding a Page from the Windows Clipboard, page 101

Pasting a Page after the Current Page

You can add the new page as the next page in the batch (after the currently displayed page).

To paste a page after the current page:

1. Move the desired data to the Windows Clipboard. Typically, this is performed through a
program’s Edit menu, and some programs have shortcuts to accomplish this function.

2. Ensure the appropriate batch is currently displayed. For instructions, see Displaying a Batch,
page 95.

3. From the Page menu, select New and then Clipboard Paste. A shortcut menu appears. From the
shortcut menu, select Insert After.

Note: If there is not a valid page in the Windows Clipboard, AppXtender Image Capture dims
the Insert After menu command, meaning it is not available for selection. If this is the case, verify
that the data has been moved to the Clipboard successfully. The Clipboard viewer (supplied with
Windows) can be used to view the contents of the Clipboard at any time.

The content of the Clipboard appears in the Batch Display view as a new page.

For more information, see:

* Adding a Page from the Windows Clipboard, page 101

Appending a Pasted Page to a Batch

You can add the new page as the last page in the batch.
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To paste a page to the end of the current batch:

1. Move the desired data to the Windows Clipboard. Typically, this is performed through a
program’s Edit menu, and some programs have shortcuts to accomplish this function.

2. Ensure the appropriate batch is currently displayed. For instructions, see Displaying a Batch,
page 95.

3. From the Edit menu, select Paste.

Note: If there is not a valid page in the Windows Clipboard, AppXtender Image Capture dims
the Paste command, meaning it is not available for selection. If this is the case, verify that the data
has been moved to the Clipboard successfully. The Clipboard viewer (supplied with Windows)
can be used to view the contents of the Clipboard at any time.

The content of the Clipboard appears in the Batch Display view as a new page.

For more information, see:

* Adding a Page from the Windows Clipboard, page 101

Adding a Page by Importing a File

You can create a page by importing an existing file. You can import any file type. Your ability to view
the resulting page depends on the type of file you have imported. If AppXtender Image Capture
supports the file type that you import, the content of the file appears in the Batch Display view.
Unsupported file types, or foreign file types, are represented in the Batch Display view by an icon
(unless the Foreign File Viewer is enabled). AppXtender Image Capture stores foreign file types

in their native file format. For more information, see Support for Viewing of Imported Files in
AppXtender Image Capture, page 96.

To add a page by importing a file:

1. Ensure the appropriate batch is currently displayed. For instructions, see Displaying a Batch,
page 95.

2. From the Page menu, select New and then Import File. A shortcut menu appears.

3. You have the following choices:

e If you want the new page to be added as the next page in the batch (after the currently
displayed page), select Insert After.

e If you want the new page to be added as the previous page in the batch (before the currently
displayed page), select Insert Before.

¢ If you want the new page to be added as the last page in the batch, select Append.

The Import File dialog box appears, allowing selection of any file.
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Figure 1. Import File Dialog Box

ImportFile 2] %
Lok ir; Iﬁ Legato Systems j da e -

|:I Content Management

File name: |

Filez of twpe: I,ﬂ-.ll Files [*#] j Cancel |

4. If you want to add a file of a foreign type, select All Files (*.*) from the Files of type list.

5. Navigate to and select the file you want to import and click Open. The new page appears in the
Batch Display view.

For more information, see:

* Adding Pages to Batches, page 98

Adding a Page by Dragging a File

You can create a page by dragging a file from another program, such as Microsoft Outlook, Microsoft
Exchange, or Windows Explorer. You can drag any file type into AppXtender Image Capture. Your
ability to view the resulting page depends on the type of file you have dragged. If AppXtender
Image Capture supports the file type you drag, the content of the file appears in the Batch Display
view. Unsupported file types, or foreign file types, are represented in the Batch Display view by an
icon (unless the Foreign File Viewer is enabled). AppXtender Image Capture stores foreign file
types in their native file format. For more information, see Support for Viewing of Imported Files in
AppXtender Image Capture, page 96.

To add a new page by dragging a file:

1. Ensure the appropriate batch is currently displayed. For instructions, see Displaying a Batch,
page 95.

2. Drag the file from the other program and drop it in the AppXtender Image Capture Batch Display
view. AppXtender Image Capture adds the page to the currently displayed batch (just before the
displayed page) and displays the new page in the Batch Display view.
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For more information, see:

¢ Adding Pages to Batches, page 98
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Viewing and Managing Batches

This section explains the various batch viewing functions available in ApplicationXtender Image
Capture, including displaying individual pages in multiple-page batches, page rotation, scaling,
zoom (both in and out), and sticky view. The section also explains the batch management functions
that are available in ApplicationXtender Image Capture, including the ability to edit batch memos
and the ability to print, fax, and delete batches and batch pages.

¢ Introduction to Batches, page 83

* Selecting Pages to View within a Batch, page 108
¢ Viewing Multiple Batches and Pages, page 109

¢ Page View Functions Available for Multiple Page Types, page 111
* Viewing Specific Page Types, page 123

e Batch View Properties, page 127

* Page Information, page 133

* Editing the Memo for a Batch, page 134

* Printing or Faxing Pages and Regions, page 135
¢ Copying Pages, page 137

* Deleting Batches and Pages, page 138

Introduction to Batches

ApplicationXtender Image Capture offers a wide variety of display options. For example, you can
easily switch from page to page, alter the display of a page’s size and position, focus on one part of a
page, or return to a desired page display format by default. AppXtender Image Capture supports
standard interfaces, so special print or fax drivers are not necessary to use the print and fax functions.

Note: Only users with the Print privilege granted can perform operations that cause information
to be "exported” from the AppXtender system. These operations include printing or faxing pages
and regions. If you have questions about the privileges assigned to your AppXtender user profile,
consult your AppXtender system administrator or refer to the Managing Security chapter of the
ApplicationXtender Administration Guide.
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Selecting Pages to View within a Batch

When you view a ApplicationXtender Image Capture (AppXtender Image Capture) batch with
multiple pages, you can use AppXtender Image Capture page navigation commands to move from
page to page and to view different parts of a page. You can use toolbar buttons, menu commands,
or keystroke combinations to display specific pages in a batch.

When you display a batch, AppXtender Image Capture always displays the last page in the Batch
Display view. (AppXtender, however, always displays the first page in the Batch Display view when
you display a document.) If the batch has more than one page, the Next Page, Previous Page, and Go
To Page functions can be used to move from page to page. You may choose from several different
methods of accessing subsequent pages: the Batch menu, the keyboard, or the Image toolbar.

As you navigate from page to page, the title bar and status bar indicate the page number of the
currently displayed page.

Note: If you are using Split View, the behavior of the Next Page and Previous Page commands
depends on the current configuration of the PgUp/PgDn in Dual-Page View option on the Display tab
of the Configuration dialog box. For information on this option, see PgUp/PgDn in Dual-Page View,
page 67. For information on Split View, see Split View, page 110.

For more information, see:

¢ Chapter 4, Viewing and Managing Batches
¢ Next Page, page 108

* Previous Page, page 108

* Go To Page, page 109

Next Page

To move forward one page:

¢ While any page of the batch is displayed, from the Batch menu, select Next Page.

Note: If the last page of the batch is currently displayed, the Next Page menu command displays
the first page of the batch.

For more information, see:

* Selecting Pages to View within a Batch, page 108

Previous Page

To move back one page:

* While any page of the batch is displayed, from the Batch menu, select Previous Page.

Note: If the first page of the batch is currently displayed, the Previous Page menu command displays
the last page of the batch.
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For more information, see:

® Selecting Pages to View within a Batch, page 108

Go To Page

If there is more than one page in the batch, you can use the Go To Page dialog box to display a
particular page.

To display a specific page within a multiple-page batch:

1. From the Batch menu, select Go To Page. The Go To dialog box appears.

Figure 2. Go To Dialog Box

x
Page: |2 _%

Help

Cancel |

2. In the Page text box, enter the page number of the page you want to display. You can either enter
the number or use the arrow buttons to specify a page number.

3. Click OK. The page is displayed.
For more information, see:

® Selecting Pages to View within a Batch, page 108

Viewing Multiple Batches and Pages

ApplicationXtender Image Capture (AppXtender Image Capture) can display multiple batches
simultaneously. Using the Windows Tile and Cascade features, AppXtender Image Capture shows
all open batches side-by-side or neatly stacked. You can also configure the Batch Display view to
show multiple pages of the same batch simultaneously.

For more information, see:

* Chapter 4, Viewing and Managing Batches
® C(Cascade, page 110

e Tile, page 110

® Split View, page 110

109



Viewing and Managing Batches

Cascade

The Cascade command cascades, or stacks, all displayed batch windows from the top left corner to
the bottom right corner. The active batch is displayed on the top. If the Applications view is currently
displayed as a window, it is included in the cascade.

To cascade all open windows:

e From the Window menu, select Cascade.

For more information, see:

* Viewing Multiple Batches and Pages, page 109

Tile

The Tile command shows all open batches side-by-side in the Batch Display view. If the Applications
view is currently displayed as a window, it is included in the tile effect.

To tile open windows:

¢ From the Windows menu, select Tile. AppXtender Image Capture tiles all open windows. If there
are three or fewer windows, the windows are tiled horizontally.

For more information, see:

¢ Viewing Multiple Batches and Pages, page 109

Split View

Split View splits the Batch Display view so that multiple pages of the same batch are displayed.
To enable split view:

¢ From the View menu, select Split Horizontally or Split Vertically.

To disable split view:

* From the View menu, select No Split.

Note: When you use Split View, the behavior of the Next Page and Previous Page commands depends
on the current configuration of the PgUp/PgDn in Dual-Page View option in the Configuration dialog
box. For information on this option, see PgUp/PgDn in Dual-Page View, page 67. For information on
the Next Page and Previous Page commands, see Selecting Pages to View within a Batch, page 108.
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For more information, see:

¢ Viewing Multiple Batches and Pages, page 109

Page View Functions Available for Multiple
Page Types

The way pages appear in ApplicationXtender Image Capture (AppXtender Image Capture) and
the viewing options available depend on the file type of the page. When you create a batch or
add a page to an existing batch by scanning, the file type is always an image file type. When you
create a batch or add a page by importing, the file type of each batch page depends on the native
file format of the file you imported.

The following topics describe functions that can be used with multiple page types:

¢ Using Sticky View, page 58

* Using Zoom, page 113

¢ Using Rotate, page 117

¢ Using the Magnifier, page 117

* Using Scale-to-Gray, page 118

¢ Using Regions, page 119

The page types that allow each of these functions are listed at the beginning of each of these topics.

Note: You can determine the page type of most AppXtender Image Capture batch pages by looking
at the Type value on the Information tab of the Image Information dialog box for the page. For details
on viewing information about a page, see Page Information, page 133.

For more information, see:

¢ Chapter 4, Viewing and Managing Batches

Using Sticky View

Sticky View means that AppXtender Image Capture can "remember" display settings (zoom, rotation,
and scale-to-gray) for similar page types. For example, bi-tonal (black and white) pages can be "stuck"
to open with certain zoom and rotation settings. A different Sticky View could be set for bitmaps.
Sticky View can be helpful when scanning similar paper documents, by displaying the page at its
actual size to facilitate monitoring the quality of the scan. AppXtender Image Capture automatically
discerns which page type is displayed and responds with the appropriate settings.

You can use Sticky View with the following page types:

¢ Images
¢ Text (as defined in the File Types tab of the Configuration dialog box)
¢ OLE Objects (as defined in the File Types tab of the Configuration dialog box)
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Note: For more information on the File Types tab of the Configuration dialog box, consult your
system administrator or refer to the "Configuring AppXtender Workstations" chapter of the
ApplicationXtender Administration Guide.

Sticky View is different from the default display configuration, which means the pages are not stored
with the sticky settings; the pages appear in Sticky View simply for batch creation and retrieval. The
sticky settings are in effect until Sticky View is turned off.

Sticky View applies the following settings:

® Zoom, as described in Using Zoom, page 113
* Rotation, as described in Using Rotate, page 117
* Scale-to-gray, as described in Using Scale-to-Gray, page 118

You can also save multiple sticky view settings for each image type and switch between each of
the saved sticky view settings. For more information, see Saving Sticky View Settings, page 59
and Switching Sticky View Settings, page 112.

For more information, see:

¢ Page View Functions Available for Multiple Page Types, page 111

Switching Sticky View Settings

As soon as you have saved a sticky view setting, you can use the Switch View command to display a
page using a Save Settings view, or the Sticky View button to cycle through each of the saved sticky
view settings. Depending on the number of views saved, you can display a page with up to five
different view settings. For information on saving views, see Saving Sticky View Settings, page 59.

To switch between sticky views from the View menu:

1. Display a page.

2. Select a sticky view setting. From the View menu, select Sticky View and then Switch View. The
Switch View menu appears. Highlight the appropriate view (for example, View 1).

Figure 3. Switch View Menu

Wigw 1 Alt+1
Wiew 2 Alk+2
Wiew 3 Al+3
Wiew 4 Al
Migw 5 Al+5

A check mark appears next to the selected view and the page appears with the selected sticky
view setting.
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Figure 4. Switch View Menu with the Selected View
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To switch between sticky views from the Image toolbar:
1. Display the page.

2. Click the arrow next to the Next Sticky View button on the Image toolbar.
Figure 5. Next Sticky View Button
.
The Sticky View drop-down menu appears with the currently saved sticky view settings enabled.
Figure 6. Sticky View Menu

Wigw 1 Alt+1
Wiew 2 Alk+2
v Wiew 3 Alk+3
Wiew 4 Al
Migw 5 Al+5

3. Select a sticky view setting. AppXtender Image Capture displays the page using the selected
sticky view setting.

Note: You can cycle through each of the sticky view settings by clicking the Next Sticky View button.
If the last sticky view setting is displayed, clicking the Next Sticky View button displays the first
available sticky view setting in the Sticky View menu.

For more information, see:

¢ Using Sticky View, page 58

Using Zoom

Zoom allows you to either focus precisely on a specific region of the page or view an entire page on
the screen at one time. The Zoom feature enlarges or reduces the selected page to the next size in the
zoom cycle. As soon as the largest size is reached, both the menu command for Zoom In and the
Zoom In toolbar button are dimmed to indicate that further enlargement is not possible. Similarly, if
the smallest size is reached, the Zoom Out menu command and toolbar button are dimmed.

You can set the default display scale in the Configuration dialog box. (For information on changing
the default display scale in the Configuration dialog box, see Image Size Options, page 63.) When a
batch is displayed in AppXtender Image Capture, the batch appears in this default scale. You can
also change the scale for the currently displayed page only, without affecting the default display
parameters. AppXtender Image Capture provides a wide variety of scaling options.
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You can use Zoom with the following page types:

* Images
¢ Text (as defined in the File Types tab of the Configuration dialog box)
* OLE Objects (as defined in the File Types tab of the Configuration dialog box)

Note: For more information on the File Types tab of the Configuration dialog box, consult your
system administrator or refer to the "Configuring AppXtender Workstations" chapter of the
ApplicationXtender Core Components Administrator’s Guide.

For more information, see:

* Page View Functions Available for Multiple Page Types, page 111
e Zoom In, page 114

* Zoom Out, page 114

e Zoom To Percent, page 115

e Zoom Percent, page 115

¢ Fit to Window, page 115

¢ Fit to Window Width, page 116

¢ Fit to Window Height, page 116

* Actual Size, page 116

Zoom In

This option enlarges (or zooms in on) the displayed page by cycling through pre-set magnification
levels.

To zoom in or enlarge the displayed page:

¢ From the View menu, select Zoom and then Zoom In.

For more information, see:

¢ Using Zoom, page 113

Zoom Out

This option reduces the displayed size of (or zooms out on) the displayed page by cycling through
pre-set magnification levels.
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To zoom out or decrease the size of the displayed page:

e From the View menu, select Zoom and then Zoom Out.

For more information, see:

¢ Using Zoom, page 113

Zoom To Percent

Like other Windows applications, AppXtender Image Capture allows you to select how big or how
small you want the displayed page to appear. Zooming to 100%, for example, shows the displayed
page at actual size. You can use this option to view varying amounts of detail on different pages.

To zoom the displayed page to a specific ratio:

¢ Right-click the page. A shortcut menu appears. From the shortcut menu, select a zoom ratio.
The pre-set options range from 25% to 400%.

For more information, see:

¢ Using Zoom, page 113

Zoom Percent

You can also apply a specific zoom percent to a displayed page. When this feature is accessed
from the View menu, any changes to the zoom parameters apply to the displayed page only. (For
information on setting the zoom percent default for all images, see View Tab, page 63.)

To define the zoom percentage for a page:

1. From the View menu, select Zoom and then Zoom Percent. The Zoom Percent dialog box
appears. The zoom percent range is from 1% to 1600%.

2. In the Zoom % text box, enter the zoom percentage you want to apply. You can enter a value or
you can use the up and down arrows to select the percentage.

3. Click OK. The selected zoom percent is applied to the page.
For more information, see:

¢ Using Zoom, page 113

Fit to Window

The selected page can be scaled so the entire page fits in the Batch Display view.
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To fit the entire displayed page within the window:

* From the View menu, select Zoom and then Fit To Window. The page adjusts so its entire height
and width fit in the window.

For more information, see:

¢ Using Zoom, page 113

Fit to Window Width

The selected page can be scaled so its entire width is visible in the Batch Display view.

To fit the displayed page's entire width within the window:

¢ From the View menu, select Zoom and then Fit To Window Width. The page adjusts so it fits the
window left to right.

For more information, see:

¢ Using Zoom, page 113

Fit to Window Height

The selected page can be scaled so its entire height is visible in the Batch Display view.

To fit the displayed page's entire height within the window:

* From the View menu, select Zoom and then Fit To Window Height. The page adjusts so it fits
the window top to bottom.

For more information, see:

* Using Zoom, page 113

Actual Size

The selected page can be scaled to its actual size. This means that each stored pixel is represented by
a monitor pixel.
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To display a page in its actual size:
¢ From the View menu, select Zoom and then Actual Size. The page adjusts so it appears in the
window at actual size.

For more information, see:

¢ Using Zoom, page 113

Using Rotate

The Rotate feature allows you to rotate pages and is especially useful when images were not saved in
the proper orientation. You can use rotation with image page types.

For more information, see:

¢ Page View Functions Available for Multiple Page Types, page 111
* Rotate Left, page 117
* Rotate Right, page 117

Rotate Left

This command rotates the displayed page 90° to the left.
To rotate a displayed page to the left:

¢ From the View menu, select Rotate Left.

For more information, see:

¢ Using Rotate, page 117

Rotate Right

This command rotates the displayed page 90° to the right.
To rotate a displayed page to the right:

¢ From the View menu, select Rotate Right.

For more information, see:

¢ Using Rotate, page 117

Using the Magnifier

AppXtender Image Capture provides a Magnifier feature that allows you to pinpoint an area of an
image to zoom. When the Magnifier button is selected, the mouse pointer becomes a magnifier and
a click of the mouse displays the selected page region in the Magnifier dialog box. You can use

the Magnifier with image page types.

17



Viewing and Managing Batches

To use the Magnifier:

1. From the View menu, select Zoom and then Magnifier. The Magnifier dialog box appears, and
the mouse pointer changes to a magnifying glass.

Figure 7. Magnifier Dialog Box

|z00% | v

2. You have the following choices:
* Click the image in the area you want to magnify. A dotted rectangle appears where you
clicked and the image within that rectangle is magnified in the Magnifier dialog box.

¢ Drag the mouse pointer over the image. The mouse pointer changes to include a dotted
rectangle. As you drag the pointer, the image within the dotted rectangle is magnified in the
Magnifier dialog box. When you release the mouse button, the dotted rectangle remains on
the image and the image within that rectangle remains magnified in the Magnifier dialog box.

3. You can change the zoom percent in the Magnifier dialog box.

¢ To increase the magnification, slide the arrow to the right.
* To decrease the magnification, slide the arrow to the left.

The display in the Magnifier window changes to reflect the new magnification.
For more information, see:

¢ Page View Functions Available for Multiple Page Types, page 111

Using Scale-to-Gray

A selected bi-tonal (black and white) page can be scaled to gray to increase readability. You can use
Scale-To-Gray only with bi-tonal image page types.
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To increase readability:

* From the View menu, select the Scale-to-Gray option.

For more information, see:

¢ Page View Functions Available for Multiple Page Types, page 111

Using Regions

You can select regions of an image or text page and process those regions in many ways. You can also
print a region. For more information, see Printing or Faxing a Region, page 137.

You can use regions with the following page types:

¢ Images
¢ Text (as defined in the File Types tab of the Configuration dialog box)

Note: For more information on the File Types tab of the Configuration dialog box, consult your
system administrator or refer to the "Configuring AppXtender Workstations" chapter of the
ApplicationXtender Core Components Administrator’s Guide.

For more information, see:

¢ Page View Functions Available for Multiple Page Types, page 111
* Enabling Select Mode, page 119

¢ Drawing a Region, page 120

* Magnifying a Region, page 120

¢ Copying a Region to the Clipboard, page 121

¢ (learing Regions, page 122

Enabling Select Mode

When pages are first displayed in AppXtender Image Capture, the view mode is defaulted to Pan
mode. Pan mode viewing is identified by the AppXtender Image Capture cursor appearing as a hand
in the interface. To select a region of a page for processing, change the AppXtender Image Capture
page-viewing mode from Pan to Select.

To change page view mode from Pan to Select:

¢ If the page currently displayed is in Pan mode, click the Pan Mode button in the Image toolbar.

Figure 8. Pan Mode Button

i

The button is "disabled" and the cursor, when placed over the displayed page, changes to an arrow.
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To return page view mode from Select to Pan:

¢ If the page currently displayed is in Select mode, click the Pan Mode button in the Image toolbar.
The button is "enabled" and the cursor, when placed over the displayed page, changes to a hand.

For more information, see:

¢ Using Regions, page 119

Drawing a Region

When you draw a region, you are selecting a region for processing. You can draw a region on the
following page types:

¢ Images
¢ Text (as defined in the File Types tab of the Configuration dialog box)

Note: For more information on the File Types tab of the Configuration dialog box, consult your system
administrator or refer to the Configuring AppXtender Workstations chapter of the ApplicationXtender
Administration Guide.

To draw a region:

1. Ensure Pan Mode is disabled. For information, see Enabling Select Mode, page 119.

2. Drag the pointer over the region you want to select. As you drag the pointer, it draws a rectangle
and highlights the area within the rectangle in green. This rectangle is the selected region.
For more information, see:

¢ Using Regions, page 119

Magnifying a Region

The Magnify Region feature allows you to focus on one region of an image and to enlarge it for better
viewing or manipulation. You can magnify a region on image page types.

To magnify a region:

* Right-click the highlighted region. A shortcut menu appears. From the shortcut menu, select
Magnify.

If Magnitfy is selected, the region appears with its enlarged view in a Magnify window. The Magnify
window has its own menu bar, with File and Edit commands.
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Figure 9. Magnify Window
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You have several choices. The following table describes commands that you can use in the File
menu and Edit menu of the Magnify window:

Table 18. Magnify Window Menu Commands

To Do This From This Magnify Menu Select This Command
Save the magnified region toa | File Save As

separate file. (Print privilege is

required.)

Print the magnified region. File Print

(Print privilege is required.)

Exit the Magnify window. File Exit

Copy the region to the Edit Copy

Windows Clipboard. (Print

privilege is required.)

Preserve the magnified region’s | Edit Keep Aspect Ratio
original height/width ratio.

Display information about the | Edit Information
magnified region, such as size,

width, and height.

Note: Only users with the Print privilege can perform operations that cause information to be
"exported" from the AppXtender system. If you have questions about the privileges assigned to your
AppXtender user profile, consult your AppXtender system administrator or refer to the Managing

Security chapter of the ApplicationXtender Administration Guide.

For more information, see:

¢ Using Regions, page 119

Copying a Region to the Clipboard

If you have the Print privilege, you can copy a region on the following page types:

¢ Images

¢ Text (as defined in the File Types tab of the Configuration dialog box)
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Note: For more information on the File Types tab of the Configuration dialog box, consult your
system administrator or refer to the "Configuring AppXtender Workstations" chapter of the
ApplicationXtender Administration Guide.

When you copy a region to the Clipboard, you copy the data in that region in its native format.

To copy a region to the Windows Clipboard:
1. Right-click the highlighted region. A shortcut menu appears.

2. You have the following choices:

¢ From the shortcut menu, select Copy. The image in the selected region is copied to the
Windows Clipboard.

* From the shortcut menu, select Cut. The image in the selected region is copied to the Windows
Clipboard and the region is cleared.

For information on using the contents of the Windows Clipboard to create new pages in AppXtender
Image Capture, see Adding a Page from the Windows Clipboard, page 101.

Note: Only users with the Print privilege can perform operations that cause information to be
"exported" from the AppXtender system. If you have questions about the privileges assigned to your
AppXtender user profile, consult your AppXtender system administrator or refer to the Managing
Security chapter of the ApplicationXtender Administration Guide.

For more information, see:

¢ Using Regions, page 119

Clearing Regions

When you clear a region, you clear the selection of that region. When you clear all regions, you clear
the selection of any regions selected on the page. You can clear a region on the following page types:

* Images

* Text (as defined in the File Types tab of the Configuration dialog box)

Note: For more information on the File Types tab of the Configuration dialog box, consult your system
administrator or refer to the Configuring AppXtender Workstations chapter of the ApplicationXtender
Administration Guide.

To clear regions:

1. Right-click the highlighted region. A shortcut menu appears.

2. You have the following choices:

¢ From the shortcut menu, select Clear All Region(s). All the regions on the page are cleared.
® From the shortcut menu, select Delete. The region is cleared.

Note: The Delete command does not change or remove pixels from the image.
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For more information, see:

¢ Using Regions, page 119

Viewing Specific Page Types

For each of the specific page types, ApplicationXtender Image Capture (AppXtender Image Capture)
has functionality that is exclusively available with that page type. For information on viewing options
that are only available for specific page types, see the following topics:

¢ Viewing Text Pages, page 123
e Viewing Foreign Files, page 124
For more information, see:

¢ Chapter 4, Viewing and Managing Batches

Viewing Text Pages

AppXtender Image Capture allows you to partition a text page vertically or horizontally, creating a
non-scrollable title region. Data above a horizontal title and data to the left of a vertical title becomes
stationary, while the data below or to the right of the title can still be browsed.

Using this feature, a line of existing text can be transformed into a title (or heading) for the text below.
This feature can be useful in cases where the headings for lengthy columns normally scroll off the
screen as you move down the page. Setting a title directly below those headings keeps them in place
even when displaying data several screens below.

To lock a title on a page:

1. Display the appropriate page.

2. Enable Pan Mode (if necessary) by clicking the Pan Mode button on the toolbar. When Pan
Mode is enabled, this button should appear pushed in, and the cursor, when placed over the
displayed page, becomes a hand.

3. Right-click the area where you want to apply the title lock. A shortcut menu appears.

4. From the shortcut menu, select Set Horizontal Title, Set Vertical Title, or Set Horizontal and
Vertical Title. AppXtender Image Capture adds a blue line indicating the location of the title. Text
to the left of vertical titles or above horizontal titles does not scroll.
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Figure 10. Title Lock

b 0572171997 016G Software Credit Union ;]
un 0572271997 General Ledger Chart of Accounts
Ealance Type Ling Tot Status Hame E
H11-¢-888 Shk, 423 .26 income @  active [HTEREST OH LDAKHS d
111-¢-0080 3,674.18- income a active INT. OH SEC. REAL ESTATE i
N11-0-00n 37,507 .91- income ®  actlve  CUSO MORTGRGE INCOME i
E11-2-900 144,888 .80~ income ] active UNSECURED LODAMS [
N11-d-00n 129,562 .65- income @ active  NEW AUTD ]
111~ g-008 140,213 .49~ income a active USED AUTOD ]
111-E-80p 5,180,114 income @ active INTEREST OH HEW LEASES i}
H11-d-0an LAC 32— dincome a actiue INTEREST OH USED LEASES a
M111-g-000 289 .53~ income ] active HEW AUTD BALLDOH PYHT i
111-0-0ap 8.88 income @ active USED AUTO BALLOOM PYMT d
M11-E-008 164.29- income a active IND IRECT-HEW ]
111-0-00D b .49~ Lincome @ aclive [NDIRECT-USED ]
N11-d-00n 1,241 .80~ income @ active MOBILE HOHES ]
11= =iy ¥,V .26~ income ¥ active  SHAHE SELUKED LUANHS ]
111-E-808 8.08 income ] active OTHER SECURED LODAHS (]
Ni1-0-00n 53.68- income @ active OTHER MEMBER LDANS i_|
111-g-000 12,245 .61~ income 1] active OTHER SECURED LODAHS ]
N11-d-8ap 21.78- income 8 active HOME EQUITY LDAMS ]
Hi1-0-00D 18,170.62 dincome @ active MASTERCARD i
111-2-900 30,543.61 income ] active UISH [ 5
s T LY [ P p—— L Y -t - AR eTATE W T
4] | il

To clear a title lock:

¢ Right-click the page. A shortcut menu appears. From the shortcut menu, select Clear Title.

Note: Titles remain in place if the batch is minimized, but clear when you navigate to another page or
when you close the batch.

For more information, see:

* Viewing Specific Page Types, page 123

Viewing Foreign Files

Typically, AppXtender Image Capture-supported foreign files are displayed in the Batch Display view
as icons. However, when you enable the Foreign File Viewer feature, AppXtender Image Capture can
display the contents of a foreign file. This feature allows you to access the contents of the file without
a third-party viewer. If you want to view the contents of a Microsoft Word file, for example, you do
not need to have a viewer (such as Microsoft Word) installed on the computer.

Note: If the Foreign File Viewer setting is enabled and Microsoft Office is installed on the computer,
AppXtender Image Capture automatically displays supported Microsoft Office 2003 and 2007
documents in a native Office embedded window inside the Batch Display view. Refer to Embedded
Office Viewer File Support, page 97 for more information.

When the content of an AppXtender Image Capture-supported foreign file is displayed, you can
launch the foreign file in its native application. For more information, see Launching Foreign Files,
page 126.

You can also access page information about a foreign file from a shortcut menu, if the foreign file is
displayed as an icon. For details on viewing information about a page, see Page Information, page 133.

For a list of the foreign files that can be viewed using the Foreign File Viewer feature, see .
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For more information, see:

* Viewing Specific Page Types, page 123

* Configuring a Viewer for Foreign Files, page 125
* Viewing Foreign Files, page 125

* Viewing Foreign Files as Icons, page 126

¢ Launching Foreign Files, page 126

* C(losing a Foreign File, page 126

Configuring a Viewer for Foreign Files

An option on the View tab of the AppXtender Image Capture Configuration dialog box controls
which viewer is used to display foreign files in the Batch Display view. If you enable the Display
foreign files option and Microsoft Office is installed on the computer, supported Microsoft Office
2003 and 2007 documents are automatically displayed in a native Office embedded window inside
the Batch Display view. Documents are available in read-only mode. If this option is enabled but
Microsoft Office is not installed on the computer, AppXtender Image Capture displays foreign files
using the Foreign File Viewer. If you disable the Foreign File Viewer option, AppXtender Image
Capture displays foreign files as icons.

To configure foreign file display:

1. From the File menu in AppXtender Image Capture, select Configuration. The AppXtender Image
Capture Configuration dialog box appears.

2. Click the View tab to activate it.

3. You have the following choices:
* To use the Foreign File Viewer to view foreign files, enable the Display foreign files option.
For instructions, see Viewing Foreign Files, page 125.

Note: If Microsoft Office is installed on the computer, enabling this option causes AppXtender
Image Capture to display supported Microsoft Office 2003 and 2007 documents in a native
Office embedded window instead of using the Foreign File Viewer. Refer to Embedded Office
Viewer File Support, page 97 for more information.

* To view foreign files as icons, disable the Display foreign files option. For instructions, see
Viewing Foreign Files as Icons, page 126.

For more information, see:

e Viewing Foreign Files, page 124
Viewing Foreign Files

When you view a foreign file using the Foreign File Viewer, the contents of the file appear in the
Batch Display view.
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When you display foreign files with the Foreign File Viewer, you can launch the foreign file in its
native application. For instructions, see the following topics:

* Viewing Foreign Files, page 124
¢ Launching Foreign Files, page 126
* Page Information, page 133

¢ Batch View Properties, page 127

Viewing Foreign Files as Icons

When you do not enable use of the Foreign File Viewer with foreign files, an icon represents the file
in the Batch Display view.

When foreign files are displayed as icons, you can access page information or batch view properties
from the Batch Display view. You can also launch the foreign file in its native application. For
instructions, see the following topics:

* Viewing Foreign Files, page 124

¢ Launching Foreign Files, page 126
* Page Information, page 133

* Batch View Properties, page 127

Launching Foreign Files

You can launch a foreign file to view it in the source application for the foreign file as long as you
have the source application installed on the computer. However, when you launch foreign files
from AppXtender Image Capture, any changes that you make to the file in the source application
are not saved in AppXtender Image Capture.

To launch a foreign file, from the Page menu, select Launch Foreign File. The source application for
the foreign file opens.

For more information, see:

* Viewing Foreign Files, page 124

Closing a Foreign File

To close the foreign file and return to the Batch Display view, from the File menu for the source
application, select Exit.
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For more information, see:

* Viewing Foreign Files, page 124

Batch View Properties

ApplicationXtender Image Capture (AppXtender Image Capture) allows you to modify the view
properties of a displayed page. The AppXtender Image Capture Configuration dialog box allows
you to set default parameters that are used when displaying a batch or page in AppXtender Image
Capture. However, you can use the Properties dialog box to customize the page display for only the
displayed page. There are four tabs in the Properties dialog box — General, Image, Text, and OCR.
Each tab has options that allow you to customize the view for the displayed page. The following
topics detail each tab:

¢ General Tab, page 127
* Image Tab, page 129
¢ Text Tab, page 132

Note: This feature is available for foreign files displayed as icons, but not for foreign files displayed
with the Foreign File Viewer. For instructions on displaying foreign files as icons, see Configuring a
Viewer for Foreign Files, page 125. Also, the options on the OCR tab are not available for AppXtender
Image Capture.

For more information, see:

¢ Chapter 4, Viewing and Managing Batches

General Tab

The General tab allows you to configure mouse action and batch display options.

To configure mouse action and batch display for a page:
1. Right-click the page. A shortcut menu appears.
2. From the shortcut menu, select Properties. The Properties dialog box appears.

3. Click the General tab.
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Figure 11. ApplicationXtender View Control Properties — General Tab
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4. Enable the options you want to use. The following table provides details on each option.

Table 19. ApplicationXtender View Control Properties - General Tab Options

To Do This Do This Default Status
Make the mouse pointer into | Enable the Scroll image Enabled
a scrolling device so that option.

you can drag the image in

Batch Display view to a new

position.

Make the mouse a selection Enable the Select image Disabled
tool so that you can draw option.

regions around all or a part

of the image in Batch Display

view for processing.

Make the mouse a selection Enable the Select annotation | Disabled
tool so that you can select option.

annotations for processing.

Do not allow the shortcut Uncheck the Right-click Disabled
menu to appear when you context menu option.

right-click a batch in the

display view (default).

Allow the shortcut menu to Close the displayed batch and | Enabled
appear when you right-click | re-open.

a batch in the display view

(after it has been disabled).
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To Do This Do This Default Status
Allow the horizontal or Enable the Display scrollbars | Enabled

vertical scrollbars to display | option.

in Batch Display view.

Specify the zoom ratio for the | In the Zoom ratio text box, Current zoom ratio
image in Batch Display view. | enter a value.

Some of these options can be implemented more easily with toolbar buttons. The following table
lists these options and their corresponding toolbar buttons:

Table 20. ApplicationXtender View Control Properties - General Tab Options

Option Toolbar Button For More Information, See

Scroll image o Batch Display View, page 36

Select image Using Regions, page 119

Select annotation Chapter 5, Annotations

Zoom ratio Using Zoom, page 113

0 E w» B+~ | 6

3

5. When all desired options have been selected/deselected, you have the following choices:

* C(lick OK to save changes and exit the dialog box.
* Click Cancel to exit without saving changes.
¢ Click Apply to save changes without exiting the dialog box.

For more information, see:

e Batch View Properties, page 127

Image Tab

The Image tab provides display and screen resolution options for the current page, if it is an image.

To configure display and screen resolution for an image:
1. Right-click the page. A shortcut menu appears.

2. From the shortcut menu, select Properties. The Properties dialog box appears. Click the Image tab.
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Figure 12. ApplicationXtender View Control Properties — Image Tab

ApplicationXtender ¥iew Control Properties El

General Image |Te:-:t IEIEH I

Display palette: IScale ta Gray - 256 Shades j

¥ Display image in itz actual scale

Screen Hesalution

¥ Use customized screen display rezolution [DF)

Haorizontal: IEIE 3: Wertical: IEIE 3:

Cancel | Lpply |

3. Enable the options you want to use. The following topics describe each option:

¢ Display Palette, page 130
¢ Display Image in its Actual Scale, page 131
¢ Screen Resolution, page 131

4. When all desired options have been selected/deselected, you have the following choices:

* Click OK to save changes and exit the dialog box.
* C(lick Cancel to exit without saving changes.
* Click Apply to save any changes you have made without exiting the dialog box.

For more information, see:

* Batch View Properties, page 127

Display Palette

The Display palette drop-down list provides options for viewing the image in various palettes. Keep
in mind that image size, image clarity, and file size increase with the number of colors in a palette.
Also, keep in mind that file processing slows as file size increases.

For a color image, you have the following choices:
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* Median Cut Palette * Bayer - Monochrome

¢ Fixed Palette * Bayer - 4 Gray Shades

e 3-3-2 Palette * Bayer - 16 Gray Shades

® Thumbnail Palette * Bayer - Fixed Palette

e 1-1-1 Palette * Bayer - 3-3-2 Palette

* Monochrome Palette * Bayer - 1-1-1 Palette

® 16 Gray Shades Palette ¢ Floyd/Steinberg - Monochrome

® 256 Gray Shades Palette ¢ Floyd/Steinberg - 4 Gray Shades
¢ Floyd/Steinberg - 16 Gray Shades

For a bi-tonal (black and white) image, you have the following choices:

* Monochrome Palette
* Scale to Gray - 16 Shades
* Scale to Gray - 256 Shades

For more information, see:

¢ Image Tab, page 129

Display Image in its Actual Scale

A check mark in this box allows the image to be scaled to its actual size. (This option can be
implemented more easily with a menu command. For information, see Actual Size, page 116.)
For more information, see:

¢ Image Tab, page 129

Screen Resolution

This option is available only when you enable the Display image in its actual scale option. If you
enable the Use customized screen display resolution (DPI) option, AppXtender Image Capture allows
you to designate customized horizontal or vertical settings. (The default values in the Horizontal
and Vertical boxes depend on the settings in the Display tab of the AppXtender Image Capture
Configuration dialog box. For more information, see Screen DPI, page 67.)
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For more information, see:

* Image Tab, page 129

Text Tab

The Text tab provides various display options for the text pages in the current batch.

To configure display options for the text pages in a batch:
1. Right-click the batch. A shortcut menu appears.

2. From the shortcut menu, select Properties. The Properties dialog box appears. Click the Text tab.

Figure 13. ApplicationXtender View Control Properties — Text Tab

ApplicationXtender ¥iew Control Properkties El

Generalllmage Text |EIEF| I

[T Display SelectFont.. | [T Bald [ Italic

Height [linez]: |3 E:

Calar—— Tab Size [characters]: Ig 3:

— Color Bar——————— " Test Font

I I

|| e D=y
| [ & o overlay
[ - -

€ ASEl overlay

% ¢ Image overlay [drrerlay fomt... |

Cancel | Apply |

3. Enable the options you want to use. The following table provides information on each option.

Table 21. ApplicationXtender View Control Properties - Text Tab Options

Option Function

Display Select this option to display the text pages
with a color bar background (helps make text
information in columns more readable).

Height (lines) To configure the height of each color bar,
enter the number of lines to display with the
selected color.

Select Font Select the font type for text page display.

Bold Select this option to display font in bold.
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Option Function
Italic Select this option to display font in italics.
Tab Size Enter a number or use the arrows to enter the

number of characters for tab settings within
a text page. Tabs are automatically set at
intervals of that length within the text page.

4. When all desired options have been selected/deselected, you have the following choices:

¢ C(lick OK to save changes and exit the dialog box.
¢ C(lick Cancel to exit without saving changes.
¢ Click Apply to save any changes you have made without exiting the dialog box.

For more information, see:

* Batch View Properties, page 127

Page Information

ApplicationXtender Image Capture (AppXtender Image Capture) supplies valuable information for
every page of a batch. This can be useful in determining the size of a particular image, for example,
or the page storage location.

Note: This feature is available for foreign files displayed as icons, but not for foreign files displayed
with the Foreign File Viewer. For instructions on displaying foreign files as icons, see Configuring a
Viewer for Foreign Files, page 125.

To view information about a page:

1. Display the page in AppXtender Image Capture.

2. Right-click the page. A shortcut menu appears. From the shortcut menu, select Information.
The Information dialog box appears.

Figure 14. Information Tab

Image Information El

Jris |

Wwidth: 738 piselz Height: 356 pixels
Bitz Per Pixel 1 Fezolution: 200 dpi
Size: 9914 bytes Compression: Law
Type: Tagged Image File Format

The Information tab provides the following details:
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Table 22. Image Information - Information Tab Description

Information Description

Width Number of pixels or characters being used for
width of page.

Height Number of pixels or lines being used for
height of page.

Bits Per Pixel Number of bits for each pixel.

Resolution Resolution of the page.

Size Compressed page file size (in bytes).

Compression Type of compression used for this page.

Type Page file type (such as TIFF or JPEG).

3. To view information specific to the files associated with the batch, click the Files tab.

Figure 15. Image Information Dialog Box: Files Tab

Image Information EI

Infarmation | |

Image Filename:
ID:'\F‘ngram FilezhLegato Spztems\Caontent M anagementhDEMODE\filezhCHELCI

Annatation Filenanne:

The Files tab provides the following details:

Table 23. Image Information - Files Tab Description

Info Description

Image Filename Path location and file name of the stored page.

Annotation Filename Path location and file name of the page’s
annotations, if any.

For more information, see:

¢ Chapter 4, Viewing and Managing Batches

Editing the Memo for a Batch

When a batch is created in ApplicationXtender Image Capture (AppXtender Image Capture), a memo
is automatically created with it. By default, this memo contains the date and time that the batch was
created. You can add to or edit this memao, if the batch status is Idle.
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To edit the memo for a batch:
1. If the batch is currently displayed, close it.

2. In Applications view, right-click an application. A shortcut menu appears. From the shortcut
menu, select Batch List. The Batch Scan dialog box appears.

3. In the Batches for application drop-down list, select the application that contains the batch for
which you want to edit the memo. A list of batches appears in the table.

4. Select the row for the batch and click Memo. (This button is available only when none of the
AppXtender or AppXtender Image Capture workstations in the AppXtender system have that
batch open.) The Memo dialog box for that batch appears.

Figure 16. Memo Dialog Box

Memo x|

Batch create at 2002-04-05 16:57. This batch
contains invoices, ASF

Cancel Help |

5. Edit the text. You can include any information (up to 132 characters) that you think is helpful to
the following people:

* The AppXtender user or users who index and create documents from this batch.
* The AppXtender Image Capture user or users who add more pages to this batch.
6. Click OK.

For more information, see:

¢ Chapter 4, Viewing and Managing Batches

Printing or Faxing Pages and Regions

ApplicationXtender Image Capture (AppXtender Image Capture) allows you to print or fax pages or
regions of an image or text page. For information, see the following topics:

e Chapter 4, Viewing and Managing Batches
* Printing or Faxing Pages, page 136
¢ Printing or Faxing a Region, page 137

Note: AppXtender Image Capture uses Windows print drivers to perform faxing operations. To fax
pages in AppXtender Image Capture, you must install Windows-compliant fax software.

Note: Only users with the Print privilege can perform operations that cause information to be
"exported" from the AppXtender system. These operations include printing or faxing pages or
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regions. If you have questions about the privileges assigned to your AppXtender user profile,
consult your AppXtender system administrator or refer to the "Managing Security" chapter of the
ApplicationXtender Administration Guide.

Printing or Faxing Pages

You can print or fax a displayed page in AppXtender Image Capture.

You can fax a displayed page in AppXtender Image Capture using standard Windows fax devices.
Any fax device installed as a standard printer port can be used to fax AppXtender Image Capture
pages. If your fax device is listed in the Name drop-down list on a standard Print dialog box, you
can fax AppXtender Image Capture pages to it.

Note: An endorsement can be added to pages printed or faxed in AppXtender Image Capture
(except HTML pages). Endorsements are identifying text strings that can be configured to print

in one of the four corners of the page. In addition to text, page numbers can be included in an
endorsement. For more information on endorsing printed or faxed pages, consult your AppXtender
system administrator or refer to the "Configuring AppXtender Workstations" chapter of the
ApplicationXtender Administration Guide.

To print or fax a page:
1.  Within AppXtender Image Capture, display the page that you want to print or fax.

2. From the Page menu, select Print. The standard Windows Print dialog box appears.

Figure 17. Print Dialog Box

prnt 2 x|

— Printer

M arne: I WOOCPRINTAHPA EIEIDTN_DEIELIMENT.ij Properties... |

Statusz Ready
Type: HP Lazerlet 4100 PCL &

Where:  Documentation 4th Flaor

Comment: Documentation dth Floor

— Print range — Copies
o al Mumber of copies: 1 :
" Pages  from: |1 b |2
o el o) e
* Selection z 3
™ Hide annotations ™ Print text note

f Cancel |
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3. From the Name drop-down list, select the printer or fax device. Select the number of copies
you want.

4. Click OK. The displayed page is sent to the printer or fax device. A message appears with the
status of the job. Click Cancel to quit the job at any time.

Note: You can also print or fax the displayed page by clicking the Print button on the Main toolbar. If
you do so, the Print dialog box does not appear. Instead, one copy of the displayed page is printed
using the default printer.

For more information, see:

¢ Printing or Faxing Pages and Regions, page 135

Printing or Faxing a Region

You can print or fax a specific region of an AppXtender Image Capture page.

To print or fax a region:

1. If the page currently displayed is in Pan mode (that is, the pointer is a hand), click the Pan Mode
button in the toolbar to disable Pan mode. For information, see Enabling Select Mode, page 119.

2. Drag the pointer over the region that you want to select. As you drag the pointer, it draws a
rectangle and highlights the area within the rectangle in green. This rectangle is the selected
region.

3. Right-click the highlighted region. A shortcut menu appears.

4. From the shortcut menu, select Print. The image in the selected region is sent to the computer's
default printer (which may actually be a fax device).

For more information on using regions, see Using Regions, page 119.

For more information, see:

¢ Printing or Faxing Pages and Regions, page 135

Copying Pages

You can copy pages from AppXtender Image Capture at anytime. When a page is copied,
AppXtender Image Capture makes a copy of the object file (*.BIN) and places the copied page to the
Windows Clipboard.

To copy a page:

1.  Within AppXtender Image Capture, display the page you want to copy.

2. From the Edit menu, select Copy. The page is copied to the Windows Clipboard.

If you want to paste the page back into an AppXtender Image Capture batch, see Adding a Page from
the Windows Clipboard, page 101.
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For more information, see:

¢ Chapter 4, Viewing and Managing Batches

Deleting Batches and Pages

ApplicationXtender Image Capture (AppXtender Image Capture) allows you to delete batches or
pages. For more information, see the following topics:

¢ Chapter 4, Viewing and Managing Batches
* Deleting Pages, page 138

e Cutting Pages, page 138

* Deleting Batches, page 139

Deleting Pages

You can delete pages from an AppXtender Image Capture batch at any time. When a page is deleted,
AppXtender Image Capture also deletes the object file (*.BIN).

!\ Caution: As soon as the deletion is confirmed, the page is permanently lost. Caution should be
exercised because recovery of the page is not possible.

To delete a page:
1. Within AppXtender Image Capture, display the page that you want to delete.
2. From the Page menu, select Delete. A delete confirmation message appears.

3. Click Yes to delete the displayed page. Click No to quit.
For more information, see:

* Deleting Batches and Pages, page 138

Cutting Pages

You can cut pages from an AppXtender Image Capture batch at any time. When a page is cut,
AppXtender Image Capture deletes the object file (*.BIN) and moves the page to the Windows
Clipboard.

! \ Caution: As soon as the deletion is confirmed, the page exists only in the Clipboard. Caution
should be exercised because recovery of the page is not possible unless you paste the page back
into an AppXtender Image Capture batch.

To cut a page:

1. Within AppXtender Image Capture, display the page that you want to cut.
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2. From the Edit menu, select Cut. A delete confirmation message appears.

3. Click Yes to delete the displayed page. Click No to quit. The page is copied to the Windows
Clipboard.

If you want to paste the page back into an AppXtender Image Capture batch, see Adding a Page from
the Windows Clipboard, page 101.

For more information, see:

* Deleting Batches and Pages, page 138

Deleting Batches

There are two ways to delete a batch in AppXtender Image Capture: from the Batch List or from the
Batch Display view. When a batch is deleted, the batch pages (*.BIN files) are deleted.

For more information, see:

* Deleting Batches and Pages, page 138
* Deleting a Batch from the Batch Display View, page 139
* Deleting a Batch from the Batch List, page 139

Deleting a Batch from the Batch Display View

You can delete a batch that has been displayed in the Batch Display view.

! \ Caution: As soon as the deletion is confirmed, the batch is permanently lost. Caution should be
exercised because recovery of the batch is not possible.

To delete a displayed batch:
1. Display the batch that you want to delete.
2. From the Batch menu, select Delete. A delete confirmation message appears.

3. Click Yes to delete the displayed batch. Click No to quit.
For more information, see:

* Deleting Batches, page 139

Deleting a Batch from the Batch List
You can delete a batch from the Batch List.

!\ Caution: As soon as the deletion is confirmed, the batch is permanently lost. Caution should be
exercised because recovery of the batch is not possible.
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To delete a batch from the Batch List:

1. In Applications view, right-click an application. A shortcut menu appears. From the shortcut
menu, select Batch List. The Batch Scan dialog box appears.

2. In the Batches for application drop-down list, select the application that contains the batch that
you want to delete. A list of batches appears in the table.

3. Select the batch that you want to delete. Click Delete. A delete confirmation message appears.
4. Click Yes to delete the batch. Click No to quit.

For more information, see:

* Deleting Batches, page 139
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Chapter 5

Annotations

This section describes how to ApplicationXtender Image Capture to attach an annotation to batch
pages to comment on the contents of a page, block areas of a page from view, or highlight important
information. You can add annotations to images, text, and Portable Document Format (PDF) files.

¢ Introduction to Annotations, page 141

¢ Annotation Types, page 142

¢ Configuring Annotation Settings, page 143

* Creating an Annotation, page 149

* Rubber Stamp Annotations, page 158

¢ Overlapping Annotations, page 160

* Assigning an Annotation to an Annotation Group, page 161
¢ Showing or Hiding Annotations, page 162

* Modifying Annotation Settings, page 165

* Printing Text Annotations, page 171

* Removing Annotations, page 171

Introduction to Annotations

Several different types of annotations are available to the AppXtender Image Capture user. Manual
marks, such as lines, arrows, and highlights, can be used to emphasize part of the page. A polyline
annotation feature allows users to add lines with multiple nodes. You can also add shapes as
annotations; ovals, rectangles, and rounded rectangles can be added in opaque or transparent mode.
Polygons can be created to emphasize asymmetrically shaped areas. Text annotations can also be
added and displayed as actual text or as a sticky note icon. All annotations, including text, can be
created in transparent or opaque (redacted) mode. There is no limit to the number of annotations
that can be placed on a page; however, a large number of annotations could slow down or distort
page rendering.

Several properties of annotations can be customized to create desired effects. For example, the
redaction feature can be used in combination with the filled setting to block sections of a page from
view. Additionally, the line width and colors of annotations can be changed.
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Figure 18. Page With Annotations
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A show/hide feature allows you to view or hide annotations with a single click, and annotations
can easily be deleted or saved. Using the Cancel Changes function, you can remove changes to
annotations made since the last save. Annotations can overlap, and you can move them in front of
or behind other annotations.

Note: Contact your ApplicationXtender administrator if you have any questions about your
annotation privileges.

Annotation Types

You can annotate your pages with five types of annotations:

¢ Line annotations include the straight line, the freehand line, the arrow, and the polyline.

* Shape annotations include the rectangle, the rounded rectangle, the oval, and the polygon. Shape
annotations have a fill color and an outline.

* Text annotations have both fill color and outline configuration options. They can be displayed as
either icons or text.

¢ Highlight annotations are similar to rectangle annotations, except that they have no outline and
the default color is not configurable.

* Rubber Stamp annotations include standard annotation attributes as well as other rubber stamp
annotation attributes such as type (text or image), content (text string or embedded bitmap),
and so on.

Note: When any type of annotation (line, shape, text, highlight, or rubber stamp) has the redaction
property applied to it, the annotation is considered to be a redaction. Annotations and redactions of
any type can be created, modified, hidden, moved, or deleted only by users who have appropriate
privileges. For example, the Edit Redaction privilege allows you to hide a redaction that you have
created, but not one created by someone else, unless you also have the Global Annotations privilege.
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Saving Annotations

You have these options for saving an annotation to a document page:

¢ Select Annotate> Save from the Image Capture menu bar.
* Press w.
* C(lose the document or batch.

Refer to Modifying Annotation Settings, page 165 for information on modifying annotations after
they have been saved to a page.

Configuring Annotation Settings

You can set certain properties for lines and shapes before applying an annotation. For more
information, see the following topics:

* Default Line Width, page 143

¢ Default Color for Highlight Annotations, page 144

* Default Color for Text Annotations, page 144

¢ Default Color for Line and Shape Annotations, page 146
¢ Default Filled or Hollow Setting, page 147

* Default Redaction Setting, page 147

* Default Annotation Group, page 148

Note: Only users with appropriate privileges can control the annotation features. If you have
questions about the privileges assigned to your AppXtender user profile, consult your AppXtender
system administrator or refer to the Managing Security" chapter of the ApplicationXtender
Administration Guide.

Default Line Width

The line width of lines and shapes added as annotations is configurable. Line width settings are used
for line annotations and the outlines of shape annotations. You can change the default line width
from the Annotation menu or from the Annotation toolbar.

To set the width of lines and arcs:

1. From the Annotate menu, select Settings and then Line Width. The Line Width drop-down
box appears.
2. Select the new line width.

Any new annotations you create will have the line width setting you selected. You can change
the line width setting of an existing annotation in the Annotation Properties dialog box. For more
information, see Modifying Annotation Settings, page 165.
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For more information, see:

* Configuring Annotation Settings, page 143

Default Color for Highlight Annotations

Color is used for all annotations. Color settings for highlight annotations are separate from color
settings for text, line, or shape annotations.

Note: The default color for highlight annotations is yellow and cannot be changed.

You can change the color of existing highlight annotations in the Annotation Properties dialog box.
For more information, see Modifying Annotation Settings, page 165.

For more information, see:

¢ Configuring Annotation Settings, page 143

Default Color for Text Annotations

Color is used for all annotations. The default fill and line colors of new annotations are configurable.
Color settings for text annotations are separate from color settings for highlight, line, or shape
annotations. You can change the default color settings for text annotations in the Annotation Text
Editor dialog box.

To set the default color of text annotations:

1. Create a text annotation. For information, see Creating a Text Annotation, page 150.

2. Ensure that the Annotation Selection button on the Annotations toolbar is selected. Select the text
annotation and right-click the selected annotation.

3. From the shortcut menu that appears, select Properties.

4. Click the ellipses button (...) if the in-place text editor appears. The Annotation Text Editor
dialog box appears.
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Figure 19. Annotation Text Editor Dialog Box
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5. Click Advanced. The advanced options appear.

Figure 20. Annotation Text Editor Dialog Box: Advanced Options
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Under Colors, notice the grid of colors. Under this grid, notice the two overlapping rectangles.
The color in the top rectangle represents the color of text annotation outlines. The color in the
bottom rectangle represents the fill color for text annotations.

6. Inthe grid of colors, click a color. The color you selected appears in the top rectangle, representing
the color of text annotation outlines.

7. In the grid of colors, right-click a color. The color you selected appears in the bottom rectangle,
representing the fill color for text annotations.
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8. Enable the Set as default option.

9. Click OK. Any text annotations created from now on appear with the colors you selected.

You can change the color of an existing text annotation in the Annotation Text Editor dialog box. For
more information on modifying a text annotation, see Modifying Annotation Settings, page 165.

For more information, see:

¢ Configuring Annotation Settings, page 143

Default Color for Line and Shape Annotations

The color of lines and shapes added as annotations is configurable. Color is used for all annotations.
Color settings for line and shape annotations are separate from color settings for text or highlight
annotations. You can change the default color settings for line or shape annotations from the
Annotation menu or from the Annotation toolbar.

To set the color of lines and shapes:

1. From the Annotate menu, select Settings and then Colors. The Color drop-down box appears.

Figure 21. Color Drop-Down Box

Under the grid of colors, notice the two overlapping rectangles. The color in the top rectangle
represents the color of shape outlines and lines. The color in the bottom rectangle represents the
fill color for all shape annotations.

2. To set the fill color, right-click a color in the grid of colors. The color you selected appears in the
bottom rectangle, indicating the fill color for all shape annotations.

3. To set the outline color, click a color in the grid of colors. The color you selected appears in the top
rectangle, indicating the color of shape outlines and lines. Any line or shape annotations created
from now on appear with the colors you selected.

You can change the color of an existing line or shape annotation in the Properties dialog box. For
more information, see Modifying Annotation Settings, page 165.
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For more information, see:

¢ Configuring Annotation Settings, page 143

Default Filled or Hollow Setting

The filled/hollow setting is used for annotation shapes. You can fill an annotation shape with the
default fill color or you can make a shape hollow. You can change the default filled/hollow setting
from the Annotation menu or from the Annotation toolbar.

Note: Highlight annotations are similar to shape annotations, except that they are always filled,
regardless of the filled/hollow setting.

Generally, this feature is used with redaction to block large areas of the page from view. When both
fill and redaction are enabled, both the outline and fill of the annotation are applied as opaque. For
information on redaction, see Default Redaction Setting, page 147.

To toggle the fill setting on and off, choose one of the following options:

e Select Annotate> Settings> Filled.
¢ Pressi.

If the button is active (lighter in color), new shape annotations have a fill of the default fill color. If
the button is not active (same color as the other toolbar buttons) new shape annotations are added
without a fill color.

Any annotations created from now on appear with the filled/hollow setting you selected. You can
change the filled/hollow setting of an existing annotation in the Properties dialog box. For more
information, see Modifying Annotation Settings, page 165.

For more information, see:

¢ Configuring Annotation Settings, page 143

Default Redaction Setting

Redaction is a security feature that enables you to block certain areas of an image or text page
from view. You can change the default redaction setting from the Annotation menu or from the
Annotation toolbar.

When enabled, the outline of the annotation is applied as opaque; underlying parts of the image are
not visible. When disabled, the outline of the annotation is applied as transparent.

Redaction can be used in conjunction with the filled/hollow feature to make the entire shape of
the annotation opaque (not just the outline). For information on filled and hollow annotations,
see Default Filled or Hollow Setting, page 147.

To toggle redaction on and off, choose one of the following options:

* Select Annotate> Settings> Redaction.

e Press d.

147



Annotations

If the button is active (lighter in color), the outline of any new annotation is opaque. If the Fill button
is also active, both the outline and the fill of new annotations are opaque. If the Redaction button is
not active (same color as other toolbar buttons), both the outline and the fill (if one is configured)

of new annotations are transparent.

Any annotations created from now on appear with the redaction setting you selected. You can change
the redaction setting of an existing annotation in the Properties dialog box. For more information,
see Modifying Annotation Settings, page 165.

For information on the interaction between redactions and OCR/full-text, refer to the "Annotations"
section of the ApplicationXtender Document Manager User’s Guide.

For more information, see:

¢ Configuring Annotation Settings, page 143

Default Annotation Group

If your user account is a member of an annotation group, you might be able to specify that particular
annotation group as a default annotation group. When a new annotation is created or when current
settings are applied to an annotation, the annotation is assigned to the default annotation group. If
your AppXtender administrator instructs you that the annotations you create should be added to a
specific annotation group, you can set that annotation group as a default to cause the annotations you
create or modify to be automatically added to the group.

Note: Only users with appropriate annotation group options can specify an annotation group as
default. If you have questions about the annotation group configuration of your AppXtender user
account, consult your AppXtender system administrator or refer to the Managing Security chapter
of the ApplicationXtender Administration Guide.

To specify an annotation as a default annotation group:

1. From the Annotate menu, select Settings and then Default Annotation Group. The Select the
Default Annotation Group dialog box appears.
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Figure 22. Select the Default Annotation Group Dialog Box
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2. Select the group that you want to use as the default group.
3. Click OK.

For more information, see:

¢ Configuring Annotation Settings, page 143

Creating an Annotation

After configuring the properties of the annotation, you can add any one of several different types
of annotations to the page. You can apply any text, line, shape, or highlight annotation that best
emphasizes the desired area of the image. Lines include straight lines, freehand lines, arrows,

or polylines. Shapes include rectangles, rounded rectangles, ovals, or polygons. You can apply
annotation text in a desired color and font format. ApplicationXtender Image Capture also allows
you to create "rubber stamp" annotations, which can be a custom text string or embedded bitmap.

Note: Only users with appropriate privileges can control the annotation features. If you have
questions about the privileges assigned to your AppXtender user profile, consult your AppXtender
system administrator or refer to the Managing Security chapter of the ApplicationXtender
Administration Guide.

Note: If your user account has been configured with annotation group options, but does not have any
annotation privileges, you must set your annotation group as default to use annotation features. For
instructions on setting an annotation group as default, see Default Annotation Group, page 148.

For more information, see the following topics:

® Creating a Text Annotation, page 150

® Creating a Line Annotation, page 153
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¢ Creating a Shape Annotation, page 155
¢ Creating a Highlight Annotation, page 157
* Rubber Stamp Annotations, page 158

Creating a Text Annotation

ApplicationXtender Image Capture has two tools for creating text annotations. For more information,
refer to the following sectionstopics:

¢ Using the Annotation Text Editor, page 150
¢ Using the In-place Text Editor, page 152

Using the Annotation Text Editor

The Annotation Text Editor is a dialog box text annotation tool.

To use the Annotation Text Editor to create a text annotation:
1. Display the page to which you want to add a text annotation.

2. Choose one of these options to activate the text annotation symbol:

* Select Annotate> New> Text from the Image Capture menu bar.
® Presst.
Note: You must have redaction privileges to create and modify non-transparent text annotations.

3. Click the location on the AppXtender page where you want to place the text annotation. The
Annotation Text Editor dialog box appears.
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Figure 23. Annotation Text Editor Dialog Box
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Under Annotation Text, type the text that you want to use as the annotation. Press Enter to
start a new line in the editor.

Click Sp to check the spelling of the text annotation. The Check Spelling dialog box appears.
Correct or confirm the spelling of any questionable words.

Note: Click Help on the Check Spelling dialog box for more information on spell-checker options.
Click OK to close the ApplicationXtender message box after all words have been checked.

Specify how you want Image Capture to display the text annotation:
¢ To display this annotation as an icon, select Display As Icon.
¢ To display the text as the annotation, clear the Display As Icon check box.

Note: You must have the Global Annotations privilege to view or modify the text of a text
annotation icon created by another user. If you have questions about the privileges assigned to
your AppXtender user profile, consult your AppXtender system administrator or refer to the
Managing Security chapter of the ApplicationXtender Administration Guide.

If you want to define the font and color features for the annotation text, click Advanced. The
advanced options appear.
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Figure 24. Annotation Text Editor Dialog Box: Advanced Options

Annotation Text Editor ) x|

Annatation Text: [5e] — Font
| ] Size: I‘IE vl

[T Bold T Underline
[ ltalic [ Stike out
[ Transparent

LI _’ILI —Colorg——————————
| Emm-
™ Display az icon <<Bazic
| [
N ]

Created:
Modified:

[Eroup; E
0, I Cancel Apply | I Set az default

10. Select the desired color and font size, and select the check boxes for any other desired font
properties. Select the Set as Default check box to save the current settings as the default.

Note: Any color selection in the text annotation editor applies only to text annotations and does
not affect shape, line, or highlight annotations.

Note: To modify the size of a text annotation, you must modify the text font.
11. Click OK to apply the text annotation to the image.

12. Save the annotation. Refer to Saving Annotations, page 143 for more information.

The text annotation and any other new annotations are saved to the image. When retrieved, the image
is displayed with the text annotation in the defined color and font.

Using the In-place Text Editor

The in-place text editor is a What You See Is What You Get (WYSIWYG) text annotation tool.

To use the in-place text editor to create a text annotation:
1. Display the page to which you want to add a text annotation.

2. Choose one of these options to activate the text editor:
e Press Shift-t.

® Press and hold down Alt, left-click the Text button on the Annotation toolbar, release Alt.
The cursor becomes a pushpin.

3. Left-click and drag the pushpin over the page to define the border of the text editor.
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Figure 25. In-place Text Editor

4. Type the text annotation. Press Ctrl-Enter to start a new line in the editor.
5. Click Sp to check the spelling of the text annotation. The Check Spelling dialog box appears.
6. Correct or confirm the spelling of any questionable words.
Note: Click Help on the Check Spelling dialog box for more information on spell-checker options.
7. Click OK to close the ApplicationXtender message box after all words have been checked.
8. Click the green check mark to apply the text annotation to the image.
9. Save the annotation. Refer to Saving Annotations, page 143 for more information.

Note: You can change the properties of polyline annotations after they have been added to a page.
For more information, see Modifying Annotation Settings, page 165.

Creating a Line Annotation

You can add basic line annotations and polyline annotations to pages. Basic line annotations are
straight lines, freehand lines, and arrows. A polyline annotation is a series of connected straight lines.

For more information, see the following topics:

* Creating a Basic Line Annotation, page 153

¢ Creating a Polyline Annotation, page 154

Creating a Basic Line Annotation

You can add straight lines, freehand lines, and arrows (basic line annotations) to pages.

To add a basic line annotation to a page:

1. Display the page to which you want to add a basic line annotation.
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2. Choose one of these options to select a type of line annotation:

* Select Annotate> New from the Image Capture menu bar, and then select the annotation
from the shortcut menu.

* C(lick the appropriate button on the Annotation toolbar.
* Press the keyboard shortcut.

The following table describes the available line annotations.

Table 24. Creating Basic Lines

Shortcut Menu
To Create Option Button Keyboard Shortcut
A straight line Straight Line \ L
A freehand line Freehand Line , F
An arrow Arrow / A

The mouse pointer changes shape to reflect your selection.

3. Drag the mouse pointer from a starting point to an end point. As you drag the pointer, a new line
annotation appears on the image.

4. Save the new annotation. Refer to Saving Annotations, page 143 for more information.

The line annotation and any other new annotations are saved to the image. When retrieved, the
image is displayed with the line annotation in the defined color.

Note: You can change the properties of polyline annotations after they have been added to a page.
For more information, see Modifying Annotation Settings, page 165.

For more information, see:

¢ Creating a Line Annotation, page 153

Creating a Polyline Annotation

You can add polyline annotations to pages. A polyline is a line that connects more than one point,
or node. The nodes defining the polyline do not have to be aligned. With the polyline feature, you
can create line annotations that are not straight lines. Polyline annotations can contain angles and
can even delineate shapes.

Note: A shape created with the polyline feature cannot be filled with color. You can use the polygon
feature to create polygon shapes, which can be filled with color. For information on polygon
annotations, see Creating a Polygon Annotation, page 156.

Each point in a polyline annotation is specified by a single left mouse click. You draw the line point
by point, stretching each straight-line segment from the endpoint of the last.

To add a polyline annotation to a page:

1. Display the page to which you want to add a polyline annotation.
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2. Choose one of these options to activate the polyline annotation symbol:

¢ Select Annotate> New> Polyline from the Image Capture menu bar.
® Press p.
3. Click where you want the polyline to start. This creates the first node in the line.

4. Move the pointer and click again to set the endpoint for the first segment of the polyline. This
endpoint is the next node in the line.

5. Continue to draw line segments by moving the pointer and clicking wherever you want each
segment to end. Each of these endpoints becomes a new node in the line. Each segment created is
connected to the previous segment.

Figure 26. Example of a Polyline
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Note: To erase the polyline without adding it, right-click anywhere on the page.

6. When the polyline is complete, double-click where you want the last node to appear. The
annotation is added to the page.

7. Save the new annotation. Refer to Saving Annotations, page 143 for more information.

The polyline annotation and any other new annotations are saved to the image. When retrieved, the
image is displayed with the polyline annotation in the defined color and shape.

Note: You can change the properties of polyline annotations after they have been added to a page.
For more information, see Modifying Annotation Settings, page 165.

For more information, see:

* Creating a Line Annotation, page 153

Creating a Shape Annotation

You can add basic shape annotations and polygon annotations to pages. Basic shape annotations are
rectangles, rounded rectangles, and ovals. A polygon annotation is a closed shape, composed of a
series of connected, straight lines that can be filled with color like any other shape.

For more information, see the following topics:

* Creating a Basic Shape Annotation, page 155

¢ C(Creating a Polygon Annotation, page 156

Creating a Basic Shape Annotation

You can add rectangles, rounded rectangles, and ovals (basic shape annotations) to pages.
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To add a basic shape annotation to a page:
1. Display the page to which you want to add a basic shape annotation.

2. Choose one of these options to select a shape annotation:

® Select Annotate> New from the Image Capture menu bar, then select the annotation from
the shortcut menu.

* C(Click the appropriate button on the Annotation toolbar.
® Press the keyboard shortcut.

The following table describes the available shape annotations.

Table 25. Creating Basic Shapes

Shortcut Menu
To Create Option Button Keyboard Shortcut
A rectangle Rectangle O R
A rounded rectangle | Rounded Rectangle O N
An oval Oval ) O

The mouse pointer changes shape to reflect the selection.

3. Drag the mouse pointer from a starting point to an end point. As you drag the pointer, a new
shape annotation appears on the image.

4. Save the new annotation. Refer to Saving Annotations, page 143 for more information.

The shape annotation and any other new annotations are saved to the image. When retrieved, the

image is displayed with the shape annotation in the defined color and shape.

Note: You can change the properties of shape annotations after they have been added to a page. For
more information, see Modifying Annotation Settings, page 165.

For more information, see:

¢ Creating a Shape Annotation, page 155

Creating a Polygon Annotation

You can add polygon annotations to pages. A polygon is a shape that does not have to be symmetrical,
with sides comprised of straight lines. Each left mouse click defines the point of a corner (or node)
of the polygon. AppXtender Image Capture draws a figure by connecting each point created by a
left mouse click from the first point created to the last point created and back to the first point. The
nodes defining the polygon do not have to be in alignment. With the polygon feature, you can create
asymmetrical shape annotations with many sides.

To add a polygon annotation to a page:

1. Display the page to which you want to add a polygon annotation.
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2. Choose one of these options to activate the polygon annotation symbol:

¢ Select Annotate> New> Polygon from the Image Capture menu bar.
* Pressg.

3. Click where you want the polygon to start. This action creates the first node in the shape.

Figure 27. Example of a Polygon
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4. Move the pointer and click again where you want to set the endpoint for the first side of the
polygon. This endpoint is the next node in the shape. At this point, the shape appears as a
line between the two points.

5. Draw the next node in the polygon by moving the pointer and clicking the left mouse button
wherever the next node in the shape should be located. Lines stretch to this node from each of the
two existing nodes, creating a triangle. Continue to add nodes in the shape as needed. When
a new node is added, lines stretch from that node to the last node created and to the first node
created for the shape.

Note: To erase the polygon without adding it, you can right-click anywhere.
6. When the polygon is complete, double-click to add the annotation to the page.

7. Save the new annotation. Refer to Saving Annotations, page 143 for more information.

The polygon annotation and any other new annotations are saved to the image. When retrieved, the
image is displayed with the polygon annotation in the defined color and shape.

Note: You can change the properties of shape annotations after they have been added to a page. For
more information, see Modifying Annotation Settings, page 165.

For more information, see:

¢ Creating a Shape Annotation, page 155

Creating a Highlight Annotation

You can add highlight annotations to pages. A highlight annotation allows you to emphasize or
bring attention to a particular area of a page.

To add a highlight annotation to a page:

1. Display the page to which you want to add a highlight annotation.

2. Choose one of these options to activate the highlighter annotation symbol:

* Select Annotate> New> Highlight from the Image Capture menu bar.

e Press h.
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3. Drag the mouse pointer from a starting point to an end point. As you drag the pointer, a new
highlight annotation appears on the image.
4. Save the new annotation. Refer to Saving Annotations, page 143 for more information.

The highlight annotation and any other new annotations are saved to the image. When retrieved, the
image is displayed with the highlight annotation in the default highlight color of yellow, and the
defined shape.

Note: You can change the properties of highlight annotations after they have been added to a page.
For more information, see Modifying Annotation Settings, page 165.
For more information, see:

¢ Creating an Annotation, page 149

Rubber Stamp Annotations

Rubber Stamps are pre-defined annotations that can be used to describe certain events. For example,
you could have a rubber stamp that says "Added by Username on Date", where Username and
Date are populated by your name and the date you added the annotation. Some rubber stamps can
be composed of an image, so that you can place a signature or other relevant graphic on a page.
When you select a rubber stamp, AppXtender Image Capture places it on the page wherever you
click your mouse. You can move or delete a rubber stamp annotation, just as you can other types

of annotations, but cannot edit its properties.

Note: Rubber stamps must be added and configured by the AppXtender system administrator before
they are available for use. Also, only users with appropriate privileges can control the annotation
features. If rubber stamps have not been configured, or if you have questions about the privileges
assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to
the "Annotations" section of the ApplicationXtender Document Manager User’s Guide.

You can add rubber stamp annotations to pages in various ways. For information, see the following
topics:
¢ Adding a Rubber Stamp from the List of Most Recently Used Rubber Stamps, page 158

¢ Adding a Rubber Stamp from the Select Rubber Stamp Dialog Box, page 159

Adding a Rubber Stamp from the List of Most Recently
Used Rubber Stamps

You can select a rubber stamp from the Rubber Stamp drop-down menu. This menu contains a list of
up to 10 of the most recently used rubber stamps for the current application. Each menu item has an
icon displayed to its left to identify the type of stamp (text or image).

To add a rubber stamp annotation using the Rubber Stamp drop-down menu:

1. Display the page to which you want to add a rubber stamp annotation.

2. Click the arrow next to the Rubber Stamp Annotation button on the Annotation toolbar.
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Figure 28. Rubber Stamp Annotation Button
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The Rubber Stamp Annotation menu appears with up to 10 of the most recently used rubber
stamps for the current application and the More Rubber Stamps option.

Figure 29. Rubber Stamp Annotation Drop-Down Menu
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3. Select the appropriate rubber stamp from the menu. The Rubber Stamp annotation button is then
activated (the button appears in a lighter gray color), and the cursor changes to Rubber Stamp
mode.

Figure 30. Cursor in Rubber Stamp Mode
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4. Place your cursor where you want the rubber stamp to appear and click once. To add additional
copies of the rubber stamp, click wherever you want the rubber stamp to appear.

5. To deactivate the rubber stamp, click once on the Rubber Stamp button. The cursor returns to
its normal state.
For more information, see:

* Rubber Stamp Annotations, page 158Adding a Rubber Stamp from the Select Rubber Stamp
Dialog Box

Adding a Rubber Stamp from the Select Rubber Stamp
Dialog Box

The Select Rubber Stamp dialog box contains a list of up to 256 rubber stamps. The AppXtender
administrator can create more than 256 rubber stamps, but only 256 are returned and displayed in
the dialog box. Each menu item has an icon displayed to its left to identify the type of stamp (text
or image).

To add a rubber stamp annotation using the Select Rubber Stamp dialog box:

1. From the Annotate menu, select New and then Rubber Stamp. The Select Rubber Stamp dialog
box appears.
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Figure 31. Select Rubber Stamp Dialog Box
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2. From the Select Rubber Stamp dialog box, select the appropriate rubber stamp. The OK button
becomes available. Click OK. (To cancel the rubber stamp selection, click Cancel.)

3. The Rubber Stamp annotation button is then activated (the button appears in a lighter gray color),
and the cursor changes to Rubber Stamp mode.

Figure 32. Cursor in Rubber Stamp Mode
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4. Place your cursor where you want the rubber stamp to appear and click once. To add additional
copies of the rubber stamp, click wherever you want the rubber stamp to appear.

5. To deactivate the rubber stamp, click once on the Rubber Stamp button. The cursor returns to
its normal state.

For more information, see:

* Rubber Stamp Annotations, page 158

Overlapping Annotations

ApplicationXtender Image Capture allows you to place multiple annotations on one image. You
can overlap these annotations, extending one over the other. When a new annotation is created, it
is placed on the top "layer" of the page. Through tools on the Annotation toolbar, you can place an
annotation behind another annotation.

Note: When you draw a freehand annotation around an existing annotation on an page, you cannot
select the other annotation. For example, if you attempt to select an annotation that is "inside"

a freehand annotation, only the freehand annotation is selected. In addition, when a freehand
annotation crosses over another annotation, AppXtender Image Capture may not allow you to select
the other annotation.
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Note: AppXtender Image Capture can accurately pinpoint the exact hit for a simple shape annotation.
For example, if you click the lines or border of a line annotation or a non-fill rectangle, oval, or
rounded-rectangle, AppXtender Image Capture determines whether or not the mouse pointer hit the
simple shape annotation. However, since a freehand annotation is not a simple shape annotation,
AppXtender Image Capture uses a minimum rectangular area, which covers all the nodes of a
freehand annotation, to determine whether or not the mouse pointer hit the freehand annotation.

To move annotations to the front layer:

1. Select the annotations that you want to move to the front. For instructions, refer to Selecting
Annotations, page 165.
2. Choose one of these options to move the annotations:

e (lick the To Front button on the Annotation toolbar.
e Press Shift-semicolon (;).
To move the annotation to the back layer:

1. Select the annotations that you want to move to the back. For instructions, refer to Selecting
Annotations, page 165.

2. Choose one of these options to move the annotations:
¢ (lick the To Back button on the Annotation toolbar.

e Press semicolon (;).

For more information, see:

* Chapter 5, Annotations

Assigning an Annotation to an Annotation
Group

If your user or group account is a member of an annotation group, you might be able to assign an
annotation to that annotation group. For guidelines on which annotations should be assigned to each
annotation group, consult your AppXtender administrator.

After you assign an annotation to an annotation group, users who are not members of the annotation
group cannot view or modify the annotation. After you add a redaction to an annotation group, users
who are not members of the annotation group cannot hide or modify the redaction. Depending on
the options enabled for each user or group within the annotation group and depending on who
created the annotation or redaction, users who are members of the annotation group may be able

to view or view and modify annotations in the annotation group and hide or hide and modify
redactions in the annotation group.

Note: Only users with appropriate annotation group options can assign annotations to annotation

groups. If you have questions about the annotation group configuration of your AppXtender user

account, consult your AppXtender system administrator or refer to the Managing Security chapter
of the ApplicationXtender Administration Guide.

To assign an annotation to an annotation group:

1. Select the annotations that you want to assign to an annotation group. For instructions, see
Selecting Annotations, page 165.
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2. Right-click the selected annotations.

3. From the shortcut menu that appears, select Group Assignment. Another shortcut menu appears,
listing the annotation groups to which you can assign the currently selected annotations. (The
annotation groups that are listed depend on properties of the selected annotations.)

4. From the second shortcut menu, select the annotation group to which you want to assign the
annotation.
For more information, see:

¢ Chapter 5, Annotations

Showing or Hiding Annotations

It may be preferable for you to display or print pages without annotations. The following topics
describe how to do so:

* Hiding Annotations when Viewing Batches, page 162
¢ Hiding Annotations when Printing, page 164

For more information, see:

¢ Chapter 5, Annotations

Hiding Annotations when Viewing Batches

AppXtender Image Capture provides an option to show or hide all annotations provided you have
hide annotation privileges.

Note: Only users with appropriate privileges can hide annotations. Only users with appropriate
annotation group options can hide annotations that have been assigned to annotation groups. If

you have questions about the privileges assigned to your AppXtender user profile, or about the
annotation group configuration of your AppXtender user account, consult your AppXtender system
administrator or refer to the Managing Security chapter of the ApplicationXtender Administration Guide
To show all displayed annotations:

¢ Select Show from the Annotate menu to place a check mark next to the Show option on the menu.

To hide all displayed annotations:

* Select Show from the Annotate menu to remove the check mark from the Show option on the
menu.

For more information, see:

¢ Showing or Hiding Annotations, page 162
¢ Hiding Annotations by Annotation Group, page 163
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Hiding Annotations by Annotation Group

If your user or group account is a member of an annotation group, you might be able to hide all
annotations on a displayed page that have been assigned to that annotation group. For example, if
your user account has been configured with the View Annotations option in an annotation group
called ACCOUNTING, you can hide all unredacted annotations on a purchase order that have been
added to the ACCOUNTING annotation group.

Note: Only users with appropriate annotation group options can hide annotations that have been
assigned to annotation groups. If you have questions about the annotation group configuration
of your AppXtender user account, consult your AppXtender system administrator or refer to the
Managing Security chapter of the ApplicationXtender Administration Guide.

To show or hide annotations by annotation group:

1. From the Annotate menu, select Show Groups. The Show/hide Annotation Groups dialog box
appears.

Figure 33. Show/hide Annotation Groups Dialog Box
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2. Click the check box next to the name of the annotation group that you want to hide or show.

3.  When each annotation group that you want to hide has no check mark and each annotation group
that you want to show has a check mark, click OK. The annotations on the currently displayed
page are shown or hidden according to your selections.

For more information, see:

* Showing or Hiding Annotations, page 162

¢ Hiding Annotations when Viewing Batches, page 162

163



Annotations

Hiding Annotations when Printing

You can print a page or a region of an image without annotations. AppXtender Image Capture
provides an option on the Print dialog box to hide all annotations. The Print dialog box can be
accessed from the Page menu. In order to hide annotations when printing pages or regions from the
Page menu, the page must be displayed.

Note: Only users with appropriate privileges (including the Print privilege) can hide annotations
while printing. Only users with appropriate annotation group options can hide annotations that have
been assigned to annotation groups. If you have questions about the privileges assigned to your
AppXtender user profile, or about the annotation group configuration of your AppXtender user
account, consult your AppXtender system administrator or refer to the Managing Security chapter
of the ApplicationXtender Administration Guide.

To print a page with or without annotations:
1. Display the page you want to print. Select Print. The Print dialog box appears.
Figure 34. Print Dialog Box
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2. From the Print dialog box, you have the following options:

¢ To print the page without annotations, select the Hide annotations check box.
¢ To print the page with annotations, clear the Hide annotations check box.

3. Click OK to begin printing.

For more information, see:

¢ Showing or Hiding Annotations, page 162
* Printing or Faxing Pages and Regions, page 135
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Modifying Annotation Settings

The properties of an annotation can be modified after it has been applied or saved to an image.
You can alter the outline width, color, opacity, or fill of the annotation. For more information, see
the following topics:

* Selecting Annotations, page 165

* Moving Annotations, page 166

¢ Resizing an Annotation, page 167

* Modifying a Shape Annotation, page 167
* Modifying Text Annotations, page 169

Note: Only users with appropriate privileges can modify annotations. If you have questions about the
privileges assigned to your AppXtender user profile, consult your AppXtender system administrator
or refer to the Managing Security chapter of the ApplicationXtender Administration Guide.

Note: If the AppXtender system has been converted from the CM security provider to the Windows
security provider and you created and saved annotations while the CM security provider was in use,
you must have both the Global Annotations and Edit Annotations privileges assigned to your profile
in order to modify those annotations. If you have questions about the privileges assigned to your
AppXtender user profile, consult your AppXtender system administrator or refer to the Managing
Security chapter of the ApplicationXtender Administration Guide.

For instructions on editing text rubber stamp annotations, refer to the "Annotations" section of the
ApplicationXtender Document Manager User’s Guide.

Selecting Annotations

The following table describes the methods you can use to select annotations:

Table 26. Selecting Annotations

To Select Do This Button

One annotation Enable the Annotation Selection R,
button on the Annotation
toolbar. Click the annotation
that you want to modify.

An annotation that is behind Enable the Annotation Selection R,
another annotation button on the Annotation
toolbar. Click any annotation.
Press the [TAB] key until the
annotation that you want to
modify is selected.
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To Select

Do This

Multiple annotations

Enable the Annotation Selection k
button on the Annotation
toolbar. Click one of the
annotations that you want

to modify. While holding

the [SHIFT] key, click each
additional annotation that you
want to modify.

All annotations

Click the Select All button on ..
the Annotation toolbar.

Note: Press the spacebar to toggle between annotation selection mode and pan mode.

The appearance of each annotation changes to indicate that it is selected. For example, a selected text
annotation is enclosed in a gray frame, a selected arrow has a handle on each end, and a selected oval

is enclosed in both a gray frame and handles.

Figure 35. Selected and Unselected Annotations
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* Overlapping Annotations, page 160

e Assigning an Annotation to an Annotation Group, page 161

* Modifying Annotation Settings, page 165

¢ Deleting Annotations, page 172

Moving Annotations

You can use the mouse pointer to move a single annotation or multiple annotations together.

To move annotations:

1. Select the annotations that you want to move. For instructions, see Selecting Annotations,

page 165.
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2. Hold the pointer over the selected annotation or annotations. The pointer changes to crossed
double arrows.

3. Drag the annotation or annotations to a new location. Changes to the selected annotation or
annotations are reflected immediately.

4. Save your changes. Refer to Saving Annotations, page 143 for more information.
For more information, see:

* Modifying Annotation Settings, page 165

Resizing an Annotation

You can use the mouse pointer to resize any type of annotation, including text annotations created
with the in-place text editor.
To resize a single annotation:

1. Select the annotation that you want to resize. For instructions, see Selecting Annotations, page
165.

2. Hold the pointer over one of the handles on the selected annotation. The pointer changes to a
double arrow.

3. Drag the handle to a new location. Changes to the selected annotation are reflected immediately.

4. Save your changes. Refer to Saving Annotations, page 143 for more information.
For more information, see:

* Modifying Annotation Settings, page 165

Modifying a Shape Annotation

To modify a shape annotation:
1. Select the annotation. For instructions, see Selecting Annotations, page 165.

2. Right-click and select Properties from the shortcut menu. The Annotation Properties dialog
box appears.
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Figure 36. Annotation Properties Dialog Box
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The Annotation Properties dialog box provides information on the creation date, time, and user,
and the latest modification date, time, and user for the annotation. If the AppXtender system

is using the Windows security provider, the domain name is provided with each user name. If
the annotation has been assigned to an annotation group, the name of that annotation group is
also provided.

Note: There is no "fill" color for basic line annotations (for example, freehand, line, and arrow).
When you select a basic line annotation, the two overlapping rectangles appear with the same
color.

3. Change the properties of the annotation. The following table describes how to change each
property in the Annotation Properties dialog box:

Table 27. Changing the Properties of a Shape Annotation

To Change Do This

Opacity Next to Options, click Redaction.

Fill status Next to Options, click Filled.

Line color Under Colors, click a new color.

Fill color Under Colors, right-click a new color.
Line width Under Line Width, click a new line width.

4. Click Apply. Image Capture applies the new properties to the annotation.
5. Click OK to close the Annotation Properties dialog box.
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6. Save your changes. Refer to Saving Annotations, page 143 for more information.
For more information, see:

* Modifying Annotation Settings, page 165

Modifying Text Annotations

Image Capture allows you to modify the properties of a text annotation and annotation text.

For more information, refer to these topics:

¢ Changing the Properties of a Text Annotation, page 169
* Modifying Annotation Text, page 170

Changing the Properties of a Text Annotation

To change the properties of a text annotation:
1. Select the text annotation. For instructions, see Selecting Annotations, page 165.
2. Right-click and select Properties from the shortcut menu.

Note: Click the ellipses button (...) if the in-place text editor appears.

The Annotation Text Editor dialog box appears.

Figure 37. Annotation Text Editor Dialog Box
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3. Click Advanced. The advanced options appear.
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Figure 38. Annotation Text Editor Dialog Box: Advanced Options
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4. Change the properties of the annotation. The following table describes how to change each
property in the Annotation Text Editor dialog box:

Table 28. Changing the Properties of a Text Annotation

To Change

Do This

Display status

Click the Display as icon check box.

Font size

Under Font, in the Size text box, enter a value.

Font appearance

Under Font, click the check boxes that you
want to change (Bold, Underline, Italic, and
Strike out).

Outline status

Under Font, click the Transparent check box.

Text color

Under Colors, click a new color for the text.

Fill color

Under Colors, right-click a new fill color.

Note: Refer to Modifying Annotation Text, page 170 for more information.

5. Click OK. Changes to the selected annotation are reflected immediately.

6. Save your changes. Refer to Saving Annotations, page 143 for more information.

For more information, see:

* Modifying Annotation Settings, page 165

Modifying Annotation Text

To modify annotation text:

1. Select the text annotation. For instructions, refer to Selecting Annotations, page 165.
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2. Right-click and select Properties from the shortcut menu.
The Annotation Text Editor appears if it was used to create the annotation.

The in-place text editor appears if it was used to create the annotation.

Note: If the in-place text editor window is too small in the Document Display view, the
Annotation Text Editor appears after you select Properties from the shortcut menu.

3. Change the text.

4. Apply the new text:
¢ Click the green check mark if you changed the text in the in-place text editor.

e Click Apply if you changed the text in the Annotation Text Editor, and then click OK to
close the editor.

5. Save your changes. Refer to Saving Annotations, page 143 for more information.

Printing Text Annotations

You can print the contents of one or more text annotations.

Note: Only users with appropriate privileges can print text annotations. If you have questions
about the privileges assigned to your AppXtender user profile, consult your AppXtender system
administrator or refer to the "Managing Security" chapter of the ApplicationXtender Administration
Guide.

To print text annotations:

1. Select the text annotations that you want to print. For instructions, see Selecting Annotations,
page 165.

2. Right-click the selected annotations.

3. From the shortcut menu that appears, select Print text. The standard Windows Print dialog
box appears.

4. Click OK. The contents of the selected text annotations print.

For more information, see:

¢ Chapter 5, Annotations

Removing Annotations

You can remove annotations from a page by either erasing or deleting them.

Note: Only users with appropriate privileges can modify and delete annotations. If you have
questions about the privileges assigned to your AppXtender user profile, consult your AppXtender
system administrator or refer to the Managing Security chapter of the ApplicationXtender
Administration Guide.

Note: If the AppXtender system has been converted from the CM security provider to the Windows
security provider and you created and saved annotations while the CM security provider was in use,
you must have both the Global Annotations and Edit Annotations privileges assigned to your profile
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in order to modify and delete those annotations. If you have questions about the privileges assigned
to your AppXtender user profile, consult your AppXtender system administrator or refer to the
Managing Security chapter of the ApplicationXtender Administration Guide.

For more information on removing annotations, see the following topics:

¢ [Erasing Annotations, page 172

¢ Deleting Annotations, page 172

Erasing Annotations

You can use an eraser tool to remove a single annotation from the displayed image.

To erase an annotation:

1. Choose one of these options to activate the eraser tool:

* C(Click the Eraser button on the Annotation toolbar. The button is available only when the
displayed page contains an annotation.

Figure 39. Eraser Button
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2. Click the annotation that you want to remove. It is erased from the page.
For more information, see:

* Removing Annotations, page 171

Deleting Annotations

You can delete one or more annotations from a displayed image.

To delete annotations:

1. Select the annotations that you want to delete. For instructions, refer to Selecting Annotations,
page 165.

2. Choose one of these options:

* Right-click, then select Delete from the shortcut menu.

e Press x.
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For more information, see:

* Removing Annotations, page 171
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Chapter 6

Image Enhancement

This chapter describes how to use ApplicationXtender Image Capture image enhancement functions
to enhance bi-tonal (black and white) images.

® Introduction to Image Enhancement, page 175

¢ Configuring Automatic Enhancement, page 176
e Using Advanced De-skew, page 178

¢ Using Advanced Registration, page 181

* Using Advanced Dot Shading Removal, page 186
* Using Speck Removal, page 190

¢ Using Advanced Line Removal, page 193

¢ Using Advanced Inverse Text Correction, page 197
* Smoothing Characters, page 200

* Using Manual Crop, page 203

* Resizing an Image, page 206

¢ Using Advanced Sub Image, page 208

¢ Using IntelligentCrop, page 211

Introduction to Image Enhancement

ApplicationXtender Image Capture provides a licensed image enhancement utility that you can
use to enhance bi-tonal (black and white) images automatically as you scan them. With the image
enhancement utility, you can remove lines, realign, de-skew, and remove shading on AppXtender
Image Capture pages. Many of these options (de-skew, and horizontal and vertical registration) can
be used to make images more readable. If the batches that you scan in AppXtender Image Capture
will be processed using optical character recognition (OCR) in ApplicationXtender (AppXtender),
other options (line removal and inverse text correction) can be used to prepare pages for OCR.

Note:

e If annotations have been added to the image, the processed image appears without the
annotations, unless they are redactions or non-transparent text annotations

* You must purchase Image Enhancement licence. This is not bundled along with Image Capture.
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Configuring Automatic Enhancement

The image enhancement utility provides complete enhancement features for bi-tonal (black and
white) images. Image enhancement enables you to de-skew, change the margin alignment, remove
lines and specks, and convert inverse and shaded text to black text on a white background. These
functions can be used to prepare the images for OCR (in AppXtender), display, print, or fax. Refer
to Enabling Image Processing Options, page 69 for information on configuring AppXtender Image
Capture for image processing.

The settings for optimum bi-tonal image enhancement are built into AppXtender Image Capture as
defaults, but they can be changed to allow for exact specifications. The default parameters can be
reset at any time in the ScanFix Configuration dialog box (and in the ScanFix Advanced Settings
dialog box).

For more information, see:

¢ Chapter 6, Image Enhancement
* Enabling Automatic Enhancement, page 176
¢ Customizing Enhancement Configuration, page 176

* Resetting Image Enhancement Settings to Default, page 178

Enabling Automatic Enhancement

AppXtender Image Capture allows you to automatically enhance pages as they are being scanned. If
the pages that you are scanning will be processed using optical character recognition (OCR) in
AppXtender, this feature can make the OCR more accurate. Automatic enhancement applies all
settings configured in the ScanFix Configuration dialog box and the ScanFix Advanced settings
dialog box. Automatic enhancement applies to bi-tonal (black and white) images only. Refer to
Enabling Image Processing Options, page 69 for information on configuring AppXtender Image
Capture for image processing.

To enable or disable automatic enhancement:

* From the Scan menu, select Configuration and then Auto Enhancement. The automatic
enhancement feature toggles on or off.

Customizing Enhancement Configuration

When automatic enhancement is enabled, all bi-tonal images scanned into AppXtender Image
Capture are enhanced using the configured enhancement settings. The effectiveness of this feature
for improving OCR processing of scanned images in AppXtender depends entirely on how you
configure image enhancement settings.
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To customize image enhancement configuration:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix
Configuration dialog box appears.

Figure 40. ScanFix Configuration Dialog Box
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2. Enable the check boxes of the image enhancement options that you want to use. All enhancement
options that are checked are executed when the displayed page is processed.

The following table explains each image enhancement option.

Table 29. Enhancement Options

Enhancement Options Explanation
Image de-skew Straightens skewed (crooked) images.
Inverse text correction Detects areas of inverse text and converts the

text into normal text.

Dot shading removal Removes speck or dot shading from an image.
Sub image Processes only specified area of an image.
Horizontal registration Aligns the image with a consistent left margin.
Vertical registration Aligns the image with a consistent top margin.
Horizontal line removal Removes horizontal lines from an image.
Vertical line removal Removes vertical lines from an image.

Note: You can also view explanations for each option by moving the pointer over the options. As
the mouse pointer moves over the options listed, explanatory messages appear as tool tips.

Additional settings for each enhancement option are available to produce the desired results.
These settings are accessed by clicking the Advanced button in the ScanFix Configuration
dialog box. Details on each page of the ScanFix Advanced Settings dialog box are provided in
the following topics.

¢ Using Advanced De-skew, page 178
¢ Using Advanced Registration, page 181
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* Using Advanced Dot Shading Removal, page 186
* Using Speck Removal, page 190
¢ Using Advanced Line Removal, page 193
¢ Using Advanced Inverse Text Correction, page 197
* Smoothing Characters, page 200
¢ Using Manual Crop, page 203
¢ Resizing an Image, page 206
* Using Advanced Sub Image, page 208
¢ Using IntelligentCrop, page 211
3. Click OK.

For more information, see:

¢ Configuring Automatic Enhancement, page 176

Resetting Image Enhancement Settings to Default

The settings for optimum bi-tonal image enhancement are built into AppXtender Image Capture as
defaults, but they can be changed to allow for exact specifications. The default parameters in the
ScanFix Configuration dialog box (and in the ScanFix Advanced Settings dialog box) can be reset at
any time.

To configure image enhancement using system default settings:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix
Configuration dialog box appears.

2. Click Reset.
3. Click OK.

For more information, see:

¢ Configuring Automatic Enhancement, page 176

Using Advanced De-skew

Skew refers to how much rotation the text has in relation to a horizontal reference line. An image that
is not perfectly square is considered "skewed." Visually, an image with positive skew rises from left to
right across a page. An image with negative skew slants downward from left to right across a page.

The Image de-skew option automatically straightens images that are skewed when you scan them
into AppXtender Image Capture. If the batches that you scan in AppXtender Image Capture will

be processed using optical character recognition (OCR) in AppXtender, the Image de-skew option
can be an integral tool in preparation for OCR because a 1% or 2% skew may cause an increase in
OCR errors as many OCR engines fail to recognize characters. Other applications for de-skew include
document imaging, forms processing, digital copying, faxing, and image file compression. The
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process is invaluable for applications that require precise and consistent placement of text, such as
forms processing and the intelligent OCR of columnar data. De-skewing an image can also improve
the performance of compression.

The Image de-skew option handles a maximum skew of 20%. A character protection feature
eliminates rotational distortion induced in the straightening process, using text and horizontal lines
to automatically detect and remove skew from an image.

When enabled, the De-skew feature optimizes the other image enhancing functions. It is advised that
you turn on this feature. The de-skew process changes the width and height of an image.
To perform advanced de-skew on an image:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix
Configuration dialog box appears.

2. Enable the Image de-skew option. Click Advanced. The ScanFix Advanced Settings dialog
box appears, with the Deskew tab forward.

Figure 41. Deskew Tab
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3. If necessary, modify the settings on the Deskew tab. The following topics describe each setting:

* Minimum Detect Length, page 180
* Maximum Acceptable Skew, page 181
¢ Character Protection, page 181
4. In the ScanFix Advanced Settings dialog box, click OK.

5. In the ScanFix Configuration dialog box, click OK to save the settings. (Any settings saved
become the defaults.) The next time you scan a new batch or page into AppXtender Image
Capture, each image is automatically de-skewed and appears in the Batch Display view.

The following figure compares two examples of scanned images. The example image on the left is
slightly skewed. The example image on the right has been de-skewed.

Figure 42. Using Deskew
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For more information, see:

¢ Chapter 6, Image Enhancement

Minimum Detect Length

This parameter sets the shortest line (text or graphics) AppXtender Image Capture uses to detect
skew. This measurement is in pixels. The default setting for Minimum Detect Length is 300 (1 inch at
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300 DPI). This value should be at least 25% larger than Maximum Acceptable Skew. If a report of
Failure to Detect Skew appears, decrease this value and reprocess the image.

For more information, see:

¢ Using Advanced De-skew, page 178

Maximum Acceptable Skew

This parameter determines how much skew is acceptable. When AppXtender Image Capture
encounters an image skewed less than this value, it omits the De-Skew process. Using a higher value
here causes AppXtender Image Capture to process images with a lower percentage skew. If you set
this to a lower value, lightly skewed images are accepted without de-skewing them. The default
setting is 200. Lower numbers indicate greater skew.

Note: A setting of 100 corresponds to 1% skew, while a setting of 200 corresponds to 0.5% skew.
Many OCR engines (such as those available in AppXtender) can handle a lightly skewed image, so
high values for Maximum Acceptable Skew might not improve performance.

For more information, see:

¢ Using Advanced De-skew, page 178

Character Protection

This feature automaticallyremoves rotational distortion from the de-skewed characters, because
de-skewing an image often distorts text characters. Checking the box activates character protection.
Character protection provides improved OCR results (such as in AppXtender) and a more attractive
image, but is considerably slower than de-skew alone. It is a trade-off between speed and OCR
accuracy. Because this feature can dramatically increase processing time, it is recommended that the
user leave it off unless the OCR error rate is unacceptable.

For more information, see:

¢ Using Advanced De-skew, page 178

Using Advanced Registration

Registration allows you to specify how far from the edge of an image you want the image data
placed. AppXtender Image Capture can automatically register an image in both the horizontal and
vertical planes. The process is accurate and consistent to within 3 or 4 pixels. On a 300 DPI image,
AppXtender Image Capture can position data within 1/100 of an inch. Registration automatically
positions text horizontally and vertically on the page, providing a consistent left and top margin for
pages. If the batches that you scan in AppXtender Image Capture will be processed using optical
character recognition (OCR) in AppXtender, registration control is helpful because it makes OCR
zoning of text fields in forms much more reliable.
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To perform advanced registration on an image:

1.

182

From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix
Configuration dialog box appears.

Enable the Image de-skew option, unless you know the original is perfectly straight.

Enable the Horizontal registration option, the Vertical registration option, or both, depending on
the level of precision that you need.

You can activate and set the parameters for horizontal and vertical registration separately. For
most operations where you require a consistent left margin, you should activate horizontal
registration. In many cases, you can leave vertical registration deactivated. For applications where
precise text location is important, you should activate both horizontal and vertical registration.

Click Advanced. The ScanFix Advanced Settings dialog box appears.
Click the Registration tab.

Figure 43. Registration Tab
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6. If necessary, modify the settings on the Registration tab. The following topics describe each

setting:
* Horizontal/Vertical Registration, page 184

* Advanced Registration Settings, page 185

7. In the ScanFix Advanced Settings dialog box, click OK.

8. In the ScanFix Configuration dialog box, click OK to save the settings. (Any settings saved
become the defaults.) The next time you scan a new batch or page into AppXtender Image
Capture, each image is automatically repositioned and appears in the Batch Display view.

The following figure compares two examples of scanned images. The example image on the left has
a narrow left margin and a slightly thicker top margin. The example image on the right has been

repositioned using registration. (Notice the thicker left and top margins.)

Figure 44. Using Registration
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For more information, see:

¢ Chapter 6, Image Enhancement

Horizontal/Vertical Registration

Using horizontal registration settings, AppXtender Image Capture locates the left edge of the text and
positions the left edge of the image a specified number of pixels from the left edge of text (or data).
Using vertical registration settings, AppXtender Image Capture locates the topmost edge of the text,
and positions it a fixed distance from the top edge of the image.

Note: If you are designing a form for later processing, a black line 1/16" thick across the top and a 1/8"
thick line down the left edge provide reliable registration when you use Find Line for Register.

For more information, see:

¢ Using Advanced Registration, page 181
¢ Central Focus, page 184

* Add Only, page 184

¢ Ignore Holes, page 184

* Resultant Left/Top Margin, page 185

* Find Line for Register, page 185

Central Focus

This feature causes AppXtender Image Capture to register using only the middle portion of the image
border. Central Focus is useful for ignoring edge noise, letterheads, and logos.

Add Only

This feature causes expansion of the current margin (if it is smaller than the specified amount) to
the size specified in the resultant left or top margin parameters.

Ignore Holes

Check this box to ignore binder holes and other left-edge noise when analyzing the margin. Leave
this feature off unless you have holes or similar noise to avoid. This feature applies only to horizontal
registration.
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Resultant Left/Top Margin

This parameter determines how many pixels remain as a left or top margin after processing. Setting
this value to 0 places text flush with the left or top edge of the image. A negative value crops the
specified number of pixels from the left or top edge of the text.

Find Line for Register

This is a powerful feature for precise registration on forms, especially on forms with edge noise.
Instead of using what it believes to be the edge of the text, AppXtender Image Capture instead
positions the text in the image based on the position of a vertical line. This line should be significantly
larger than any text characters (in particular, those characters to the left of this line). Therefore, set
this parameter to a value larger than the height of characters but less than the length of this line.
Setting the value to 0 deactivates this feature.

Advanced Registration Settings

Registration parameters for Horizontal and Vertical Registration are identical. The only difference is
the orientation. Horizontal parameters refer to the left edge of an image, while vertical parameters
deal with the top edge. The vertical adjustmentfeatures allow you to control alignment of the image
in the vertical plane.

The advanced features of the Registration process are located in the lower left corner of the
Registration tab. The Advanced settings give you finer control over image registration, augmenting
the find line to register parameters previously described. The registration skip parameters apply to
both normal registration and registration to line.

For more information, see:

¢ Using Advanced Registration, page 181
¢ Line Gap, page 185

¢ Line Thickness, page 186

* Registration Skip, page 186

Line Gap

Line Gap values under 3 short gaps are ignored. However, setting these values over 3 reassembles
broken lines into a whole line for registration purposes, and can dramatically improve success rate
with the registration feature.
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Line Thickness

AppXtender Image Capture scans across or down an image looking for lines. In some cases,
AppXtender Image Capture can mistake dense text for a line. These parameters allow you to select
the maximum line thickness as lower than the width of the text.

Registration Skip

Registration skip allows you to skip a number of scan lines before starting to look for valid information
for registration. The skip feature is valuable for dealing with unwanted data on the edge of an image.
In some cases, you may want to skip over a form line or margin note that is seen as valid data. In
other cases, this feature can be useful to skip over scanner artifacts that look like lines and data.

Using Advanced Dot Shading Removal

To simulate shades of gray, most black and white printers use dithering, also known as dot shading,
to give the impression of gray shading. Some black and white scanners also use this technique
when they scan color or grayscale images. AppXtender Image Capture can automatically detect and
remove dot-shaded regions from the image, leaving any text inside the dot-shaded regions intact.
The noise removal features allow you to remove dot shading, or ‘dithered” areas of an image, without
degrading text.

If the batches that you scan in AppXtender Image Capture will be processed using optical character
recognition (OCR) in AppXtender, consider using the shade removal feature to automatically remove
dot shading from an image. This allows shaded text to be recognized as text (not as graphics), which
increases OCR performance in AppXtender. Shade removal also enhances the compressibility of
image files containing heavily shaded areas by 50% or more, handling a wide range of dot sizes.

To perform advanced dot shading removal on an image:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix
Configuration dialog box appears.

2. Enable the Dot shading removal option. Click Advanced. The ScanFix Advanced Settings
dialog box appears.

3. Click the Noise Removal tab.

4. If necessary, modify the Dot Shading Removal settings on the Noise Removal tab. The following
topics describe each setting:

* Minimum Area Width, page 188
¢ Minimum Area Height, page 188
® Horizontal Size Adjust, page 189
® Vertical Size Adjust, page 189
e Maximum Dot Size, page 189

¢ Character Protection, page 181

186



Image Enhancement

Figure 45. Noise Removal Tab
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5. In the ScanFix Advanced Settings dialog box, click OK.

6. In the ScanFix Configuration dialog box, click OK to save the settings. (Any settings saved
become the defaults.) The next time you scan a new batch or page into AppXtender Image
Capture, dot shading is automatically removed from each image. Each enhanced image appears
in the Batch Display view.

The following figure compares two examples of scanned images. The example image on the left has
dot shading (highlighting "1968 Cadillac,” "1969 Cadillac," and "1970 Cadillac") that needs to be
removed. The dot shading in the example image on the right has been removed.
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Figure 46. Using Dot Shading Removal
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For more information, see:

¢ Chapter 6, Image Enhancement

Minimum Area Width

This parameter determines the smallest horizontal width of any shaded areas to be processed. The
default setting is 100 pixels. Set this value higher to reduce errors.

For more information, see:

¢ Using Advanced Dot Shading Removal, page 186

Minimum Area Height

This parameter controls the smallest expected vertical thickness of any shaded area. The default

setting is 50 pixels. Set this value higher to detect thicker shaded areas and decrease this value
to detect shorter dot shaded zones.
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For more information, see:

¢ Using Advanced Dot Shading Removal, page 186

Horizontal Size Adjust

This parameter controls the width of specks to be removed. The default setting is 0. Set the value to
1 if specks remain after automated processing; this removes specks that are 1 pixel wider than the
size designated in the Maximum Dot setting. Set the value to -1 if the text is being degraded. This
decreases the width of the specks being removed by 1 pixel, sparing small text.

For more information, see:

* Using Advanced Dot Shading Removal, page 186

Vertical Size Adjust

This parameter controls the height of specks to be removed. The default setting is 0. Set the value to
1 if specks remain after the automated process; this removes specks that are 1 pixel taller than the
size set in Maximum Dot setting. Set the value to -1 if the text is being degraded. This decreases the
height of the specks being removed by 1 pixel, sparing small text.

For more information, see:

* Using Advanced Dot Shading Removal, page 186

Maximum Dot Size

This setting determines the maximum size of individual dots that make up the dot shading. This
determines the removal of dots up to, and including this size. The default value is 5 pixels.

For more information, see:

* Using Advanced Dot Shading Removal, page 186

Character Protection

This feature automaticallyremoves rotational distortion from the de-skewed characters, because
de-skewing an image often distorts text characters. The options described in the following table allow
you to select character protection with dot shading removal.

You can protect against horizontal cuts, vertical cuts, or cuts in both directions. This feature is more
effective on horizontal and vertical segments of characters than it is on their diagonal segments.
This feature may also preserve dots that touch letters. If the batches that you scan in AppXtender
Image Capture will be processed using optical character recognition (OCR) in AppXtender, this
feature may improve OCR results.
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Table 30. Character Protection Options

Option

Description

None

Select none in most cases as this feature
dramatically increases processing time.

Horizontal cuts

Select the horizontal cuts button to protect
character segments horizontally.

Vertical cuts

Select the Vertical cuts button to protect
character segments vertically.

All cuts

Select All cuts and character segments running
both directions are protected.

For more information, see:

¢ Using Advanced Dot Shading Removal, page 186

Using Speck Removal

De-speck allows you to remove random horizontal and/or vertical specks (noise) from the image

without degrading text.

To perform speck removal on an image:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix

Configuration dialog box appears.

2. Click Advanced. The ScanFix Advanced Settings dialog box appears.

3. Click the Noise Removal tab.
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Figure 47. Noise Removal Tab
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4. If necessary, modify the De-Speck settings on the Noise Removal tab. The following topics
describe each De-Speck setting:

* Horizontal De-Speck, page 192
e Vertical De-Speck, page 192
¢ Isolated De-Speck, page 193
5. In the ScanFix Advanced Settings dialog box, click OK.

6. In the ScanFix Configuration dialog box, click OK to save the settings. (Any settings saved
become the defaults.) The next time you scan a new batch or page into AppXtender Image
Capture, specks are automatically removed from each image. Each enhanced image appears
in the Batch Display view.

The following figure compares two examples of scanned images. The example image on the left has a
speck (above and to the right of "Fleetwood") that needs to be removed. In the example image on the
right, the speck has been removed.
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Figure 48. Using De-Speck

(Fleetwood) | | (Fleetwood)
od) . . . . Jvod) . . . ..

For more information, see:

¢ Chapter 6, Image Enhancement

Horizontal De-Speck

This parameter sets the maximum horizontal size for de-speck, determining the width of specks to be
removed. The default setting is 0. Slide the bar right to remove wider specks and slide the bar left
to decrease erroneous text removal.

For more information, see:

¢ Using Speck Removal, page 190

* Horizontal Protection, page 192

Horizontal Protection

Checking the Horizontal Protection box makes AppXtender Image Capture check the vertical plane
to determine if the pixel group in question is part of a character.

Vertical De-Speck

This parameter controls the maximum vertical size for de-speck; the height of specks to be removed.
Increase this value to remove larger (taller) specks and decrease to prevent erroneous text removal.
Setting this value too high can remove small vertical sections of characters.

For more information, see:

* Using Speck Removal, page 190

* Vertical Protection, page 193
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Vertical Protection

Checking the Vertical Protection box makes AppXtender Image Capture check the vertical plane to
determine if the pixel group in question is part of a character.

Isolated De-Speck

This feature removes specks that are not touching anything else in the image. Larger values can cause
AppXtender Image Capture to remove periods and the dots on the letters i and j. Isolated de-speck is
faster than using both horizontal and vertical de-speck.

In the Isolated De-Speck text box, enter a number. The value given sets the largest dimension for a
speck in any direction. Press the [TAB] keyand the advanced features become activated.

The Advanced Features area of the Noise Removal tab only applies to the Isolated De-Speck feature.
The following table describes the options in the Advanced Features area:

Table 31. Isolated De-Speck Options

Option Description

De-Speck Width The width parameter allows you to set different
values for the height and width of a speck.

The value set in isolated de-speck becomes the
height, and the value given here becomes the
width. Essentially, this makes a box a rectangle
and de-speck removes any speck that fits within
the rectangle.

Diagonal Protection In normal processing, the four pixels above,
below, and to either side of a suspected speck are
looked at. With this mode active, AppXtender
Image Capture looks at the four corners as
well. Use this feature only when you find that
the diagonal portion of text characters is being
removed.

For more information, see:

¢ Using Speck Removal, page 190

Using Advanced Line Removal

Line removal settings remove horizontal and/or vertical lines from an image. If the batches that you
scan in AppXtender Image Capture will be processed using optical character recognition (OCR) in
AppXtender, removing lines increases the accuracy of the OCR process. AppXtender Image Capture
automatically detects and removes horizontal or vertical lines — even the most degraded lines (under
the Maximum Line Gap parameter).
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With the Advanced Character Repair feature, the accuracy of OCR improves greatly with difficult
documents, such as typed forms and those with underlined words. You can activate horizontal

line management separately from vertical line settings with independent parameters. Other than
orientation, these features are identical.

Note: If line removal removes large text, you have several options. You can estimate the thickness of
the horizontal segments of the largest text characters in the image, and set maximum line thickness to
some value lower than that thickness. Another option is to set horizontal minimum line values to
larger than the length of the longest horizontal segments of the largest text characters. Conversely, set
vertical line management values higher than the longest vertical segment.

To perform advanced line removal on an image:

1.
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Click the Line Removal tab.

Figure 49. Line Removal Tab
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4. If necessary, modify the settings on the Line Removal tab. The following topics describe each
setting:
* Minimum Line Length, page 196
¢ Maximum Line Thickness, page 196
¢ Maximum Line Gap, page 196
* Edge Cleaning, page 196
¢ Character Repair, page 197
5. In the ScanFix Advanced Settings dialog box, click OK.

6. In the ScanFix Configuration dialog box, click OK to save the settings. (Any settings saved
become the defaults.) The next time you scan a new batch or page into AppXtender Image
Capture, horizontal and vertical lines are automatically removed from each image. Each
enhanced image appears in the Batch Display view.

The following figure compares two examples of scanned images. The example image on the left has
a thick line along the right side that needs to be removed. In the example image on the right, the
thick line has been removed.

Figure 50. Using Vertical Line Removal
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For more information, see:

¢ Chapter 6, Image Enhancement

Minimum Line Length

This parameter sets the minimum length of a line to detect and remove from the image. The line
removal system can identify and remove very short horizontal lines, such as the one across a large
capital T. The default setting is 150 horizontal pixels (1/2 inch at 300 DPI) and 150 vertical pixels.
For more information, see:

* Using Speck Removal, page 190

Maximum Line Thickness

This parameter sets the thickness of a line for the system to detect. Some images have short graphic
lines that you want to remove and large text characters you want to preserve. Because extremely large
text is usually thicker than the lines on forms, you can use this feature to keep AppXtender Image
Capture from removing very large text in titles. The horizontal and vertical default setting is 20 pixels.

Note: The capital "I" in a large title or headline has horizontal and vertical components that could be
mistaken for lines and that could be removed. To avoid unintentional line removal, set the maximum
line thickness parameter to a smaller value (like 10). You may also set minimum line thickness to be
longer than the widest text.

For more information, see:

* Using Speck Removal, page 190

Maximum Line Gap

This parameter sets the maximum size of a gap allowed in a line. This assures complete removal
of lines containing gaps. The default setting is 1 pixel for both horizontal and vertical and works
well for most clean images.
For more information, see:

* Using Speck Removal, page 190

Edge Cleaning

Noise near a line is removed along with the line; this feature determines how far AppXtender Image
Capture looks for stray pixels near a line. The default setting is 2. Set this value to 3 or 4 if unwanted
line shadow remnants remain, or 0 or 1 if adjacent text is degraded. The Character Repair feature
can often repair text damaged by line removal.
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For more information, see:

¢ Using Speck Removal, page 190

Character Repair

This parameter sets the maximum width or height, in pixels, of characters to reconstruct after the
line removal is performed. The default setting is 20 pixels. Set this parameter higher if text is not
being adequately repaired and lower if unintentional reconstruction occurs. Setting this value to
0 disables character reconstruction.

Note: When you disable Character Repair, you may want to set the Edge Cleaning factor lower than 2
(the default) if line removal is damaging characters.

For more information, see:

* Using Speck Removal, page 190

Using Advanced Inverse Text Correction

Inverse text detects white text with a black background (inverse text) and converts it to black text
with a white background (normal text). If the batches that you scan in AppXtender Image Capture
will be processed using optical character recognition (OCR) in AppXtender, this feature can be used
to prepare images for the OCR, which cannot read inverse text.

To perform advanced inverse text correction on an image:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix
Configuration dialog box appears.

2. Enable the Inverse text correction option. Click Advanced. The ScanFix Advanced Settings
dialog box appears.

3. Click the Inverse Text tab.
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Figure 51. Inverse Text Tab
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4. Ifnecessary, modify the settings on the Inverse Text tab. The following table describes each setting:
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Table 32. Inverse Text Settings

Setting

Description

Minimum Area Height

This parameter controls the smallest vertical
thickness of inverse text areas. The default
setting is 50 pixels. Decrease this value if small
areas of inverse text are missed or increase this
value if normal text is treated as inverse.

Minimum Area Width

This parameter controls the smallest horizontal
width of inverse text areas. The default setting
is 300 pixels. Decrease this value if small
bands of inverse text are missed or increase
this value if normal text is treated as inverse.

Minimum Black On Edges

This parameter controls the smallest horizontal
distance between the edge of an inverse text
area and the inverse text itself. The default
setting is 10 pixels. Decrease this value if small
areas of inverse text are missed or increase this
value if normal text is treated as inverse.

5. In the ScanFix Advanced Settings dialog box, click OK.

6. In the ScanFix Configuration dialog box, click OK to save the settings. (Any settings saved
become the defaults.) The next time you scan a new batch or page into AppXtender Image
Capture, inverse text on each image is automatically converted to normal text. Each enhanced

image appears in the Batch Display view.

The following figure compares two examples of scanned images. The example image on the left
has inverse text that needs to be corrected. In the example image on the right, the inverse text has

been corrected.
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Figure 52. Using Inverse Text Correction
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For more information, see:

¢ Chapter 6, Image Enhancement

Smoothing Characters

Smoothing characters involves growing and eroding characters in an image and then using "sand" or
"fill" operations to produce a finished look. Dot matrix print becomes readable using this setting.
This feature allows for de-emphasizing bold text, bringing out faint text, and smoothing out the

jagged edges of text.

To smooth characters in an image:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix

Configuration dialog box appears.

2. Click Advanced. The ScanFix Advanced Settings dialog box appears.

3. Click the Smooth tab.
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Figure 53. Smooth Tab
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4. If necessary, modify the settings on the Smooth tab. The following table describes each setting:
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Table 33. Smooth Settings

Setting Description

Grow This feature makes single pixels "grow" into
small dots, and expands the borders of text
characters. It is very useful for making a font
bolder and has the affect of "connecting the
dots" of dot matrix print. Lower this value
if characters start touching one another or
integral spaces in letters close up.

Erode This feature looks at groups of black pixels
and removes the outer edges. This has the
effect of making a speck or text character
"shrink" by selected value. Setting this value
to 2 erodes a 3 by 3 block of pixels to a single
central pixel, or makes a 2 by 2 block of black
pixels disappear entirely. Negative values are
not allowed with this feature.

Sand and Fill This feature improves an image’s appearance
by smoothing out the edges of characters. It
does this by filling small pits and removing
small bumps on the edges of characters. Sand
and fill options reduces its compressed image
file size. Use larger values (from 1 to 5) for
larger type size, pits and bumps.

5. In the ScanFix Advanced Settings dialog box, click OK.

6. In the ScanFix Configuration dialog box, click OK to save the settings. (Any settings saved
become the defaults.) The next time you scan a new batch or page into AppXtender Image
Capture, characters on each image are automatically smoothed. Each enhanced image appears
in the Batch Display view.

The following figure compares two examples of scanned images. The example image on the left has
text that needs to be smoothed. The text in the example image on the right has been smoothed
with the Grow option.
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Figure 54. Smoothing Characters
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For more information, see:

¢ Chapter 6, Image Enhancement

Using Manual Crop

Manual crop resizes an image by adding or removing a specified number of pixels from the image

in the selected directions. This feature does not alter the image resolution. Only when values are

entered into the crop text boxes do the pad text boxes become enabled.

To crop an image manually:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix

Configuration dialog box appears.

2. Click Advanced. The ScanFix Advanced Settings dialog box appears.

3. Click the Crop tab.
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Figure 55. Crop Tab
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4. If necessary, modify the Manual Crop settings on the Crop tab.

The following table describes each setting;:
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Table 34. Manual Crop Settings

Setting

Description

Top Crop/Pad

Removes the specified number of pixels from
the top edge of the image. The manual crop
function starts at the edge of the image and
ignores image data. Pad adds the specified
number of pixels (the value in top crop) to the
top edge of the image.

Bottom Crop/Pad

Removes the specified number of pixels from
the bottom edge of the image. This parameter
can help remove unwanted noise from an
image, or unwanted footer information. The
bottom pad adds the specified number (from
the bottom crop value) of pixels to the bottom
edge of the image.

Left Crop/Pad

Removes the specified number of pixels from
the left edge of the image. Left pad adds the
specified number of pixels (in left crop) to the
left edge of the image.

Right Crop/Pad

Removes the specified number of pixels from
the right edge of the image. Right pad adds
the specified number (from the right crop
setting) of pixels to the right edge of the image.

5. In the ScanFix Advanced Settings dialog box, click OK.

6. In the ScanFix Configuration dialog box, click OK to save the settings. (Any settings saved
become the defaults.) The next time you scan a new batch or page into AppXtender Image
Capture, the specified areas of each image are automatically cropped from the image. Each
enhanced image appears in the Batch Display view.

The following figure compares two examples of scanned images. The example image on the left has
areas that need to be cropped out. The example image on the right has been cropped.

205



Image Enhancement

Figure 56. Using Manual Crop
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For more information, see:

¢ Chapter 6, Image Enhancement

Resizing an Image

AppXtender Image Capture can alter the size of an image to user-defined dimensions. This feature
does not change the resolution (DPI) of the image, but it compresses or expands the image data to
match the new image size.

To resize an image:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix
Configuration dialog box appears.

2. Click Advanced. The ScanFix Advanced Settings dialog box appears.
3. Click Crop tab.
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4.

Figure 57. Crop Tab
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If necessary, modify the Resize settings on the Crop tab. The following table describes each setting:

Table 35. Resize Settings

Setting Description

Resultant Width Sets the output width of the image and
magnifies or shrinks the image to this width.

Resultant Height Sets the output height of the image and
magnifies or shrinks the image to this height.

In the ScanFix Advanced Settings dialog box, click OK.

In the ScanFix Configuration dialog box, click OK to save the settings. (Any settings saved
become the defaults.) The next time you scan a new batch or page into AppXtender Image
Capture, each image is automatically resized and appears in the Batch Display view.

The following figure compares two examples of scanned images. The example image on the left needs
to be resized. The example image on the right has been resized.
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Figure 58. Resizing an Image
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For more information, see:

* Chapter 6, Image Enhancement

Using Advanced Sub Image

This feature allows you to isolate a specified area from an image, called a Sub-Image. This extraction
occurs after de-skew and register, but before any other processing. The sub-image is then processed
with all other active features after discarding all remaining parts of the image.

To enhance a sub image of an image:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix
Configuration dialog box appears.

2. Enable the Image de-skew option and the registration options.

* For information on the Image de-skew option, see Using Advanced De-skew, page 178.
e For information on the registration options, see Using Advanced Registration, page 181.

3. Enable the Sub image option and any other options for enhancements that you want to perform
on the sub-image.

4. Click Advanced. The ScanFix Advanced Settings dialog box appears.
5. Click the Crop tab.

208



Image Enhancement

Figure 59. Crop Tab
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6. If necessary, modify the Sub-Image settings on the Crop tab. The following topics describe
each setting:

Top Edge, page 210
Bottom Edge, page 210
Left Edge, page 211
Right Edge, page 211

7. Configure other tabs, if necessary, to perform enhancements on the sub-image.

8. In the ScanFix Advanced Settings dialog box, click OK.

9. In the ScanFix Configuration dialog box, click OK to save the settings. (Any settings saved
become the defaults.) The next time you scan a new batch or page into AppXtender Image
Capture, for each image, AppXtender Image Capture automatically performs deskew and

registration on the whole image, and then performs all other configured enhancements on the

sub-image. Each enhanced image appears in the Batch Display view.

The following figure compares two examples of scanned images. The example scanned image on

the right is a sub image of the example scanned image on the left.
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Figure 60. Using Sub Image
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For more information, see:

* Chapter 6, Image Enhancement

Top Edge

This value defines the top edge of sub-image to extract, measured in pixels from the top of the image
after performing de-skew and registration. Use 0 to start from the very top of the image.

For more information, see:

¢ Using Advanced Sub Image, page 208

Bottom Edge

This value defines the bottom edge of the sub-image to extract, measured in pixels from the top of the
image after de-skew and registration. Use 0 to signify the very bottom of the image.
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For more information, see:

¢ Using Advanced Sub Image, page 208

Left Edge

This defines the bottom edge of the sub-image to extract, measured in pixels from the left edge of the
image after processing de-skew and registration. Use 0 to start from the left edge of the image.

Note: Try using 1275 (4.25 inches at 300 DPI) to crop the left half of a typical 8.5 inch by 11 inch page.

For more information, see:

¢ Using Advanced Sub Image, page 208

Right Edge

This value sets the right edge of the sub-image to separate, measured in pixels from the left edge of
the image after processing de-skew and registration. Use 0 to signify the image’s right edge.

Note: Try using 1275 (4.25 inches at 300 DPI) to crop the right half of a typical 8.5 inch by 11 inch page.

For more information, see:

¢ Using Advanced Sub Image, page 208

Using IntelligentCrop

This option allows bleaching out black or shaded borders. Intelligent crop performs image analysis to
determine where the edge of the data lies in relation to the edge of the image, automaticallycropping
the image to leave behind only the data you require.

To crop an image with IntelligentCrop:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix
Configuration dialog box appears.

2. Click Advanced. The ScanFix Advanced Settings dialog box appears.
3. Click the Crop tab.

21



Image Enhancement

Figure 61. Crop Tab
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4. If necessary, modify the IntelligentCrop settings on the Crop tab. The following table describes
each setting:
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Table 36. IntelligentCrop Settings

Setting

Description

Black Crop

This feature detects black border around an
image’s perimeter resulting from scanning
or other input system and "bleaches" out
this unnecessary feature without actually
removing it.

White Crop

This feature trims the white space around the
border of an image where no data appears.
The value entered here is the white border
size in pixels that remains after cropping. You
can substitute this feature for registration,
but it is not as precise. Setting the value to 0
deactivates this feature. AppXtender Image
Capture performs black crop first if both are
activated.

5. In the ScanFix Advanced Settings dialog box, click OK.

6. In the ScanFix Configuration dialog box, click OK to save the settings. (Any settings saved
become the defaults.) The next time you scan a new batch or page into AppXtender Image
Capture, the border of each image is automatically bleached or trimmed as specified. Each
enhanced image appears in the Batch Display view.

The following figure compares two examples of scanned images. The example image on the left
has white space that needs to be cropped. The white space surrounding the example image on

the right has been cropped.

213



Image Enhancement

Figure 62. Using IntelligentCrop
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For more information, see:

¢ Chapter 6, Image Enhancement
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accessible security
Accessible security grants access to the users in the group for only documents with index
field values matching the secured value list. (See also Document Level Security.)

annotation
An annotation is a note or a shape added to a document page, typically to focus attention
on a particular part of the page. Users can use annotations to comment on the contents of a
page, block areas of the page from view, or highlight important information. When a user
creates an annotation, it is associated with the AppXtender document page on which the
user created it. Annotations are edited and stored separately from the image, but they are
displayed along with the image in AppXtender. The types of annotations available include
text, highlighting, lines, arrows, shapes, and rubber stamps.

annotation group
Annotation groups allow you to create associations between users, groups, and specific
annotations. You can specify which users and groups can view or modify specific
annotations, and which users and groups can hide or modify specific redactions.

application
An AppXtender application is an index-driven data storage structure where documents can
be stored and retrieved. An AppXtender application is based on an index that is composed
of one or many fields. AppXtender applications are created in the ApplicationXtender
Administrator module of AppXtender.

application security profile
Application security profiles, like global security profiles, allow you to grant a particular set
of privileges to a user or group of users. You can define different privileges for a user or
group of users in each application.
When a profile is application-specific, however, the privilege settings are not carried over to
a new application when it is created. If a group of users has an application-specific profile
for a certain application, but no global profile, then when a new application is created, the
members of the group will not be able to access the new application. Application-specific
security settings override global security settings.

audit trail
The Audit Trails feature allows you to track user activity within the AppXtender system.
System-wide activities such as the creation, modification, and deletion of applications, users,
and groups can be tracked. You can also track user activity in applications by tracking items
such as the creation and deletion of documents, the addition of pages, and the modification
of index information for documents. By default, AppXtender logs audit trail events to a
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table in the AppXtender database. You can configure audit trails to log to this table, to a log
file, or to both locations.

authentication
Authentication requires all users to enter a valid user name and password to access software
modules. Authentication ensures that each user is who he or she claims to be.

authorization
Authorization is the granting of specific access privileges according to the user name.
Security profiles contain information pertaining to a user’s specific privileges within the
AppXtender system.

auto index import
AppXtender Auto Index Import allows use of the <F7> key to import index values from a text
file, so users adding documents can automatically populate indexes using the imported data.
AppXtender Auto Index Import is ideal for the import of index records that are applicable to
only one document. In an AppXtender Auto Index Import table, once a record (or a group of
index values) has been used to index a document, the record is deleted.

check in/check out mode
When AppXtender is in check in/check out mode, use of revision control with AppXtender
documents is mandatory. Users must check out a document in order to modify it. If they do
not check the document out, it is opened in read-only mode and it cannot be modified.

COLD
COLD (computer output to laser disk) data is report data generated for existing applications.
COLD data can be added to AppXtender as documents through the use of ColdXtender®
(CX) or ApplicationXtender Reports Management (AppXtender Reports Mgmt).

collection
A collection is a K2 full-text database.

data source
A data source is the means by which ApplicationXtender accesses data from a database.
When a data source is defined, an OLE DB data provider is configured to access the database.
All these characteristics in combination — where the data is stored, the format of the data
stored, and the data provider used to access the data — comprise the data source.

data source group
A data source group in ApplicationXtender Administrator associates a list of data sources
with everything that has been configured in ApplicationXtender Administrator, such as
ApplicationXtender Web Access settings and connections to License Server computers. This
feature provides convenience in that the work of configuration does not have to be repeated
every time you create a data source.

database
A database is a collection of data tables of a particular database format (such as Oracle or
Microsoft SQL Server). ApplicationXtender uses databases to store application information.
When an application is created, details such as the field definitions and security information
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are stored in database tables. Once documents are added to an application, index information
is stored in a table, as are the pointers to the location of the documents.

document
A document is a page or group of pages stored in an application and identified by index
information. Each page of a document is comprised of a single object such as a scanned
image file or a word processing document. To create a document, users add an object to an
application and attach index information to it. Subsequent objects can be added as additional
pages of the same document.

Document Level Security
Document Level Security (DLS) pinpoints user access within an AppXtender application.
With DLS, you can deny a group of users access to any classified or sensitive document(s),
without restricting access to other documents in the application. DLS can also be configured
to grant a group of users access to only a specific set of documents in an application.

ERM
ERM (enterprise report management) data is report data generated for existing applications.
ERM data can be added to AppXtender as documents through the use of ApplicationXtender
Reports Management (AppXtender Reports Mgmt).

extended applications
Extended applications are AppXtender applications that can be called from within other
software applications, adding document storage and processing functions.

full-text
Users can index documents for full-text searching by submitting them to the Index Agent.
With a full-text search, users can find documents even if they do not know any of the index
values. Users can also use full-text searching to refine an index value search.

global security profile
Global security profiles can be established to automatically assign a uniform set of access
privileges for a user or group of users every time a new application is created. When a
global profile exists for a user or group of users, the privileges assigned in that profile are
automatically assigned for every application created. If a user or group of users does not
have a global profile, an application-specific profile must be created for that user or group
before they can access an application.

grab bar
An AppXtender docked view has a grab bar. A grab bar is similar to a title bar except that
it does not contain a title.

impersonation account
The Index Agent impersonation account grants security privileges to Index Agent and
is essential for the Index Server to operate properly. Index Agent uses the Index Server
impersonation account to access remote and server resources, including AppXtender
document paths, the XtenderSolutions License Server, the registry, and the image repository
(in some cases, the DX Document Server).
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import specification

A specification is a set of rules that ApplicationXtender follows when importing data from an
import file using the AppXtender Auto Index Import, AppXtender Index Image Import, or
AppXtender Key Reference Import.

inaccessible security

index

Inaccessible security denies access to the users in the group for documents with index field
values matching the secured value list. (See also Document Level Security.)

An AppXtender index contains a group of fields where descriptive information pertaining
to documents can be stored. This group of field definitions is used by AppXtender when
storing index information within an application.

index image import

AppXtender Index Image Import allows you to import index data and document files in a
single step. A text file is required which contains a line of text for each document to be
imported, with a value for each index field and a reference to the location of the file to be
imported. No manual document indexing is required.

Index Agent

The AppXtender Index Agent is an optional module that adds full-text indexing and OCR
functionality to ApplicationXtender systems.

key reference import

node

OCR

ODMA

AppXtender Key Reference Import allows use of the <Tab> key to import index values from
a text file. AppXtender Key Reference Import is most effectively used in situations where
each imported record may describe several documents. AppXtender Key Reference Import
maintains the index records in the AppXtender Key Reference Import table even after records
have been used to index documents. Any change made to a record in the AppXtender Key
Reference Import table is reflected in the indexes of all documents described by that record.

A node is an element of a tree structure such as in ApplicationXtender Administrator,
AppXtender Administrator, AppXtender, or AppXtender Reports Mgmt. A node can be
expanded to reveal subnodes or can be collapsed.

Users can process bi-tonal images using optical character recognition (OCR). This process
converts an image of text into text. After a user processes an image using OCR, it can then be
submitted to the Index Server for full-text searching.

Open Document Management API (ODMA) support allows users to work with AppXtender
documents within other ODMA-compliant applications.

OLE DB
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page

provides flexible data architecture that offers applications like AppXtender efficient access to
databases. Data is accessed through OLE DB data providers.

The word “Page” typically implies a single entity. Since AppXtender supports multiple
object types, the term “page” is redefined within AppXtender to mean a single object. A
long word processing file is considered a page to AppXtender. A page could also be, for
example, a single scanned image, a 30-minute video clip, or an audio recording. Each page of
a document has the same index record attached.

privileges

Privileges govern the ability of a user or group of users to access functions in AppXtender.

redactions

A redaction is a filled and opaque annotation shape that can be used to secure or hide
portions of image and text document pages. Users can apply redaction to all available
annotations. When applied, the area of the page behind the redaction is not visible.

security

Security is the combination of authentication and authorization.

security mapping

When the AppXtender Migration is used to migrate documents and security information,
the administrator has the option to map users and groups in the source database to users
and groups in the destination database. Similarly, when the ApplicationXtender Media
Distribution is used to extract AppXtender documents and security information before the
creation of an ApplicationXtender Media Distribution CD-ROM, the administrator has the
option to map users and groups in the source database to users and groups in the database
on the CD-ROM (or in the database where the CD-ROM will be reintegrated).

security provider

Security providers implement authentication, which requires all users to enter a valid user
name and password to access most modules. ApplicationXtender Administrator offers two
pre-packaged security providers (CM and Windows) to ensure that each user is who the user
claims to be. You can also create a directory service security provider, if necessary.

write paths

Write paths are used to instruct ApplicationXtender where to store documents, annotations,
OCR output, and the Prolndex full-text database for a particular AppXtender application.
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Acrobat Reader
view PDF files, 65
activating
a data source, 35
an application, 35
actual size display
as default, 64
for displayed page, 116
add
rubber stamp, 158
Allow Docking, 60
annotation group
assigning to annotation, 161
hiding, 163
setting default, 148
toolbar button, 39
annotation selection toolbar button, 38, 165
to 166
annotation toolbar, 38
annotation toolbar buttons, 38
annotation group, 39
annotation selection, 38, 165 to 166
arrow, 39, 154
bring to front, 39
cancel changes, 40
color, 40
delete annotations, 40
eraser, 39, 172
fill, 39
freehand line, 39, 154
hide annotations, 40
highlight, 38
line width, 40
oval, 39, 156
polygon, 39
polyline, 39
rectangle, 39, 156
redaction, 39
rounded rectangle, 39, 156

save annotations, 40

select all, 39, 166

send to back, 39, 161

straight line, 39, 154

text annotation, 38
Annotation toolbar buttons

Rubber Stamp, 40
annotations, 17

arrows, 153

assigning annotation group, 161

basic lines, 153

basic shapes, 155

configuring, 143

creating, 149

default color, 144, 146, 169

deleting, 172

erasing, 172

filled or hollow, 147

for line and shape, 146

for text, 144, 169

freehand lines, 153

hiding annotation group, 163

highlight, 157

lines, 153

modifying, 165, 167, 169 to 170

move, 161

ovals, 155

polygons, 156

polyline, 154

print document, 164

printing text annotation, 171

properties, changing, 165

rectangles, 155

redactions, 147

resizing, 167

rounded rectangles, 155

rubber stamp, 158

selecting, 165

setting default annotation group, 148

shape, 155, 167

straight lines, 153
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text, 150, 158, 169 to 170
to the back layer, 161
to the front layer, 161
types, 142
application
activating, 35
definition of the term, 17
Applications View toolbar button, 37
AppXtender Administrator privilege, 30
AppXtender Image Capture
desktop, customizing, 60
workstation configuration, 45
AppXtender Image Capture views
Applications, 35
Batch Display, 36
customize, 60
display as dialog box, 60
display as subwindow, 61
docking, 60
hiding on use, 61
arrow annotations, 153
arrow toolbar button, 39, 154
aspect ratio, in Magnify window, 121
assigning annotation group, 161
Auto Enhance toolbar button, 43
Auto Feed toolbar button, 42
automatic features
cropping, 211
deskewed characters, protecting, 181,
189
dots, removing, 186
enhancing images during scan, 43, 48
hiding a view on use, 61
lines, removing, 193
noise, removing, 186
registering an image, 181
removing blank pages during
scanning, 69
rotating pages during scan, 42
saving desktop layout on exit, 66
scanning all pages in feeder, 42, 48
setting tab size, 133
shading, removing, 186
skew, removing, 178
view settings, applying to page
types, 58, 111
automatically logging in, 33

B

back page, rotation during scan, 42, 52
Back Rotation toolbar button, 42
basic annotations
lines, 153
shapes, 155
batch
create new, 84
creating by file selection, 86
creating from import file, 88
definition of the term, 18
deleting, 139
displaying, 95
from the scanner, 84
import file, creating, 89
import, performing, 93
input methods, 98
managing, 107
memo, editing, 134
scanning, 84
Batch Scan privilege, 30, 42
batch view properties
general, 127
image, 129
text, 132
bi-tonal image enhancement, 175
bi-tonal scanned image enhancement
default settings, 178
blank page separation, 70
blank pages
removing while scanning, 85
blank pages as separators, 85
bring to front toolbar button, 39
buttons, toolbar
annotation group, 39
annotation selection, 38, 165 to 166
Applications View, 37
arrow, 39, 154
Auto Enhance, 43
Auto Feed, 42
Back Rotation, 42
bring to front, 39
cancel changes, 40
Cascade, 38
color, 40
Configuration, 37
Copy, 37
Cut, 37
delete annotations, 40
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eraser, 39, 172
fill, 39
Fit Height, 41
Fit to Window, 40
Fit Width, 41
freehand line, 39, 154
Front Rotation, 42
hide annotations, 40
highlight, 38
line width, 40
Magnifier, 41
Manual Feed, 42
Next Page, 41
oval, 39, 156
Pan Mode, 36, 41
Paste, 37
polygon, 39
polyline, 39
Previous Page, 41
Print, 37, 137
rectangle, 39, 156
redaction, 39
Rescan, 42
Rotate Left, 41
Rotate Right, 41
rounded rectangle, 39, 156
Rubber Stamp, 40
save annotations, 40
Scan, 42
Scan Batch, 38
Scanner Setup, 43
select all, 39, 166
Select Scanner, 38
send to back, 39, 161
Single Feed, 42
Sticky View, 40
straight line, 39, 154
text annotation, 38
Tile Horizontally, 37
Tile Vertically, 37
Zoom In, 41
Zoom Out, 41
buttons, toolbar, changing size of, 54

C

cancel changes toolbar button, 40
Cascade toolbar button, 38
cascading windows, 38, 110
changing size of toolbar buttons, 54

characters
smoothing in auto-enhance, 200
viewing number of for a page, 134
clockwise, rotating an image, 117
color of annotations
configuring, 144, 146, 169
modifying, 165
color toolbar button, 40
components of AppXtender, 21
compression, viewing type for a page, 134
concepts, 16
Conlfiguration toolbar button, 37
Configure WS privilege, 30, 62
configuring
annotation colors, 144, 146, 169
annotation line width, 143
annotations, 143
AppXtender Image Capture
workstation, 45
display settings, 66
image enhancement settings, 176
print settings, default, 57
scaling, 63
scan settings, 68
scanner driver, 52
scanner properties, 47
scanner selection, 46
status bar, 57
title bar, 55
toolbars, 53 to 55
view settings, 63
zoom, 63
copy
contents of Batch Display view, 37
contents of Magnify window, 121
Copy toolbar button, 37
correcting inverse text in auto-enhance, 197
counterclockwise, rotating an image, 117
creating
a batch import file, 89
annotations, 149
batch by file selection, 86
batch from import file, 88
creator of batch, 96
cropping in auto-enhance, 203, 211
customizing
AppXtender Image Capture views, 60
toolbars, 55
Cut toolbar button, 37
cutting a page, 138
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D

data source
activating, 35
configuration module, 22
definition of the term, 19
selecting multiple for AppXtender
Image Capture, 28
specifying default for AppXtender
Move Online, 29
data types supported in AppXtender Image
Capture, 23
database, definition of the term, 19
date of batch creation, 96
DCX files
importing multi-page files, 90, 97
de-skewing text in auto-enhance, 178
default
data source, for AppXtender Move
Online, 29
foreign file storage format, 27
HTML storage format, 26
OLE storage format, 28
PDF storage format, 26
print settings, 57
settings for image enhancement, 178
default annotation group, 148
definition
annotation, 17
redaction, 21
definition of terms, 16
application, 17
batch, 18
data source, 19
database, 19
document, 19
index, 20
page, 20
delete
annotations, 172
annotations toolbar button, 40
deleting
batch, 139
page, 138
description of batch, 96
dialog box, displaying a view as, 60
disabling remember password option, 33
display
as icon, 151
text annotation, 151

display settings

configuring, 66

scale, 113

setting defaults for page types, 58, 111
displaying

batch, 95

next page, 108

previous page, 108

scrollbars, 129

status bar, 57
document

from unknown data source, 97

printing, 164

view, 97

with annotations, 164

without annotations, 164
documents

definition of the term, 19
DPI resolution toolbar list, 43
drag-and-drop to import page, 104
driver

configuring for scanner, 52

select for scanner, 46

E

edge cleaning factor, 196

Edit menu in Magnify window, 121

editing batch memo, 134

embedded Office viewer, 27, 65, 76, 97, 124
to 125

enhancement
of images, 175

enhancement of bi-tonal scanned images
enabling, 48
options, 177

erase annotations, 172

eraser toolbar button, 39, 172

exiting Magnify window, 121

F

faxing pages, 136
file for batch import
creating, 89
creating batch from, 88
format, 90
File menu in Magnify window, 121
file selection, creating batch by, 86
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file types supported in AppXtender Image
Capture, 23, 96
fill
modifying for an annotation, 165
toolbar button, 39
Fit Height toolbar button, 41
fit left to right
as default, 64
for displayed page, 116
fit to window
as default, 64
for displayed page, 115 to 116
Fit to Window toolbar button, 40
fit top to bottom
as default, 64
for displayed page, 116
Fit Width toolbar button, 41
Float as MDI Window, 61
foreign file
adding as page, 101, 103 to 104
dragging, 104
importing, 103
pasting, 101
freehand line annotations, 153
toolbar button, 39, 154
front page, rotation during scan, 52
Front Rotation toolbar button, 42

G

GIF

animation files, 90
going to page in displayed batch, 109
grab bar, definition of the term, 60
grayscale, display as, 65

H
hide
annotation groups, 163
annotations, 162
Hide Annotations toolbar button, 40
hiding
view on use, 61
highlight annotations, 157
Highlight toolbar button, 38
horizontal
tiling, Tile Horizontally toolbar
button, 37

horizontal adjustment, margin
alignment, 184

idle, batch status, 96
image
bi-tonal enhancement, 175
enhancement, 175
image enhancement
configuring, 176
correcting inverse text, 197
cropping, 203, 211
de-skewing text, 178
options, 177
registering an image, 181
removing noise/dots/shading, 186
removing specks, 190
smoothing characters, 200
sub-image, 208
image file, referencing in batch import
file, 90
Image toolbar, 40
changing size of buttons, 54
Image toolbar buttons, 40
Fit Height, 41
Fit to Window, 40
Fit Width, 41
Magnifier, 41
Next Page, 41
Pan Mode, 36, 41
Previous Page, 41
Rotate Left, 41
Rotate Right, 41
Sticky View, 40
Zoom In, 41
Zoom Out, 41
import file for batch creation, 88
creating import file, 89
file format, 90
format for multiple files, 92
importing
file as new page, 103
foreign file as new page, 104
index, definition of the term, 20
indexing as a batch status, 96
information about
contents of Magnify window, 121
installing
scanner driver, 46
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inverse text, correcting in auto
-enhance, 197

K

keep aspect ratio, in Magnify window, 121
keyboard keys

Page Down, 67 to 68

Page Up, 67 to 68

Shift, 32

Tab, 193

L

layout, restore previous, 66
left, rotating an image, 117
line
annotations, 153
configuring for annotations, 143
modifying for an annotation, 165
toolbar button, 40
width, 40, 143, 165
line removal in auto-enhance, 193
lists, toolbar
DPI Resolution, 43
Number of Colors, 43
Page Size, 43
Scanner Source, 43
log file
batch import, 94
logging in automatically, 33
Login dialog box, 31, 33 to 34

Magnifier toolbar button, 41
Magnify window for regions, 120 to 121
Main toolbar, 37

changing size of buttons, 54
Main toolbar buttons, 37

Applications View, 37

Cascade, 38

Configuration, 37

Copy, 37

Cut, 37

Paste, 37

Print, 37, 137

Scan Batch, 38

Select Scanner, 38

Tile Horizontally, 37

Tile Vertically, 37

managing batches, 107
Manual Feed toolbar button, 42
maximum
acceptable skew, for auto-enhance, 181
line gap, for auto-enhance, 196
line thickness, for auto-enhance, 196
memo, editing for batch, 134
methods for
adding pages to batches, 98
creating batches, 83
minimum length for line removal, 196
mode
Pan Mode toolbar button, 36
scanning, 49
modifying
shape annotations, 167
text annotations, 169 to 170
move to front toolbar button, 161
multi-page TIFF/DCX files, importing, 90,
97
multiple
data sources, displaying in AppXtender
Image Capture, 28
files, importing with wildcard
character, 92

N

name of batch, 96
new batch
blank page separators, 70
by file selection, 86
creating, 84
from batch import file, 88
from the scanner, 84
new page
dragging a file, 104
from imported foreign file, 103 to 104
from pasted foreign file, 101
from the scanner, 100
from the Windows Clipboard, 37
importing a file, 103
Next Page toolbar button, 41
noise removal in auto-enhance, 186, 190
Number of Colors toolbar list, 43
number of pages in batch, 96

O

object types, 20
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for AppXtender documents, 19
for AppXtender Image Capture
batches, 18
opacity
modifying for an annotation, 165
oval annotations, 155
oval toolbar button, 39, 156

P

page
adding a new, 98
adding an import file as a, 103
adding from the scanner, 100
cutting, 138
definition of the term, 20
deleting, 138
dragging file as a new, 104
faxing, 136
go to in a displayed batch, 109
importing a foreign file as a, 103 to 104
pasting a foreign file as a, 101
printing, 136
Page Down key, 67 to 68
page size scan setting, 50
Page Size toolbar list, 43
Page Up key, 67 to 68
pages
number of in batch, 96
Pan Mode toolbar button, 36, 41
password
protection for AppXtender Image
Capture, 30
remember option, 31, 33 to 34
remember option, disabling, 33
Paste toolbar button, 37
pasted file, ability to view, 101
PDF files
Acrobat Reader, 65
pixels, viewing number of for a page, 134
pointer mode, 36
polygon
annotations, 156
toolbar button, 39
polyline
annotations, 154
toolbar button, 39
Previous Page toolbar button, 41
print
contents of Magnify window, 121

document, 164

page, 136

settings, default, 57

text annotation, 171

with annotations, 164

without annotations, 164
Print privilege, 30, 107, 121, 135
Print toolbar button, 37, 137
privileges, 30

AppXtender Administrator, 30

Batch Scan, 30, 42

Configure WS, 30, 62

Print, 30, 107, 121, 135

R

ratio of height/width, Magnify
window, 121
reconstruction width/height, 197
rectangle annotations, 155
toolbar button, 39, 156
redaction, 147
definition, 21
modifying for an annotation, 165
toolbar button, 39
registering an image in auto-enhance, 181
remember password, 33
option, 31, 34
option, disabling, 33
remove
blank pages while scanning, 85
removing
blank pages during scanning, 69
lines in auto-enhance, 193
noise in auto-enhance, 186
specks in auto-enhance, 190
Rescan toolbar button, 42
resetting defaults for image
enhancement, 178
resize
annotations, 167
resolution, scan setting, 49
right, rotating an image, 117
right-click
context menu, 128
Rotate Left toolbar button, 41
Rotate Right toolbar button, 41
rotating an image, 117
left, 117
right, 117
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rounded rectangle annotation, 155
toolbar button, 39, 156

rubber stamp annotations, 158
add, 158

Rubber Stamp toolbar button, 40

S

save
annotations, 40
toolbar button, 40
scale
default view settings, 63
view settings for displayed page, 113
Scale to Gray, 118
Scan Batch toolbar button, 38
scan settings
automatically enhance images, 48
configuring driver, 52
configuring optional, 47
feeder options, 47
mode, 49
page size, 50
removing blank pages during
scanning, 69
resolution, 49
scanner manual feed timeout, 72
selecting a scanner, 46
source, 50
synchronized scan, 71
Scan toolbar, 41
changing size of buttons, 54
Scan toolbar button, 42
Scan toolbar buttons, 41
Auto Enhance, 43
Auto Feed, 42
Back Rotation, 42
Front Rotation, 42
Manual Feed, 42
Rescan, 42
Scan, 42
Scanner Setup, 43
Single Feed, 42
Scan toolbar lists
DPI Resolution, 43
Number of Colors, 43
Page Size, 43
Scanner Source, 43
scanner
driver, installing, 46

selecting for AppXtender Image
Capture workstation, 46

Scanner Setup toolbar button, 43
Scanner Source toolbar list, 43
scanning

as a batch status, 96

batches, 84

pages, 100

removing blank pages, 85

synchronized, 85
Screen DPI, 67
scrolling, 36, 128
security, Login dialog box, 31, 33 to 34
select

annotations, 128, 165 to 166

toolbar button, all, 166
select all

toolbar button, 39
Select Scanner toolbar button, 38
selecting

a region, 41

files for batch creation, 86
selection mode

for a batch, 128

for AppXtender Image Capture, 36
send to back toolbar button, 39, 161
setting default annotation group, 148
settings

annotations, 143
shape annotations, 155
Shift key, 32
show

annotations, 162
Single Feed toolbar button, 42
size of toolbar buttons, changing, 54
skew, removing, 178
smoothing characters in auto-enhance, 200
source, scan setting, 50
speck removal in auto-enhance, 190
standard page separators, 85
status bar, displaying, 57
status of the batch, 96
Sticky View toolbar button, 40
storage device for storing AppXtender

Image Capture batches, 18
storage format for

foreign files, 27

HTML files, 26

OLE files, 28

PDF files, 26
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straight line annotation, 153
toolbar button, 39, 154
sub-image in auto-enhance, 208
subwindow, displaying views as, 61
supported file types, 96
synchronized scan, 71, 85

T

Tab key, 193
text annotations, 150

printing, 171

spell-checking, 151, 153

toolbar button, 38
text file for importing a batch, 88
threshold for removing blank pages, 69
TIFF files

importing multi-page files, 90, 97
Tile Horizontally toolbar button, 37
Tile Vertically toolbar button, 37
time of batch creation, 96
timeout, scanner manual feed, 72
title bar

configuring, 55
toolbar buttons

annotation group, 39

annotation selection, 38, 165 to 166

Applications View, 37

arrow, 39, 154

Auto Enhance, 43

Auto Feed, 42

Back Rotation, 42

bring to front, 39

cancel changes, 40

Cascade, 38

color, 40

Configuration, 37

Copy, 37

Cut, 37

delete annotations, 40

eraser, 39, 172

fill, 39

Fit Height, 41

Fit to Window, 40

Fit Width, 41

freehand line, 39, 154

Front Rotation, 42

hide annotations, 40

highlight, 38

line width, 40
Magnifier, 41
Manual Feed, 42
Next Page, 41

oval, 39, 156

Pan Mode, 36, 41
Paste, 37

polygon, 39
polyline, 39
Previous Page, 41
Print, 37, 137
rectangle, 39, 156
redaction, 39
Rescan, 42

Rotate Left, 41
Rotate Right, 41
rounded rectangle, 39, 156
Rubber Stamp, 40
save annotations, 40
Scan, 42

Scan Batch, 38
Scanner Setup, 43
select all, 39, 166
Select Scanner, 38
send to back, 39, 161
Single Feed, 42
Sticky View, 40
straight line, 39, 154
text annotation, 38
Tile Horizontally, 37
Tile Vertically, 37
Zoom In, 41

Zoom Out, 41

toolbar lists

DPI Resolution, 43
Number of Colors, 43
Page Size, 43
Scanner Source, 43

toolbars

add buttons, 55

annotation, 38

changing size of buttons, 54
configuring, 53, 55
customizing, 55

Image, 40

Main, 37

remove buttons, 55

Scan, 41
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U

user account, entering password, 30
user who created batch, 96

Vv

vertical
adjustment, margin alignment, 185
tiling, Tile Vertically toolbar button, 37
view
documents, 97
from unknown data source, 97
view settings, configuring, 63
viewing
next page, 108
previous page, 108
views
Applications, 35
Applications View toolbar button, 37
Batch Display, 36
display as dialog box, 60

display as subwindow, 61
docking, 60
hiding on use, 61
volume label, using in batch import file, 92

w

wildcard character in batch import file, 92
workstation configuration, 45

VA

zoom, 113
configuring, 63
percent, as default, 64
percent, for displayed page, 115 to 116
ratio, 129
settings are pixels, 64
Zoom In toolbar button, 41
Zoom QOut toolbar button, 41
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